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Question 1

Question 2
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A(n) ________ produces results based on variable or constant inputs known as arguments.
Answer: https://biology-forums.com/index.php?topic=270510

Question 3

R
U

A primary key:
A) must include letters.
B) must contain a unique value for each record within the table.
C) has the same value for all records.
D) is not usually necessary.
Answer: https://biology-forums.com/index.php?topic=270320

Question 4

YFO

Match the Word 2010 feature with the tab where it can be found:
I.show paragraph marksA.Page Layout
II.insert a hard page breakB.Insert
III.add a page number in a documentC.File
IV.customize WordD.Header & Footer Tools
V.Link to Previous featureE.Home tab
Answer: https://biology-forums.com/index.php?topic=271347

G

Question 5

IO

LO

An expression used in queries to filter records in a table is called a(n):
A) primary key.
B) criterion.
C) report.
D) form.
Answer: https://biology-forums.com/index.php?topic=270348

Question 6

M

The ________ function inserts the system day, month, and year into an expression.
Answer: https://biology-forums.com/index.php?topic=270525

B

A Table Style controls
A) check boxes to select format actions such as Total Row.
B) check boxes to select format actions such as Header Row.
C) the fill color of the header row, columns, and records in a table.
D) arranges data in alphabetical order.
Answer: https://biology-forums.com/index.php?topic=270833

Question 7
Which of the following is true regarding the running of queries and the size of a database?
A) Queries run slower in smaller databases numeric data
B) Queries run at the same speed in large or small databases
C) The size of a database does not affect the speed at which queries run
D) The queries in larger databases may take longer to run than queries in smaller databases
Answer: https://biology-forums.com/index.php?topic=270406

Question 8
Formula AutoComplete
A) results in formulas such as =B4+C4.
B) calculates the total of values contained in two or more cells.
C) is a small pop-up description that displays the arguments for a function as you enter it.
D) displays a list of functions and defined names as you enter a function.
Answer: https://biology-forums.com/index.php?topic=270678

Question 9
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Question 10
A(n) ________ is a line that surrounds a paragraph, page, table or image.
Answer: https://biology-forums.com/index.php?topic=271399

Question 11

M
S.
C
O

A worksheet is defined as
A) the background color of a cell.
B) the current cell location of the insertion point as indicated by a dark border.
C) a single spreadsheet that often contains formulas, functions, values, text, and visual aids.
D) an unfinished project.
Answer: https://biology-forums.com/index.php?topic=270607

M
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What does the Set Poster Frame option do?
A) It allows you to choose a frame of the video as an outline box of the video on the slide.
B) It enables you to select a frame from the video to display on the slide.
C) It allows you to choose frames to embed on various slides in the presentation.
D) It enables you to set automatic timing for the video.
Answer: https://biology-forums.com/index.php?topic=271211

Question 12

YFO

A relative cell reference
A) indicates a cell's specific location and the reference does not change when you copy the formula.
B) contains both an absolute and a relative cell reference.
C) indicates a cells relative location from the cell containing the formula; the reference changes when you copy the formula.
D) occurs when a formula directly or indirectly refers to the cell containing the formula.
Answer: https://biology-forums.com/index.php?topic=270672

G

Question 13

IO

LO

Which of the following is FALSE about nonprinting marks and symbols?
A) Nonprinting marks and symbols do not display on printouts, but they do affect the appearance of a document.
B) A paragraph mark at the end of a paragraph only indicates the presence of a hard return.
C) When you press Enter, you leave a paragraph mark.
D) The hyphen and nonbreaking hyphen appear as different nonprinting symbols.
Answer: https://biology-forums.com/index.php?topic=271363

Question 14

B

Match the names or a variety of features with the type of PowerPoint option:
I.Fade, Wipe, Split, RevealA.animations
II.Urban, Hardcover, AustinB.transitions
III.Wipe, Fly In, FadeC.views
IV. Notes Page, NormalD.layouts
V.Blank, Title OnlyE.themes
Answer: https://biology-forums.com/index.php?topic=271037

Question 15
Notepad files end with a ________ extension.
A) .ntp
B) .npd
C) .txt
D) .doc
Answer: https://biology-forums.com/index.php?topic=271611

Question 16
________ inserts a nonbreaking hyphen in your document.
A) Ctrl+F4
B) Shift+H
C) Ctrl+Shift+Hyphen
D) Ctrl+N
Answer: https://biology-forums.com/index.php?topic=271357
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Question 18

R
U

Mail merge is used most frequently to create:
A) form letters.
B) e-mail messages.
C) a directory.
D) envelopes.
Answer: https://biology-forums.com/index.php?topic=271520

M
S.
C
O

Which of the following is NOT an option from the Display for Review arrow?
A) Final
B) Original: Show Markup
C) Revised
D) Original
Answer: https://biology-forums.com/index.php?topic=271435

M

Question 17

Question 19

YFO

A(n) ________, a main document type for a mail merge, creates a single document that contains a list of addresses.
Answer: https://biology-forums.com/index.php?topic=271557

Question 20

G

All of the following layouts include specific buttons to quickly and easily insert objects EXCEPT:
A) Title and Content
B) Title Slide
C) Comparison
D) Content with Caption
Answer: https://biology-forums.com/index.php?topic=270985

LO

Question 21

An ________ area is a range of cells containing results based on manipulating the variables.
Answer: https://biology-forums.com/index.php?topic=270639

IO

Question 22

B

A set of data such as first name, last name, address, etc. for a specific person is a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270363

Question 23

When defining a field, the field ________ property determines how much physical storage space the field requires.
A) size
B) format
C) caption
D) input mask
Answer: https://biology-forums.com/index.php?topic=270429

Question 24
When forming relationships in a relational data base, the ________ from one table must be joined to the foreign key of another table.
Answer: https://biology-forums.com/index.php?topic=270368

Question 25
The ________ is an Office tool that allows you to select a word and then locate a suitable substitution
Answer: https://biology-forums.com/index.php?topic=270952

Question 26
Pressing the ________ key when the insertion point is in the last cell of a table will insert a new row in the table.
Answer: https://biology-forums.com/index.php?topic=271021

Question 27
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Question 28

R
U

Match the following files with their description of the graphic file format:
I.org chart1.bmpA.good for line drawings and black-and-white images;
limited to 256 colors
II.org chart2.gifB.supports 16 million colors; standard of W3C; intended
to replace .gif format
III.org chart3.pngC.not widely supported by browsers but considered best
format for storing bitmapped images
IV.org chart4.picD.representation of rows and columns of dots; creates large
file size
V.org chart5.tifE.holds both vector and bitmap images
Answer: https://biology-forums.com/index.php?topic=271268

M
S.
C
O

M

You are reviewing a table you created in an Access database. As you review the table, you notice a column of cells that are supposed to contain
sales figures have pound signs through them (#######). What is the cause of these pound signs?
A) The pound signs are present because the value of the fields are null.
B) The pound signs serve as a warning that the data in the cells cannot totaled.
C) The pound signs are present because the column is not wide enough to display the data.
D) The pound signs are present because the currency format used on the cells is incorrect.
Answer: https://biology-forums.com/index.php?topic=270493

YFO

Question 29

G

How do you easily and quickly select one full paragraph in Word or PowerPoint?
A) Press and hold Ctrl while you click in the paragraph
B) Press and hold Shift while you press the right arrow key
C) Double-click in the paragraph
D) Triple-click in the paragraph
Answer: https://biology-forums.com/index.php?topic=270918

Question 30

IO

LO

The Y-axis
A) is text that describes a collection of data points in a chart.
B) is a vertical line that borders the plot area to provide a frame of reference for measurement.
C) compares values for one set of data.
D) is a horizontal line that borders the plot area to provide a frame of reference for measurement.
Answer: https://biology-forums.com/index.php?topic=270748

B

Question 31

The table or query that supplies the underlying data for a form or report is called the ________.
Answer: https://biology-forums.com/index.php?topic=270576

Question 32
A relational database is a collection of:
A) forms.
B) field values.
C) common fields.
D) related tables.
Answer: https://biology-forums.com/index.php?topic=270319

Question 33
A ________ is a line used to depict trends and forecast future data.
Answer: https://biology-forums.com/index.php?topic=270805

Question 34
A (n) ________ form is replica of a table or query’s Datasheet view but still retains form properties.
Answer: https://biology-forums.com/index.php?topic=270583

Question 35
If you've merged cells together and choose to divide them, use the ________ command in the Merge group.
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A) Distribute Cells
B) Unmerge Cells
C) Divide Cells
D) Split Cells
Answer: https://biology-forums.com/index.php?topic=271505

M
S.
C
O

Question 36

YFO

R
U

Match the following descriptions with the type of view:
I.slide number, icon, and title of each slide in
Outline view A.collapsed view
II.presentation displayed as a list of slides in
hierarchy formatB.expanded view
III.slide number, icon, title, and content of each
slide in Outline viewC.Outline view
IV.necessary to create an outline for your
presentationD.Normal or Slide Sorter
view
V.necessary view to create sectionsE.Normal view, click the
Outline tab, switch to
Outline view
Answer: https://biology-forums.com/index.php?topic=271110

Question 37

G

Where do changed lines display within a Word document?
A) In the right or left margin
B) On the Status bar
C) In a balloon within the left or right margin
D) In the Reviewing Pane
Answer: https://biology-forums.com/index.php?topic=271432

LO

Question 38

IO

Which of the following refers to the amount of horizontal space between characters?
A) Kerning
B) Scaling
C) Character spacing
D) Position
Answer: https://biology-forums.com/index.php?topic=271352

B

Question 39

The ________ key darkens the screen during a presentation.
A) D
B) Esc
C) B
D) F12
Answer: https://biology-forums.com/index.php?topic=270998

Question 40
Match the following Word features with the tab to access the feature:
I.create a tableA.Insert tab
II.add a new row to a tableB.Page Layout tab
III.add a border to a tableC.Mailings tab
IV.change the page orientationD.Table Tools Design tab
V.create a Labels documentE.Table Tools Layout tab
Answer: https://biology-forums.com/index.php?topic=271568

Question 41
A(n) ________ is a dynamic subset of a table that selects, sorts, and calculates records as specified in a query.
Answer: https://biology-forums.com/index.php?topic=270434

Question 42
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Question 43

Question 44

YFO

What is a tag?
A) A property identification for a program
B) An identifier for a folder
C) A custom file property created by a user
D) An e-mail identifier
Answer: https://biology-forums.com/index.php?topic=271623

R
U

Match the following terms to their descriptions:
I.copyrightA.legal protection for written and artistic
work
II.infringement of copyrightB.copyright protected photos, clip art, fonts,
sounds, and movies
III.public domainC.guidelines to determine use of copyrighted
work in education
IV.Microsoft's Media ElementsD.violation of a right held by a copyright owner
V.Proposal for Fair Use GuidelinesE.author gives everyone the right to reproduce
for Educational Multimedia and distribute their work
Answer: https://biology-forums.com/index.php?topic=271265

M
S.
C
O

M

A field
A) is a complete set of data for an entity.
B) indicates where data starts on a new printed page.
C) is an individual piece of data, such as a last name.
D) defines the range of data to print.
Answer: https://biology-forums.com/index.php?topic=270825

G

Question 45

IO

LO

Vertical Alignment (as it applies to Excel)
A) refers to the up-down position of contents in a cell.
B) removes the vertical lines and the tangent lines on the print-out.
C) shows the vertical lines but not the tangent lines on the print-out.
D) refers to the left-right position of contents in a cell.
Answer: https://biology-forums.com/index.php?topic=270630

Question 46

B

How do you know that the Link to Previous feature in the Header & Footer Tools tab is active?
A) It displays with a dark gray background
B) It displays with an orange color
C) It is not grayed out like many of the other buttons on the Header & Footer Tools tab
D) It shows with a dark black border
Answer: https://biology-forums.com/index.php?topic=271294

Question 47
What templates are displayed when you select the Sample templates option?
A) All downloaded templates
B) Templates installed with PowerPoint 2010
C) All templates available on your hard drive
D) All installed and downloaded templates as well as templates accessible at office.com
Answer: https://biology-forums.com/index.php?topic=271045

Question 48
A spreadsheet
A) is the core of a slide presentation.
B) is an electronic file that is used to write text and graphics on the web.
C) is an electronic file that contains a grid of columns and rows for related data.
D) is another word for a letter written on a computer.
Answer: https://biology-forums.com/index.php?topic=270605
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Question 49

M

The ________ allows you to organize different types of database objects into groups.
Answer: https://biology-forums.com/index.php?topic=270366

Data from two or more tables can be connected by specifying a:
A) hyperlink.
B) field value.
C) common field.
D) form.
Answer: https://biology-forums.com/index.php?topic=270318

Question 51

YFO

R
U

Match the following terms to their meanings:
I.FormulasA.Addition, subtraction, multiplication, and
division
II.Mathematical operationsB.Change static numbers into meaningful results
III.Start a formula by using the...C.Text
IV.A2+A3 (without = sign)D.Formula using a constant (not recommended)
V.=10+2E.Equals sign (=)
Answer: https://biology-forums.com/index.php?topic=270666

M
S.
C
O

Question 50

Question 52

G

Glen is working on a database table that stores patient billing information, including the date an invoice was issued. Glen needs to design a query that
shows how long the bills in the table have been outstanding. He can use the ________ function in conjunction with the Date function in Expression
Builder to determine amount of time that has elapsed between the date the invoice was issued and the current date.
Answer: https://biology-forums.com/index.php?topic=270524

LO

Question 53

A page number that displays at the bottom of every page would display in a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271323

IO

Question 54

B

The ________ view is the default view in Word 2010.
A) Draft
B) Full Screen Reading
C) Print Layout
D) Outline
Answer: https://biology-forums.com/index.php?topic=271298

Question 55
Jill must create a report for an Access database, but is unfamiliar with creating reports in Access. Which Report tool should Jill use?
A) Report Blank
B) Report Wizard
C) Report
D) Report Design
Answer: https://biology-forums.com/index.php?topic=270548

Question 56
In Windows Explorer use the ________ key if you want to select a full range of files that are adjacent.
A) Shift
B) Tab
C) Ctrl
D) Alt
Answer: https://biology-forums.com/index.php?topic=270898

Question 57
Which of the following contains thin lines at the top and bottom of the primary strokes of the font characters?
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M

A) A sans serif typeface
B) A monospace typeface
C) A serif typeface
D) A proportional typeface
Answer: https://biology-forums.com/index.php?topic=271350

M
S.
C
O

Question 58
The MEDIAN function
A) displays the lowest value in a range.
B) identifies the midpoint value in a set of values.
C) identifies the highest value in a range.
D) tallies the number of cells in a range that contain values.
Answer: https://biology-forums.com/index.php?topic=270681

Question 59

YFO

R
U

When choosing between Access and Excel, it is best to use Access in all of the following circumstances EXCEPT:
A) you need to create complex charts or graphs.
B) you require multiple tables to manage data.
C) you are managing a large quantity of data.
D) multiple users need to work with data simultaneously.
Answer: https://biology-forums.com/index.php?topic=270338

Question 60

The ________ test formula is one that tests for true or false.
Answer: https://biology-forums.com/index.php?topic=270721

Question 61

IO

Question 62

LO

G

Which of the following is NOT part of the Paragraph group on the Home tab?
A) Alignment
B) Indentation
C) Change Case
D) Line spacing
Answer: https://biology-forums.com/index.php?topic=271364

B

A(n) database ________ holds related information and is made up of records.
Answer: https://biology-forums.com/index.php?topic=270448

Question 63

A print area
A) is an individual piece of data, such as a last name.
B) is a complete set of data for an entity.
C) is the sequence in which pages print.
D) defines the range of data to print.
Answer: https://biology-forums.com/index.php?topic=270822

Question 64
Animation is movement that controls all EXCEPT the ________ of an object in a slide show.
A) transition
B) exit
C) entrance
D) path
Answer: https://biology-forums.com/index.php?topic=270989

Question 65
Match the following views to their descriptions:
I.DraftA.displays top and bottom margins, headers and footers
II.Print LayoutB.displays a structural view of a document
III.Full Screen ReadingC.eliminates tabs
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IV.OutlineD.used to create Web pages
V.Web LayoutE.best way to view the location of section breaks
Answer: https://biology-forums.com/index.php?topic=271346

Question 67

M
S.
C
O

Match the following Microsoft Office 2010 feature with the tab where it can be found:
I.access BackstageA.File tab
II.tab that automatically displays when a file
is openedB.View tab
III.create a footer in WordC.Page Layout tab
IV.change the zoom level D.Insert tab
V.change margins in WordE.Home tab
Answer: https://biology-forums.com/index.php?topic=270959

M

Question 66

YFO

R
U

What does checking the Update automatically button do in Header and Footer dialog box?
A) Automatically updates the date to always be current
B) Automatically updates edited text within a footer
C) Updates the header or footer when the file is saved
D) Updates the header and footer positions if you change slide theme
Answer: https://biology-forums.com/index.php?topic=270994

Question 68

LO

Question 69

G

Filtering
A) helps to clean the data before printing in Backstage view
B) displays data in chronological order.
C) is the process of displaying only records that meet specific conditions.
D) arranges dates in alphabetical order.
Answer: https://biology-forums.com/index.php?topic=270841

B

IO

Match the following terms with their descriptions:
I.character spacingA.permits more even spacing between characters
II.scalingB.horizontal space between letters, numbers, and
symbols
III.positionC.percentage adjustment of height or width of an
image's original size
IV.kerningD.raises or lowers text from the baseline
V.OpenTypeE.form of font designed for use on all platforms
Answer: https://biology-forums.com/index.php?topic=271415

Question 70
Referencing the image above, what number represents the section where the title would appear in the report?
A) 2
B) 3
C) 4
D) 5
Answer: https://biology-forums.com/index.php?topic=270572

Question 71
The Section button is located in the ________ group.
Answer: https://biology-forums.com/index.php?topic=271096

Question 72
The VLOOKUP function.
A) is the argument in a function that describes to which column to return a value.
B) is a range containing a lookup table.
C) is a reference to a cell containing a value to look up.
D) looks up a value and returns a related result from the lookup table.
Answer: https://biology-forums.com/index.php?topic=270694
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Question 73

Question 74
When you click a Dialog Box ________, a corresponding dialog box is opened.
Answer: https://biology-forums.com/index.php?topic=270939

YFO

A category label
A) contains the entire chart and all of its elements.
B) is text that describes a collection of data points in a chart.
C) displays data comparisons vertically in columns.
D) contains graphical representation of values in data series.
Answer: https://biology-forums.com/index.php?topic=270743

R
U

Question 75

M
S.
C
O

M

Row Height
A) is the adjustable vertical measurement of a row.
B) changes the background color of the selected cells.
C) is controlled by the fill handle of the adjacent cell.
D) is not adjustable so use only smaller fonts for formulas.
Answer: https://biology-forums.com/index.php?topic=270621

Question 76

G

Referencing the image above, this Access report is shown in ________ view.
A) Design
B) Layout
C) Print Preview
D) Form
Answer: https://biology-forums.com/index.php?topic=270569

LO

Question 77

The Replace button is located on the ________ tab in Office 2010.
Answer: https://biology-forums.com/index.php?topic=270949

IO

Question 78

B

Which of the following is FALSE about the Slide Show view?
A) A presentation running in Slide Show view can contain both manual and automatic slide transitions.
B) To end a slide show, press Esc.
C) The Slide Show view is used to deliver a completed presentation to an audience.
D) The Slide Show view is new to PowerPoint 2010.
Answer: https://biology-forums.com/index.php?topic=270969

Question 79
Adjusting white space around your data or between cells can be done with the ________ command.
Answer: https://biology-forums.com/index.php?topic=271548

Question 80
If you have selected the Lock Drawing Mode, press ________ to release it.
A) F1
B) Tab+Esc
C) Esc
D) Ctrl+Tab
Answer: https://biology-forums.com/index.php?topic=271121

Question 81
"Copy as Picture" can be a useful command when
A) you do not have a printer available.
B) the formulas, functions, and headings need to be tested.
C) you need an un-edit able "picture" of data to use elsewhere in the workbook or other programs.
D) you need to make changes to the data later.

Page 10 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Answer: https://biology-forums.com/index.php?topic=270626

R
U

Question 83

M
S.
C
O

Match the following video file formats with their description:
I.stores synchronized multimedia dataA.Movie file-.mpg
or .mpeg file
II.compresses audio and video; requires minimal storageB.Windows Media
Video file-.wmv file
III.format generally used to deliver video over the InternetC.Adobe Flash
Media file-.swf file
IV.stores sound and moving pictures in RIFF formatD.Windows Media
file-.asf file
V.designed for use with Video-CD and CD-i mediaE.Windows Video
file-.avi file
Answer: https://biology-forums.com/index.php?topic=271267

M

Question 82

Access requires the correct ________ when designing calculated fields..
Answer: https://biology-forums.com/index.php?topic=270523

YFO

Question 84

IO

Question 85

LO

G

Match the following views with their description
I.Draft viewA.shows deleted text in the document and
inserted text in a balloon
II.Original: Show Markup
viewB.can edit a footnote by clicking in it and
editing it
III.Final: Show Markup viewC.displays the Reviewing tab from any view
IV.Print Layout viewD.comments appear as tags embedded in a
document
V.all viewsE.displays inserted text in the document;
deleted text in a balloon
Answer: https://biology-forums.com/index.php?topic=271496

B

A bubble chart shows
A) a single chart and no spreadsheet data.
B) you how to adjust the size of the chart using the mouse.
C) a miniature chart contained in a single cell.
D) relationships among three values by using bubbles.
Answer: https://biology-forums.com/index.php?topic=270767

Question 86
________ a database rearranges data and objects in a database to make its size smaller.
A) Backing up
B) Compressing
C) Compacting
D) Realigning
Answer: https://biology-forums.com/index.php?topic=270328

Question 87
When you use the Ctrl+F shortcut, the Navigation Pane opens only in ________.
A) Word
B) PowerPoint
C) Access
D) Excel
Answer: https://biology-forums.com/index.php?topic=270922

Question 88
Where are the control buttons found on the title bar?
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M

A) On the left end
B) In the center
C) On the right side
D) Directly to the left of the title
Answer: https://biology-forums.com/index.php?topic=271602

Most formatting commands are located in the ________ group on the Home tab.
A) Editing
B) Styles
C) Paragraph
D) Font
Answer: https://biology-forums.com/index.php?topic=270920

Question 90

YFO

R
U

What happens when you type (c) in Word?
A) Nothing; it remains as you typed it.
B) It changes into the trademark symbol.
C) The Symbols dialog box automatically opens.
D) It changes into the copyright symbol.
Answer: https://biology-forums.com/index.php?topic=271386

M
S.
C
O

Question 89

Question 91

LO

Question 92

G

The maximum size of the Text data type is ________ characters.
A) 25
B) 50
C) 200
D) 255
Answer: https://biology-forums.com/index.php?topic=270426

The ________: Show Markup view shows deleted text within the body of a document.
Answer: https://biology-forums.com/index.php?topic=271470

IO

Question 93

B

If you have text in a table row highlighted and press the Delete key, what happens?
A) The row and text are deleted.
B) Only the text is deleted.
C) The entire table is deleted.
D) Nothing. You must delete text and rows with the Ribbon buttons.
Answer: https://biology-forums.com/index.php?topic=271504

Question 94
The ________ options ensures that slides fit within the paper size no matter what the slide size.
Answer: https://biology-forums.com/index.php?topic=271030

Question 95
________ are markers that specify the position for aligning text and organizing information in a document.
Answer: https://biology-forums.com/index.php?topic=271396

Question 96
To change the data source of a chart
A) change the numbers in the spread sheet.
B) use the Select Data Source dialog box from the Select Data button.
C) use a different chart type.
D) click Switch Row/Column in the Data group.
Answer: https://biology-forums.com/index.php?topic=270773

Question 97
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Match the following keyboard shortcuts in many programs with its function:
I.Ctrl+CA.Copy
II.Ctrl+VB.Paste
III.Ctrl+ZC.Select all
IV.Ctrl+XD.Undo
V.Ctrl+AE.Cut
Answer: https://biology-forums.com/index.php?topic=270957

Question 98

A(n) ________ is a group of files from various locations that are displayed in Windows Explorer as single units.
Answer: https://biology-forums.com/index.php?topic=270932

Question 99

R
U

When designing a calculated field, complex formulas can be created with the ________.
A) Expression Builder
B) Table Wizard
C) Form Wizard
D) Report Builder
Answer: https://biology-forums.com/index.php?topic=270463

YFO

Question 100

A combination of cell references, arithmetic operations, values, and/or functions used in calculations is called a ________.
Answer: https://biology-forums.com/index.php?topic=270653

Question 101

Question 102

LO

G

Which of the following is NOT monitored by Track Changes?
A) Additions
B) Formatting changes
C) Document versions
D) Deletions
Answer: https://biology-forums.com/index.php?topic=271429

B

IO

Which of the following is FALSE about folders?
A) Folders can be managed in Windows Explorer.
B) Folders contained within other folders are known as file folders.
C) The sole purpose of a folder is to provide a location for related files.
D) Folders can be created within other folders.
Answer: https://biology-forums.com/index.php?topic=270892

Question 103
The ________ function finds the midpoint value or a list.
Answer: https://biology-forums.com/index.php?topic=270716

Question 104
________ queries contain two or more tables and allow users to take advantage of relationships that have been set between these tables.
Answer: https://biology-forums.com/index.php?topic=270430

Question 105
What are sizing handles?
A) Small circles that appear on all inserted objects in a document.
B) Small squares that appear on all clip art images in a document.
C) Small red circles that appear at the corners of a selected object.
D) Small circles and squares that appear around a selected object.
Answer: https://biology-forums.com/index.php?topic=271379

Question 106
A(n) ________ form displays all fields from a record source in a tabular layout similar to a table’s Datasheet view.
Answer: https://biology-forums.com/index.php?topic=270582
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Question 107

M

________ automatically adjusts spacing between characters to create a more evenly spaced appearance ("Va" for example, will extend the V into the
empty space above the a).
Answer: https://biology-forums.com/index.php?topic=271392

M
S.
C
O

Question 108
Which of the following files could likely be an Excel worksheet used as a data source in Word?
A) Mexico City clients.xml
B) Oaxaca clients. docx
C) Guanajuato clients.mdb
D) Oaxaca Mexico clients.xlsx
Answer: https://biology-forums.com/index.php?topic=271529

YFO

Match the range names to their descriptions:
I.GradesA.Unacceptable name; can't use spaces in names
II.COLB.Acceptable abbreviation for cost-of-living
III.Tax_RateC.Unacceptable name; can't use special symbols and
spaces
IV.Commission RateD.Acceptable range name
V.Discount Rate %E.Acceptable name with underscore
Answer: https://biology-forums.com/index.php?topic=270738

R
U

Question 109

Question 110

G

Sorting ________ from oldest to newest displays data in chronological order.
Answer: https://biology-forums.com/index.php?topic=270872

Question 111

IO

LO

Which of the following is NOT a picture color mode?
A) Washout
B) Sepia
C) Shadow
D) Grayscale
Answer: https://biology-forums.com/index.php?topic=271152

B

Question 112

The navigation buttons allow you to:
A) delete records.
B) edit records.
C) sort records.
D) browse records.
Answer: https://biology-forums.com/index.php?topic=270324

Question 113
________ Top Row keeps only the top row visible as you scroll through a worksheet.
Answer: https://biology-forums.com/index.php?topic=270860

Question 114
By default, new workbooks contain ________ worksheets.
Answer: https://biology-forums.com/index.php?topic=270640

Question 115
Of the four Microsoft Office 2010 programs, the ________ Home tab is unique and quite different than the other programs.
A) Access
B) Word
C) PowerPoint
D) Excel
Answer: https://biology-forums.com/index.php?topic=270917
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Question 117

R
U

How do you toggle fields on and off?
A) Shift+F9
B) Ctrl+F7
C) Ctrl+F9
D) Shift+F6
Answer: https://biology-forums.com/index.php?topic=271514

M
S.
C
O

What prints along with the text of an outline when printing in expanded view?
A) The slide icon only
B) The slide icon and slide number
C) The slide number, slide icon, and animation star
D) Just the slide number
Answer: https://biology-forums.com/index.php?topic=271056

M

Question 116

Question 118

YFO

Irene is working in a database that organizes city court case information. Irene must find court cases in either one of two cities. Irene should use the
Filter by Form ________ condition.
A) query
B) sort
C) OR
D) AND
Answer: https://biology-forums.com/index.php?topic=270342

Question 119

LO

Question 120

G

Related ________ make up a table.
Answer: https://biology-forums.com/index.php?topic=270452

B

IO

Which of the following is FALSE about clip art images?
A) They can be recolored.
B) They can be modified by removing pieces you do not need or want.
C) They are made from a series of combined shapes.
D) Height and width must be adjusted separately.
Answer: https://biology-forums.com/index.php?topic=271144

Question 121

When an audio clip is selected on a slide, the Audio Tools tab appears with two tabs: Format and ________.
Answer: https://biology-forums.com/index.php?topic=271255

Question 122
A ________ is a file containing related one or more worksheets.
Answer: https://biology-forums.com/index.php?topic=270637

Question 123
You need to create a report from an Access database containing sales figures. You want the report to include a final grand total and page numbers.
Which of the following statements accurately defines what you must do in order to achieve these results?
A) Page numbers would included on the page footer section and the grand total would be included on the report footer section.
B) Page numbers would be included on the group header section and the grand total would be included on the group footer section.
C) Page numbers would included on the report footer section and the grand total would be included on the page footer section.
D) Page numbers would included on the report header section and the grand total would be included on the report footer section.
Answer: https://biology-forums.com/index.php?topic=270557

Question 124
Which of the following is NOT a type of inspector in Word 2010?
A) Invisible Content
B) Hidden Text
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C) Formatting Features
D) Document Properties
Answer: https://biology-forums.com/index.php?topic=271305

M

Question 125

M
S.
C
O

What is the primary advantage of Outline view?
A) Document text can be collapsed or expanded.
B) Text can be entered quickly and easily.
C) You can see the hierarchy of the text.
D) Levels can be easily deleted.
Answer: https://biology-forums.com/index.php?topic=271376

Question 126

R
U

Wrap Text (as it applies to Excel)
A) can be downloaded as an add-on .
B) is no longer possible in Excel 2010 due to contract restrictions.
C) is most useful with very short headings.
D) enables data to appear on two or more lines within a cell.
Answer: https://biology-forums.com/index.php?topic=270631

YFO

Question 127
Columns in a table are identified by ________.
Answer: https://biology-forums.com/index.php?topic=271552

Question 128

Question 129

LO

G

Which of the following statements is FALSE?
A) Windows Explorer can rename and delete files.
B) Windows Explorer can create folders.
C) Windows Explorer can create files.
D) Windows Explorer can rename and delete folders.
Answer: https://biology-forums.com/index.php?topic=270897

IO

Nonprinting vertical and/or horizontal lines on a slide to help align objects are known as ________.
Answer: https://biology-forums.com/index.php?topic=271180

B

Question 130

Pressing ________ is a quick and easy way to toggle among uppercase, lowercase, and sentence case formats.
A) Shift+F2
B) Shift+F3
C) Ctrl+F4
D) F5
Answer: https://biology-forums.com/index.php?topic=271354

Question 131
When choosing a chart ________, make sure it complements the chart data and is easy to read.
Answer: https://biology-forums.com/index.php?topic=270790

Question 132
Match the following terms to their meanings:
I.SpreadsheetA.An electronic file that contains a grid of columns
and rows
II.Spreadsheet ProgramB.A computer application used to create and
modify spreadsheets
III.WorksheetC.A handwritten, paper way to store and
calculate data
IV.WorkbookD.A file containing related worksheets
V.LedgerE.A spreadsheet that contains formulas,
functions, values, etc
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Answer: https://biology-forums.com/index.php?topic=270660

Which of the following is TRUE about themes in PowerPoint 2010?
A) A theme can be added from the Insert tab.
B) The Theme gallery can display each theme as Live Preview.
C) A theme includes animation and transitions.
D) A theme is automatically applied to only the currently selected slide.
Answer: https://biology-forums.com/index.php?topic=270981

Question 135

R
U

Question 134

M
S.
C
O

Match the follow samples of changeable font effects options to the type of effect:
I.Width, Dash type, Arrow settingsA.3-D Format
II.Bevel, Depth, SurfaceB.Glow and Soft Edges
III.Color, Size, Presets C.Reflection
IV.Presets, Size, BlurD.Shadow
V.Color, Transparency, AngleE.Outline Style
Answer: https://biology-forums.com/index.php?topic=271414

M

Question 133

YFO

Which of the following is the best application to store large amounts of data?
A) Word
B) Wordpad
C) Access
D) PowerPoint
Answer: https://biology-forums.com/index.php?topic=271526

G

Question 136

IO

LO

Match the following descriptions to their correct term:
I.listing of topics and page numbersA.index
II.descriptive title for an equation, figure, or tableB.table of contents
III.listing of headings and page numbersC.table of figures
IV.listing of captions in a documentD.table of authorities
V.listing of cases, legal briefs, and other legal
documentsE.caption
Answer: https://biology-forums.com/index.php?topic=271491

B

Question 137

All of the following are valid statements in reference to the IIf function EXCEPT:
A) IIf functions can only be used when a condition will evaluate to either true or false
B) IIf functions can be nested when two when two conditions are not sufficient to evaluate an expression
C) IIf functions can contain other functions as arguments
D) IIf functions work only with numeric values and not with text
Answer: https://biology-forums.com/index.php?topic=270495

Question 138
Relationships in a database can be graphically represented by the ________ between the tables.
Answer: https://biology-forums.com/index.php?topic=270377

Question 139
When ________ is enabled, Word will recuperate your file if Word crashes prior to saving the file.
Answer: https://biology-forums.com/index.php?topic=271333

Question 140
How does the Play Across Slides from the Audio Options group differ from the Loop Until Stopped check box?
A) Play Across Slides lets you set the number of slides you wish the audio to play, the Loop Until Stopped option does not
B) Play Across Slides lets you choose up to 10 slide for the audio to play across; the Loop Until Stopped option allows an unlimited number of slides
C) Play Across Slides allows you to choose two or more sounds to play simultaneously; the Loop Until Stopped option only allows you to play one over
and over again
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D) Play Across Slides doesn't let you choose the number of slides to play the audio; the Loop Until Stopped option does
Answer: https://biology-forums.com/index.php?topic=271223

M
S.
C
O

In Windows Explorer, what important information does the Address bar offer when saving a file?
A) The file size
B) The current drive or folder
C) The last file saved
D) The current application being used
Answer: https://biology-forums.com/index.php?topic=270895

M

Question 141

Question 142

The ________ view can be used to change the appearance of a form but cannot be used to edit individual records.
Answer: https://biology-forums.com/index.php?topic=270586

Question 143

YFO

R
U

Top Bottom Rules
A) is a horizontal gradient or solid fill indicating the cell's relative value compared to other selected cells.
B) moves the data from the top of the workbook to the bottom for analysis.
C) highlight cells meeting specified criteria with a specified color, font, or border.
D) format cells based upon their value in relation to the value of other cells such as the top 10%.
Answer: https://biology-forums.com/index.php?topic=270850

Question 144

The ________ function totals the values in two or more cells and displays the result in the cell containing the function.
Answer: https://biology-forums.com/index.php?topic=270714

G

Question 145

IO

LO

Which of the following is TRUE about bitmap images?
A) Bitmap images can become pixelated.
B) Bitmap images can be related to connect-the-dot images.
C) Bitmap images are created by mathematical statements.
D) Bitmap image clarity is not of photograph quality.
Answer: https://biology-forums.com/index.php?topic=271193

Question 146

B

Match the following numbers to the spaces in the second column sentences:
I.oneA.Bulleted text should be _________ pt or higher.
II.fourB.Use ________ space after punctuation.
III.nineC.PowerPoint offers ________ levels of indentation.
IV.28D.Title text should be at least ________ pts.
V.36E.To move a slide, the mouse point changes to a ________-headed
arrow.
Answer: https://biology-forums.com/index.php?topic=271108

Question 147
If you have a section break with unique formatting in each section, and you delete the section break, what happens?
A) The section formatting is deleted when the section break is deleted and it takes on the formatting of the following section.
B) Nothing; the document will retain all of the formatting.
C) The section break is removed and a hard page break is inserted.
D) The section formatting adopts the Word 2010 default formatting when the section break is deleted.
Answer: https://biology-forums.com/index.php?topic=271290

Question 148
The ________ control enables users to keep controls aligned horizontally and vertically, and give their forms a uniform appearance.
Answer: https://biology-forums.com/index.php?topic=270597

Question 149
The table or query that supplies underlying data to a form or report is called the:
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M

A) Information source
B) Data source
C) Record source
D) Object source
Answer: https://biology-forums.com/index.php?topic=270535

Expression Builder can be opened by selecting Builder located in the Query:
A) Show/Hide group
B) Setup group
C) Type group
D) Results group
Answer: https://biology-forums.com/index.php?topic=270489

Question 151

M
S.
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O

Question 150

YFO

R
U

The ________ wrap text style wraps text around the perimeter and inside any open portions of an object.
A) Tight
B) Square
C) Through
D) Top and Bottom
Answer: https://biology-forums.com/index.php?topic=271380

Question 152

IO

LO

G

Match the description of the Excel function to their steps:
I.When you select a chart, Excel displays a A.Design, Layout, and Format
Chart Tools contextual tab with three specific tabs
II.After creating a chart you can B.Design tab / Change Chart
change the chart type by usingType button
III.To reverse the Data Series of a chartC.use the Select Data Source
dialog box from the Select
Data button
IV.To change the data source of a chartD.a miniature chart contained
in a single cell
V.A sparklineE.click Switch Row/Column
in the Data group
Answer: https://biology-forums.com/index.php?topic=270815

B

Question 153

A(n) ________ is movement applied to an object or text and is viewable in Slide Show view.
Answer: https://biology-forums.com/index.php?topic=271022

Question 154
What does clicking the pushpin next to each file name on the Recent Documents list do?
A) The file will remain on the Recent Documents list for one full week.
B) The file will remain on the Recent Documents list indefinitely.
C) The file can be "pinned" to a particular folder that you designate.
D) The file is available to be "pinned" to the Quick Access Toolbar.
Answer: https://biology-forums.com/index.php?topic=270913

Question 155
To convert a table back into a range,
A) click within the table, click the Table Tools Design tab, and then select Convert to Range.
B) click the Insert tab and then click Range in the Range group.
C) select any cell in the worksheet then click Existing Range in the Tools group.
D) click in a cell and on the Home tab, click the Insert arrow in the Cells group.
Answer: https://biology-forums.com/index.php?topic=270830

Question 156
The ________ cell is the current cell, indicated by a dark border.
Answer: https://biology-forums.com/index.php?topic=270647
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Question 157

M
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Which of the following is NOT a function of the Start button?
A) A way to open programs
B) A way to arrange icons on the desktop
C) Get help
D) Shut down the computer
Answer: https://biology-forums.com/index.php?topic=271580

Question 158

Using a field that contains a birth year and a field that contains the current year to determine the age of a person listed in a database is called
________.
Answer: https://biology-forums.com/index.php?topic=270453

Question 159

R
U

A(n) ________ form combines two views of the same record source, displaying one section in a stacked layout and the other in a tabular layout.
Answer: https://biology-forums.com/index.php?topic=270581

Question 160

YFO

The ________ wrapping style permits text to wrap very closely around the outer edges of an image instead of the frame.
Answer: https://biology-forums.com/index.php?topic=271409

Question 161

________ uses special effects applied to the text itself, not to the shape surrounding the text.
Answer: https://biology-forums.com/index.php?topic=271170

G

Question 162

Question 163

LO

The ________ tool creates a customizable form that displays the data in a form in both Form view and Datasheet view at the same time.
Answer: https://biology-forums.com/index.php?topic=270601

B

IO

Which of the following should be primarily be avoided?
A) Bullet text of 28 pt or higher
B) Underlining text
C) Creating a focal point on slides
D) Title text 36 pt or higher
Answer: https://biology-forums.com/index.php?topic=271076

Question 164

Use Shift or ________ to select more than one image to be inserted into a photo album presentation.
A) Alt
B) F1
C) Ctrl
D) PgDn
Answer: https://biology-forums.com/index.php?topic=271230

Question 165
A(n) ________ generally appears at the bottom of slides and offers consistent text and/or graphics on each slide.
Answer: https://biology-forums.com/index.php?topic=271025

Question 166
A recipient list is also known as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271560

Question 167
A sparkline is
A) is a label that describes either the category axis or the value axis.
B) a miniature chart contained in a single cell.
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C) is the value or name of a data point.
D) is a label that describes the chart.
Answer: https://biology-forums.com/index.php?topic=270774

M

Question 168

M
S.
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Access provides built-in, colored ________ which can be applied to a report in order to enhance the appearance of the report and give the report a
uniform appearance.
Answer: https://biology-forums.com/index.php?topic=270592

Question 169

R
U

The ________ tab contains all the tools necessary for producing tables, forms, and queries in Access.
A) External Data
B) Database Tools
C) Create
D) Home
Answer: https://biology-forums.com/index.php?topic=270352

Question 170

YFO

Hidden text shows on the screen if you click the ________ button in the Paragraph group on the Home tab.
Answer: https://biology-forums.com/index.php?topic=271390

Question 171

LO

Question 172

G

Match the following keyboard navigation controls to their function:
I.HomeA.beginning of the document
II.EndB.end of the document
III.Ctrl+EndC.top of the previous page
IV.Ctrl+PgUp D.end of a line
V.Ctrl+HomeE.beginning of a line
Answer: https://biology-forums.com/index.php?topic=271341

B

IO

A record
A) is an individual piece of data, such as a last name.
B) defines the range of data to print.
C) is a complete set of data for an entity.
D) is the sequence in which pages print.
Answer: https://biology-forums.com/index.php?topic=270827

Question 173

A page break
A) freezes only the top row.
B) is the sequence in which pages print.
C) indicates where data starts on a new printed page.
D) stops the printer from printing.
Answer: https://biology-forums.com/index.php?topic=270821

Question 174
The ________ displays the number of the current record as well as the total number of records in the table.
Answer: https://biology-forums.com/index.php?topic=270374

Question 175
To Transpose Columns and Rows
A) select and copy the original range then click the top left corner of the destination range, click the Paste Arrow, and then click Transpose.
B) save and close the document, then reopen it in "Transpose mode".
C) drag and drop A-Z onto 1-26.
D) drag the range to a new location on the worksheet.
Answer: https://biology-forums.com/index.php?topic=270628

Question 176
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Question 177
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You are working on an Access form and want to apply programming logic to a field in the form. This can be done in ________.
A) Print Preview
B) Design View
C) Stacked View
D) Layout View
Answer: https://biology-forums.com/index.php?topic=270554

To adjust the column width and/or row height of many cells at once
A) just type longer or taller formulas in some of them.
B) click and drag across the cells to select them and use any sizing method you choose.
C) drag the fill handle across the cells.
D) type A1 in the "Go To" dialog box.
Answer: https://biology-forums.com/index.php?topic=270622

Question 178

YFO

R
U

Which of the following statements accurately describes a split form?
A) Split forms combine two different views of two different record sources
B) A Split form is a type of subform
C) You cannot edit records in a Split form
D) Split forms combine two different views of the same record source
Answer: https://biology-forums.com/index.php?topic=270537

Question 179

A(n) ________ is a shape that has a line and is often filled with text and is often used in cartooning.
Answer: https://biology-forums.com/index.php?topic=271161

G

Question 180

Question 181

LO

To place, or ________ an icon to the taskbar allows quick, single-click access to the program.
Answer: https://biology-forums.com/index.php?topic=271637

B

IO

Match the following file names to their descriptions:
I.file1.wmvA.compressed by using MPEG audio file
II.file2.mp3B.recorded music audio file
III.file3.bmpC.compressed video file that requires minimal storage
IV.file4.wmaD.optimized graphic file format for photographs on the Web
V.file5.jpgE.uncompressed, large graphic file consisting of rows and
columns of dots
Answer: https://biology-forums.com/index.php?topic=271272

Question 182
The Page Number command is located on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271318

Question 183
A lookup table
A) looks up a value and returns a related result.
B) contains data for the basis of the lookup and the data to be retrieved.
C) is the lowest value for a specific category or series.
D) is a reference to a cell containing a value to look up.
Answer: https://biology-forums.com/index.php?topic=270692

Question 184
The ________ function isolates a specific portion of a date, such as the day, month, or year, in a date field.
A) DatePart
B) Date
C) DateDiff
D) DateArithmetic
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Answer: https://biology-forums.com/index.php?topic=270466

________ are used in the Relationships window to establish a relationship between two tables.
Answer: https://biology-forums.com/index.php?topic=270439

M
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Question 186

M

Question 185

Ryan is preparing a report based on a table containing outstanding invoices. His boss has asked him to make sure the report includes a grand total.
Ryan should include this information in the ________ section.
Answer: https://biology-forums.com/index.php?topic=270593

Question 187

When you select a picture on a PowerPoint slide, the ________ Format tab becomes available.
Answer: https://biology-forums.com/index.php?topic=271236

R
U

Question 188

YFO

Which of the following statements is TRUE when comparing forms and reports?
A) The same wizard can be used for creating forms and reports.
B) Forms and reports contain the same controls.
C) Themes can be used with Reports, but not with Forms.
D) Creating forms and reports begins by sketching an outline of the form or report.
Answer: https://biology-forums.com/index.php?topic=270546

Question 189

IO

Question 190

LO

G

Match the following parts of the PowerPoint interface with its function
I.Slides tabA.add and edit text for use by the speaker
II.Slide paneB.contains the slide number, theme name, and view
options in Normal view
III.Notes paneC.shows slide thumbnails
IV.status bar D.displays bulleted text of a presentation
V.Outline tabE.edit the current slide
Answer: https://biology-forums.com/index.php?topic=271032

B

The ________ property can be used to create a label that appears in forms and reports.
Answer: https://biology-forums.com/index.php?topic=270444

Question 191

Excel creates charts on the same worksheet as the original data set, but you can ________ the chart to its own chart sheet.
Answer: https://biology-forums.com/index.php?topic=270791

Question 192
How is data in a database stored?
A) In tables
B) As a main document
C) In merge fields
D) In header rows
Answer: https://biology-forums.com/index.php?topic=271528

Question 193
Which of the following is NOT a way to return to a document from the Backstage view?
A) Click the document thumbnail
B) Click the File tab
C) Click the Close button on the Backstage view window
D) Click ESC on the keyboard
Answer: https://biology-forums.com/index.php?topic=271308

Question 194
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Question 195

YFO

R
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The ________ group on the Review tab includes Accept and Reject buttons.
A) Proofing
B) Comments
C) Changes
D) Tracking
Answer: https://biology-forums.com/index.php?topic=271433

M
S.
C
O

Match the following terms to their meanings:
I.A surface chart displaysA.relationships among three values
by using bubbles
II.A doughnut chart displaysB.contains a single chart and no
spreadsheet data
III.A bubble chart showsC.enables you to adjust the size of
the chart
IV.A chart sheetD.trends using two dimensions on a
continuous curve
V.A resizing handle, indicated by faint
dots on the outside border of a selected chartE.values as percentages of the whole
but may contain more than one data series
Answer: https://biology-forums.com/index.php?topic=270811

M
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Question 196

A data ________ is a group of related data points.
Answer: https://biology-forums.com/index.php?topic=270780

Question 197

IO

Question 198

LO

G

What is syntax?
A) The rules for constructing an equation
B) The arrangement of data in ascending order
C) Data inserted into a main document during a mail merge
D) Data source information
Answer: https://biology-forums.com/index.php?topic=271512

B

Which of the following is considered the most commonly used in a long document?
A) Table of Figures
B) Captions
C) Table of Contents
D) Table of Authorities
Answer: https://biology-forums.com/index.php?topic=271453

Question 199
Which of the following audio files would most likely be used to create sound files for UNIX computers?
A) bells_ringing.mp3
B) traffic.wav
C) dog_barking.midi
D) cat_purring.au
Answer: https://biology-forums.com/index.php?topic=271216

Question 200
The ________ keys on the keyboard allow a user to cycle through all open windows.
A) Ctrl+Shift
B) Shift+Tab
C) Alt+Ctrl
D) Alt+Tab
Answer: https://biology-forums.com/index.php?topic=271604

Question 201
Which of the following is TRUE about reusing slides from an existing presentation?
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A) The file from which you are reusing slides must be open.
B) Slides can only be reused from older version of PowerPoint.
C) To start the process, click the File tab.
D) When you insert a slide into an open presentation, the slide takes on the formatting of the current presentation.
Answer: https://biology-forums.com/index.php?topic=271067

Match the following terms to their descriptions:
I.row in an Excel tableA.increases the number of
columns
II.creating a table from existing data in a rangeB.increases the number of rows
III.converting a table back into a rangeC.restores Range tools
IV.Adding a record to a tableD.enables unique table tools
V.adding a field to a tableE.represents a record.
Answer: https://biology-forums.com/index.php?topic=270885

R
U

Question 203

M
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Question 202

________ options are the settings that are in effect when an application is installed. Spelling and grammar checker as active is one example of this.
Answer: https://biology-forums.com/index.php?topic=270951

YFO

Question 204
The foreground of a picture can be described as the:
A) portion to be removed.
B) only portion available for the contrast and brightness features.
C) portion to be kept.
D) portion that is compressed within a photo.
Answer: https://biology-forums.com/index.php?topic=271383

G

Question 205

IO

LO

Match the following Word features with their association:
I.BibliographyA.topics and page numbers in a document
II.Table of authoritiesB.considered by many as a Works Cited
III.Table of figuresC.a reference of captions
IV.Table of contentsD.used in legal documents
V.IndexE.headings as they appear in a document
Answer: https://biology-forums.com/index.php?topic=271494

B

Question 206

________ is the process of displaying only records that meet specific conditions.
Answer: https://biology-forums.com/index.php?topic=270873

Question 207
If you need to create a report quickly, you can use the Report ________, which asks a series of questions and designs a custom report based on your
answers.
Answer: https://biology-forums.com/index.php?topic=270599

Question 208
Which of the following is a less common data field in a recipient list?
A) first name
B) last name
C) phone number
D) date of birth
Answer: https://biology-forums.com/index.php?topic=271523

Question 209
Which of the following is TRUE about the SmartArt diagram galleries?
A) There are two: colors and special effects
B) There are three: colors, effects, and fill
C) There are two: colors and shapes
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D) There are two: layout and colors
Answer: https://biology-forums.com/index.php?topic=271137

M
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Where would you create a field to track company information such as customer contact or product type?
A) Document Panel
B) Compatibility Checker
C) Window search tool
D) Document Inspector
Answer: https://biology-forums.com/index.php?topic=271312

Question 212

R
U

Question 211
Important or serious alerts in the Action Center are noted by a:
A) red, flashing sign.
B) red star.
C) yellow flag.
D) red flag.
Answer: https://biology-forums.com/index.php?topic=271616

YFO

When you use the mouse to drag around and select an array of objects, you have created a(n) _________.
Answer: https://biology-forums.com/index.php?topic=271164

Question 213

LO

G

In Access, a query criterion use to locate a blank field is:
A) Empty
B) Void
C) Null
D) Invalid
Answer: https://biology-forums.com/index.php?topic=270405

Question 214

M

Question 210

B

IO

One benefit of using range names in formulas is
A) it directly or indirectly refers to the cell containing the formula.
B) it contains both an absolute and a relative cell reference.
C) it identifies the present value of the loan.
D) if you copy the formula, you do not have to make the cell reference absolute.
Answer: https://biology-forums.com/index.php?topic=270705

Question 215

A ________ is a space for individual piece of data within a record, such as a street name.
Answer: https://biology-forums.com/index.php?topic=270865

Question 216
The Show/Hide button is located on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271400

Question 217
Match the math and statistical functions to their descriptions:
I.=ROUND(number,nun_digits)A.Returns the average of the
internal values in a range by
excluding the outliers
II.=SUMPRODUCT(array1,[array2],[array3],...)B.Finds the result of multiplying
the values in one range by the
related values in another column
and then adding those products
III.=TRIMMEAN(array1,percent)C.Rounds a value to a specific
number of digits
IV.=TRUNC(number,[num_digits])D.Displays the absolute value
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of a number
V.=ABS(number)E.Returns the integer equivalent
of a number by removing the
decimal or fractional portion
Answer: https://biology-forums.com/index.php?topic=270735
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Question 218
A single data series
A) compares values for one set of data.
B) groups or clusters similar data in columns to compare values across categories.
C) is a key that identifies the color, gradient, picture, texture, or pattern fill assigned to each data series in a chart.
D) compares two or more sets of data in one chart.
Answer: https://biology-forums.com/index.php?topic=270751

Question 219

YFO

R
U

Match the following descriptions to their correct term:
I.citation at the bottom of a pageA.footnote
II.citation after all text in a documentB.endnote
III.all citation sources in a current documentC.Master List
IV.a database of all citation sources in WordD.bibliography
V.list of works cited by an author in
a documentE.Current List
Answer: https://biology-forums.com/index.php?topic=271493

Question 220

IO

Question 221

LO

G

Match the following programs or features to their descriptions:
I.Windows DefenderA.Windows 7 software to help prevent unauthorized
incoming and outgoing traffic
II.Windows UpdateB.antispyware software
III.Windows FirewallC.modifications to the operating system
IV.Parental controlsD.includes a bar to adjust the level of security
V.UACE.limit hours of access, types of games available, or
programs that run
Answer: https://biology-forums.com/index.php?topic=271665

B

Which of the following is TRUE about the Outline view?
A) Double-click the slide icon to collapse or expand slide content.
B) You can only collapse or expand a full presentation, not a single slide.
C) Press Tab to create a new slide
D) The collapsed outline view displays only the slide icon.
Answer: https://biology-forums.com/index.php?topic=271055

Question 222
A table of ________ lists a variety of legal cases or other legal documents referred to in a legal brief.
Answer: https://biology-forums.com/index.php?topic=271485

Question 223
Match the PowerPoint feature with the group where it can be accessed:
I.change slide orientationA.Page Setup group
II.remove all transitionsB.Text group
III.create a headerC.Start Slide Show group
IV.check animationsD.Timing group
V.view a slide show from the beginningE.Preview group
Answer: https://biology-forums.com/index.php?topic=271039

Question 224
The ________ button in the Changes group on the Review tab allows you to remove a suggested change.
Answer: https://biology-forums.com/index.php?topic=271468
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Freezing rows and/or columns
A) collects structured, related data in columns and rows.
B) keeps them visible as you scroll through a worksheet.
C) indicates where data starts on a new printed page.
D) enables you to adjust settings to control how the worksheet will print.
Answer: https://biology-forums.com/index.php?topic=270817

Question 226

R
U

When you use the Split Form tool, the ________ views are synchronized with each other at all times.
A) Form and Layout
B) Layout and Design
C) Form and Datasheet
D) Design and Datasheet
Answer: https://biology-forums.com/index.php?topic=270562

Question 227

YFO

Match the PowerPoint 2010 feature with the group where they are located:
I.SmartArtA.Text group
II.Convert to SmartArt GraphicB.Paragraph group
III.WordArtC.Illustrations group
IV.ColorD.Arrange group
V.RotateE.Adjust group
Answer: https://biology-forums.com/index.php?topic=271188

Question 228

LO

Question 229

G

Using Conditional ________ to highlight errors" helps locate errors in cells quickly.
Answer: https://biology-forums.com/index.php?topic=270880

B

IO

Jen is working on a database that stores employee data. In the EmployeeData Table, there is a field that stores the number of years each employee
has been with the company. She needs to design a query that shows all employees that have worked for company more than ten years. Which of the
following query criteria should Jen use to locate is information and display records of employees with the company more than ten years?
A) >10
B) #10#
C) =>10
D) <>10
Answer: https://biology-forums.com/index.php?topic=270392

Question 230
The ________: Show Markup view displays the inserted text in the body of the document and deleted text in a balloon.
Answer: https://biology-forums.com/index.php?topic=271471

Question 231
The order of ________ controls the sequence in which Excel does math.
Answer: https://biology-forums.com/index.php?topic=270656

Question 232
Which of the following is NOT typically included in a table of authorities?
A) Legal cases
B) Treaties
C) Legal rules
D) Captions
Answer: https://biology-forums.com/index.php?topic=271457

Question 233
Match the following galleries with their description:
I.Theme galleryA.includes soft glow, shadows, and
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three-dimensional
II.Colors galleryB.includes checks, stripes, blocks, and dots
III.Theme Fonts galleryC.pairs title text with body text
IV.Effects galleryD.eight options viewable from the Design tab and
can click More for the full gallery
V.Background Styles galleryE.part of a theme design that defines a set of shades
for all slides
Answer: https://biology-forums.com/index.php?topic=271115

M
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Question 235

YFO

Match the following features of a dialog box to each example:
I.option buttonA.incrementally increase the number of pages to print
II.text boxB.mutually exclusive set: print current page, specific pages,
or all pages
III.list boxC.print a specific range of pages
IV.spin arrowD.several print options: printing all pages, only odd or even
pages
V.check boxE.several toggle options: print to a file, use manual duplex
Answer: https://biology-forums.com/index.php?topic=271669

R
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Which of the following is NOT a method of selecting more than one shape in order to apply a Quick Style?
A) Drag the mouse around all objects
B) Press Ctrl and select each object
C) Press Shift and select each object
D) Press Alt and select each object
Answer: https://biology-forums.com/index.php?topic=271124

G

Question 236

IO
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Match the following design tips with how the tip can be followed:
I.Keep the design neat and cleanA.Use clip art of only one style
II.Use unified design elementsB.Leave this only for hyperlinks
III.Choose fonts appropriatelyC.Bullet text should be in sentence case
IV.Make text readable D.Use a maximum of three fonts per slide
V.Do not underline textE.Use sans serif for presentations on a projector
Answer: https://biology-forums.com/index.php?topic=271116

B

Question 237

It is important to use either ________ view or Slide Sorter view when creating sections.
Answer: https://biology-forums.com/index.php?topic=271095

Question 238
Which of the following statements is true regarding multi-table queries?
A) Skill is required in choosing the right tables and managing table relationships
B) If join lines do not appear between tables, the multi-table query results will not be affected
C) Creating a multi-table query is different from creating a single table query
D) You should add all the tables in a database to your multi-table query
Answer: https://biology-forums.com/index.php?topic=270421

Question 239
Changing features of a theme can be done through the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271100

Question 240
If you narrow the margins of a document and the lines of text of a paragraph with only soft returns are made longer, what happens to the number of
soft returns?
A) The number remains the same
B) The number of soft returns decreases
C) The number of soft returns increases
D) All soft returns are replaced with hard returns
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Answer: https://biology-forums.com/index.php?topic=271276

Question 241
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A field name can begin with a(n) ________.
A) space
B) accent grave
C) period
D) number
Answer: https://biology-forums.com/index.php?topic=270425

Question 242

R
U

WordArt can be added to a slide from the ________ tab.
A) Home
B) Design
C) Slide Show
D) Insert
Answer: https://biology-forums.com/index.php?topic=271141

Question 243

YFO

If you use Remote Assistance with someone who does not have Windows 7, an invitation file is sent. the invitation file includes a ________ that is
used to connect the two computers.
A) help file and password
B) login and password
C) Website address
D) password
Answer: https://biology-forums.com/index.php?topic=271631

G

Question 244
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WordArt Text Effects include a unique ________ option to rotate the WordArt text around a path.
A) 3-D Rotation
B) Shadow
C) Bevel
D) Transform
Answer: https://biology-forums.com/index.php?topic=271143

Question 245

B

Marla is working in a database that stores customer purchases. She needs to find customers in the New York area that have purchased over $5000
worth of goods. Which query operator would Marla use in a query to find this information?
A) OR
B) NOT
C) AND
D) NULL
Answer: https://biology-forums.com/index.php?topic=270403

Question 246
It is suggested that a title slide should include a title in ________ words.
A) two to five
B) a minimum of six
C) ten to fifteen
D) a minimum of fifteen
Answer: https://biology-forums.com/index.php?topic=270974

Question 247
Which of the following is FALSE about sections in PowerPoint?
A) They help you group meaningful slides together.
B) You can change section names
C) Slide sections can be created in Slide Show view.
D) Slide sections can be collapsed.
Answer: https://biology-forums.com/index.php?topic=271070
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Match the following windows to an option included within that window:
I.ComputerA.Windows Remote Assistance button
II.Windows Help and SupportB.pencil tool, brushes, colors, shapes
III.PaintC.spyware check
IV.Windows DefenderD.a summary of computer's disk configuration
V.WordPad E.formatting tools
Answer: https://biology-forums.com/index.php?topic=271667

Question 250

YFO

What tab is accessed in order to print a slide show?
A) File
B) Home
C) Insert
D) Review
Answer: https://biology-forums.com/index.php?topic=271000
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Question 249
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Match the PowerPoint feature or function with the tab where it can be accessed:
I.see slide in a three-pane windowA.Slide Show tab
II.view slides from the first slideB.View tab
III.save a file with a new nameC.Home tab
IV.create a new slideD.Design tab
V.choose a new themeE.File tab
Answer: https://biology-forums.com/index.php?topic=271034

M

Question 248

G

Question 251
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Which of the following is TRUE about files?
A) Software is used to create folders, not files.
B) For a file to be accessed at a later time, it must be stored only on the computer's hard drive.
C) A digital photograph or music can be a file.
D) Files contain folders.
Answer: https://biology-forums.com/index.php?topic=270891

Question 252

B

An (A) ________ cell reference provides a permanent reference to a specific cell.
Answer: https://biology-forums.com/index.php?topic=270709

Question 253

All of the following are true in reference to Expression Builder EXCEPT:
A) Expression Builder inserts placeholders that tell you where each argument belongs when you insert functions
B) Expression Builder gives you lists of fields, operators, and functions you need to create expressions.
C) Expression Builder can be used when working with controls in forms and reports.
D) Expression Builder can only be used with functions designed by the user and not with built-in functions
Answer: https://biology-forums.com/index.php?topic=270482

Question 254
A data series
A) displays data comparisons vertically in columns.
B) is a group of related data points.
C) is text that describes a collection of data points in a chart.
D) contains the entire chart and all of its elements.
Answer: https://biology-forums.com/index.php?topic=270742

Question 255
________ view is a new view in PowerPoint 2010.
Answer: https://biology-forums.com/index.php?topic=271008

Page 31 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Question 256

M

A(n) ________ control is a word or phrase that describes data, and is usually positioned to the left of a text box control.
Answer: https://biology-forums.com/index.php?topic=270588

Question 257

M
S.
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A legend
A) places stacks of data in segments on top of each other in one column, with each category in the data series represented by a different color.
B) adds a third dimension to each data series, creating a distorted perspective of the data.
C) places (stacks) data in one column per category, with each column having the same height of 100%.
D) is a key that identifies the color, gradient, picture, texture, or pattern fill assigned to each data series in a chart.
Answer: https://biology-forums.com/index.php?topic=270754

Question 258

YFO
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A stacked column chart
A) places stacks of data in segments on top of each other in one column, with each category in the data series represented by a different color.
B) adds a third dimension to each data series, creating a distorted perspective of the data.
C) compares values across categories using horizontal bars.
D) places (stacks) data in one column per category, with each column having the same height of 100%.
Answer: https://biology-forums.com/index.php?topic=270755

Question 259

LO

Question 260

G

What type of form displays records in a tabular layout similar to a table’s Datasheet view but has more editing options, such as adding graphics and
buttons, than a datasheet?
A) Split Form
B) Multiple Items Form
C) Subform
D) Datasheet form
Answer: https://biology-forums.com/index.php?topic=270538

B

IO

Match the keystrokes to their descriptions:
I.Up ArrowA.Move up one cell in the same column
II.Down ArrowB.Move left one cell in the same row
III.Left ArrowC.Move down one cell in the same column
IV.Right ArrowD.Move right one cell in the same row
V.HomeE.Move the active cell to column A of current row
Answer: https://biology-forums.com/index.php?topic=270663

Question 261

A circular reference
A) is a predefined formula that performs a calculation.
B) is a rule that governs the structure and components for functions.
C) occurs when a formula directly or indirectly refers to the cell containing the formula.
D) is an input such as a cell reference or a value needed to complete a function.
Answer: https://biology-forums.com/index.php?topic=270675

Question 262
The New Slide arrow is located on the ________ tab.
A) File
B) Insert
C) Home
D) Design
Answer: https://biology-forums.com/index.php?topic=271066

Question 263
Sheila is creating a database that will store student data. The database will contain a Field named DeansList. This field identifies whether or not a
student appears on the dean’s list. Sheila should use the ________ data type to this field.
Answer: https://biology-forums.com/index.php?topic=270437
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Question 264

M

Excel displays the row labels in the first column on the ________ axis.
Answer: https://biology-forums.com/index.php?topic=270787

Question 265

M
S.
C
O

Conditional formatting
A) highlights or emphasizes cells that meet certain conditions.
B) tags a table element as a reference in a formula.
C) formats the condition of the worksheet in preparation for printing.
D) calculates an aggregate for values in a range or database.
Answer: https://biology-forums.com/index.php?topic=270848

Question 266
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Which of the following is TRUE about a focal point on a slide?
A) It is important to always have your images quite large to create a focal point.
B) The viewer's eyes should be led away from the focal point.
C) It is important to create a focal point that leads the viewer's eyes to critical information.
D) The focal point should never be the main area of interest on a slide.
Answer: https://biology-forums.com/index.php?topic=271073

Question 267

G

The ________ option will stretch a title to span across the top of a page.
A) Condensed
B) Kerning
C) Positioning
D) Expanded
Answer: https://biology-forums.com/index.php?topic=271355

LO

Question 268

IO

Which of the following is FALSE about SmartArt objects?
A) Special modifications include Text Fill, Text Effects, and a Transform option
B) A pane is provided for entering information
C) Shapes and text is automatically resized
D) Layouts can easily be changed
Answer: https://biology-forums.com/index.php?topic=271131

B

Question 269

Previewing the worksheet in Backstage view
A) autoprints
B) sets the sequence in which pages print.
C) enables you to adjust settings to control how the worksheet will print.
D) defines the range of data to print.
Answer: https://biology-forums.com/index.php?topic=270820

Question 270
Match the following terms to their meanings:
I.taskbarA.onscreen rectangular area
II.windowB.pointer, or link, to a program or resource
III.iconC.displays icons for background programs and resources
IV.shortcutD.area that enables you to move among open applications
V.Notification areaE.small picture on the desktop
Answer: https://biology-forums.com/index.php?topic=271660

Question 271
Match the following terms to their meanings:
I.The value axisAcompares two or more sets of data in
one chart
II.A single data series chartB.is a key that identifies the color, gradient,
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picture, texture, or pattern fill assigned
to each data series in a chart
III.A multiple data series chartC.displays incremental values to identify
the values of the data series
IV.A clustered column chartD.compares values for one set of data
V.A legendE.groups or clusters similar data in columns
to compare values across categories
Answer: https://biology-forums.com/index.php?topic=270808

Question 272

Question 273

YFO

The default alignment of Word documents is:
A) left-aligned.
B) justified.
C) right-aligned.
D) centered.
Answer: https://biology-forums.com/index.php?topic=271365

R
U

A group of fields for a person or thing is known as a:
A) row.
B) data source.
C) record.
D) column.
Answer: https://biology-forums.com/index.php?topic=271524

Question 274

Question 275

LO

G

What does dividing content into sections do?
A) It helps divide a slide into different placeholder areas.
B) It helps divide your animations and transitions into manageable sections that coordinate well together.
C) It structures the text into an organized outline format.
D) It helps you group slides into meaningful segments.
Answer: https://biology-forums.com/index.php?topic=271068

B

IO

The Table Style Options Group
A) contains check boxes to select format actions such as First Column which applies a different format to the first column when checked.
B) keeps Table Options visible as you scroll through a worksheet.
C) enables you to adjust settings to control how many pages will print.
D) is a collection of structured, related data in columns and rows.
Answer: https://biology-forums.com/index.php?topic=270836

Question 276
Which of the following is NOT a SmartArt category diagram?
A) Hierarchy
B) 3-D
C) List
D) Matrix
Answer: https://biology-forums.com/index.php?topic=271132

Question 277
If you have two columns of text and want to change to one column on the same page, insert a(n) ________ section break.
A) Column
B) Continuous
C) Next Page
D) Even Page
Answer: https://biology-forums.com/index.php?topic=271292

Question 278
In the first Form Wizard dialog box, you would specify the ____.
A) tables or queries to be used and the fields to include
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B) layout of the form
C) name of the form
D) design of the form
Answer: https://biology-forums.com/index.php?topic=270551

M

Question 279
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Dianna wants to compact an Access database. She can find the tool to compact the database by clicking on the ________ tab.
A) File
B) Home
C) Create
D) External
Answer: https://biology-forums.com/index.php?topic=270345

Question 280

Question 281

YFO

Match the following document needs to the Word solution:
I.starting a new chapter on a new pageA.hard page break
II.changing orientation in the
middle of a documentB.soft page break
III.continuing text fluidly from one page to the nextC.soft return
IV.end one paragraph and begin another D.section break
V.continue text within a paragraph from line
to lineE.hard return
Answer: https://biology-forums.com/index.php?topic=271340

R
U

A(n) ________ is a set of intersecting lines, similar to graph paper.
Answer: https://biology-forums.com/index.php?topic=271179

G

Question 282

Question 283

LO

When you select an audio clip on a slide, the ________ tab appears but is not relevant to the audio clip.
Answer: https://biology-forums.com/index.php?topic=271256

B

IO

Which of the following is FALSE about paragraph styles?
A) A paragraph style can be applied to multiple paragraphs.
B) A paragraph style stores alignment and line spacing.
C) A paragraph style can be applied to only selected words in a paragraph.
D) Styles can be applied from the Home tab.
Answer: https://biology-forums.com/index.php?topic=271373

Question 284
Match the math and statistical functions to their descriptions:
I. =ABS(number)A.Counts how often a value appears in a
given range
II. FREQUENCY(data_array,bins_array)B.Displays the absolute value of a
number
III. =INT(number)C.Rounds a value number down to the
whole number
IV. =MODE.SNGL(number1,[number2],...)D.Displays the most frequently
occurring value in a list
V. =PI()E.Returns the value of pi accurate
up to 15 digits
Answer: https://biology-forums.com/index.php?topic=270733

Question 285
After you have located a program name from the Start menu, in order to create a shortcut on the desktop,:
A) left-click and choose Create shortcuts here.
B) right-click, drag the program name to the desktop, and click Create shortcuts here.
C) right-click and drag the program name to the desktop.
D) double-click the program name and click Create shortcuts here.
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Answer: https://biology-forums.com/index.php?topic=271576

Question 286

Question 287

M
S.
C
O

M

The ________ file format retains only text without saving any formatting.
A) .txt
B) .htm
C) .docx
D) .rtf
Answer: https://biology-forums.com/index.php?topic=271059

Access is made up of different types of ________, which may include tables, forms, reports, and queries.
Answer: https://biology-forums.com/index.php?topic=270367

Question 288

YFO

R
U

In order to create an outline of a presentation you must be in ________ view.
A) Outline
B) Slide Sorter
C) Normal
D) Slide Show
Answer: https://biology-forums.com/index.php?topic=271047

Question 289

LO

Question 290

G

A nonadjacent range
A) is the best tool to to use to decide which numbers to select.
B) is selected with the "Ctrl + Alt + Delete" key combination.
C) contains two or more cells or ranges that are not touching each other.
D) isn't possible in Excel 2010.
Answer: https://biology-forums.com/index.php?topic=270624

B

IO

Consider the table pictured above. The value of $17.50 in the totals row represents the mean hourly wage. How was this value calculated in the totals
row?
A) This value is a result of the Count function being applied to the HourlyWage Field
B) This value is a result of the Average function being applied to the HourlyWage Field
C) This value is a result of the Sum function being applied to the HourlyWage Field
D) This value is a result of the Maximum function being applied to the HourlyWage Field
Answer: https://biology-forums.com/index.php?topic=270500

Question 291

Match each term to the correct definition.
I.Data RedundancyA.Determines what field values you can enter for a field
II.AutoNumberB.Value of an empty field
III.Data TypeC.Unnecessary duplication of data in multiple tables
IV.Yes/No D.Data type that limits field values to on and off, for example
V.NullE.Data type that contains objects created in other applications
VI.OLE F.Data type that automatically increments each time a record
is entered
VII.Delimiters G.Special characters that surround a criterion’s value
Answer: https://biology-forums.com/index.php?topic=270462

Question 292
All of the following are sections in an Access report EXCEPT:
A) Report Detail section
B) Report Header section
C) Report Calculated section
D) Report Footer section
Answer: https://biology-forums.com/index.php?topic=270560
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Question 293

Question 294

M
S.
C
O

In a query, which of the following statements is true regarding delimiters in the criterion of a field?
A) Text data types must be enclosed in pound signs
B) Number data types require no delimiters
C) Date/Time data types must be enclosed in quotations
D) Number data types must be enclosed in single quotes
Answer: https://biology-forums.com/index.php?topic=270395

M

The Previous and Next buttons are in the ________ group on the Review tab.
Answer: https://biology-forums.com/index.php?topic=271463

Question 295

YFO

R
U

Which of the following special effects is available from the Font dialog box but is not available from the Font group on the Home tab?
A) Strikethrough
B) Subscript
C) Superscript
D) Small caps
Answer: https://biology-forums.com/index.php?topic=271351

Question 296

The ________ value is a reference to a cell containing a value to look up for a function.
Answer: https://biology-forums.com/index.php?topic=270723

Question 297

IO

LO

G

Match the following terms with their descriptions:
I.hanging indentA.marks the location to indent only the first line
in a paragraph
II.first line indentB.refers to placement of text between left and right margins
III.horizontal alignmentC.space between lines in a paragraph
IV.paragraph spacingD.amount of space before or after a paragraph
V.line spacingE.marks how far to indent each line of a paragraph
except the first
Answer: https://biology-forums.com/index.php?topic=271419

B

Question 298

Match the shape or design with their description:
I.vertexA.point where a curve or line ends or meets in a free
form shape
II.selection netB.interior area of a shape
III.fillC.area you define by dragging the mouse
IV.picture fillD.shape filled with an image from a file
V.gradient fillE.blend of two or more colors or shapes
Answer: https://biology-forums.com/index.php?topic=271183

Question 299
In what order are the headings of a table of contents listed?
A) Alphabetically
B) In the order they appear in a document
C) In the order that you entered them into the document
D) In the order of length-the longest first
Answer: https://biology-forums.com/index.php?topic=271445

Question 300
A doughnut chart displays
A) enables you to adjust the size of the chart remotely.
B) relationships among three values by using bubbles.
C) contains a single chart and no spreadsheet data.
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D) values as percentages of the whole but may contain more than one data series.
Answer: https://biology-forums.com/index.php?topic=270766

Question 301

M

The WordArt Quick Style feature is located on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271171

M
S.
C
O

Question 302
What is the keyboard shortcut to enter a hard page break?
A) Ctrl+Spacebar
B) Ctrl+Enter
C) Alt+Enter
D) Ctrl+Tab
Answer: https://biology-forums.com/index.php?topic=271279

Question 303

R
U

________ sorts a list of text data in reverse alphabetical order from Z to A, or a numeric list in highest to lowest.
Answer: https://biology-forums.com/index.php?topic=270380

Question 304

YFO

In addition to sorting and filtering cells by content you can sort and/or filter by
A) Top/Bottom rules
B) conditional formatting.
C) icon sets
D) the data bar
Answer: https://biology-forums.com/index.php?topic=270857

G

Question 305

Question 306

LO

A(n) ________ is a set of formatting options you apply to characters or paragraphs.
Answer: https://biology-forums.com/index.php?topic=271404

IO

________ uses a palette in the center of the window that acts as an easel on which you can draw.
Answer: https://biology-forums.com/index.php?topic=271646

Question 307

B

The ________ view in Access looks similar to an Excel Spreadsheet.
A) Report
B) Form
C) Datasheet
D) Design
Answer: https://biology-forums.com/index.php?topic=270346

Question 308
When you locate an image on the Internet and copy it, where is it copied to?
A) Directly to the slide
B) To the Clipboard
C) To Windows Explorer
D) To the PowerPoint folder
Answer: https://biology-forums.com/index.php?topic=271205

Question 309
Match the following PowerPoint picture tools with their description:
I.sharpeningA.sepia is one example
II.toneB.the difference between the darkest and lightest areas of an
image
III.recolorC.temperature of a color measured in kelvin units
IV.contrastD.making boundaries of the image content more pronounced
V.brightnessE.lightness and darkness of an image
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Answer: https://biology-forums.com/index.php?topic=271264

M
S.
C
O

Choosing the layout for a slide is done by clicking the ________ arrow on the ________ tab.
A) New Layout; Home
B) New Slide; Home
C) New Slide; Insert
D) Slide; Design
Answer: https://biology-forums.com/index.php?topic=270979

M

Question 310

Question 311

R
U

Match the following keyboard navigation controls to their function:
I.Ctrl+PgDnA.one word to the right
II.Ctrl+Right arrowB.down one paragraph
III.Ctrl+Down arrowC.down one line
IV.Down arrowD.right one character
V.Right arrowE.top of next page
Answer: https://biology-forums.com/index.php?topic=271338

Question 312

YFO

The ________ is at the very top of a Word window and displays the file name and application, as well as the Quick Access Toolbar.
Answer: https://biology-forums.com/index.php?topic=271313

Question 313

Question 314

LO

G

Which of the following video options is NOT included on the Video Tools Format tab?
A) Looping
B) Cropping
C) Applying a style
D) Sizing
Answer: https://biology-forums.com/index.php?topic=271210

B

IO

What do you need to do in order for a table of contents to be automatically generated in Word?
A) Nothing; it can be automatically generated without doing anything special.
B) You must designate the first word of each entry by bolding it
C) You must mark each entry from the feature on the References tab.
D) A style must be applied to each heading.
Answer: https://biology-forums.com/index.php?topic=271446

Question 315

Where are all citation sources created in Word saved?
A) In the Current List
B) In the Master List
C) In Track Changes
D) In a bibliography
Answer: https://biology-forums.com/index.php?topic=271438

Question 316
You can use the ________ function in an expression requiring the current date.
A) Date
B) DatePart
C) Now
D) DateDiff
Answer: https://biology-forums.com/index.php?topic=270503

Question 317
The built-in IIf Function evaluates a condition and displays ________.
A) the same value for conditions that evaluate to true or false
B) a value only if the condition is true
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C) one value when the condition is true and another value when the condition is false
D) a value only if the condition is false
Answer: https://biology-forums.com/index.php?topic=270465

M

Question 318

Question 319

R
U

Which PowerPoint correction tool can be overused to make the image appear grainy?
A) Brightness
B) Contrast
C) Sharpening
D) Softening
Answer: https://biology-forums.com/index.php?topic=271203

M
S.
C
O

Which of the following statements offers the best method for ensuring that a database is recoverable in case of corruption?
A) Limit the number of queries containing expressions in order to limit the chances of corrupting the database
B) Avoid using the misspelled names of tables and fields in calculated field expressions
C) Avoid using too many date arithmetic related functions.
D) Make a copy of the database before attempting to make changes to the database.
Answer: https://biology-forums.com/index.php?topic=270496

YFO

Question 320

The ________ ratio is the ratio of an object's width in regard to its height.
Answer: https://biology-forums.com/index.php?topic=271174

Question 321

G

A field can store a web site address or the path to a file if the ________ data type is applied to the field
Answer: https://biology-forums.com/index.php?topic=270455

Question 322

IO

LO

To Create a new Conditional Formatting Rule,
A) convert the cell to a Range.
B) select any cell in the table, then click New Rule in the Tools group.
C) click in a cell and on the Home tab, click the Conditional arrow in the Cells group.
D) click Conditional Formatting from the Cell Styles group and select New Rule.
Answer: https://biology-forums.com/index.php?topic=270854

B

Question 323

________ a video in a presentation connects it to another location such as a Web site or a storage device.
A) Softening
B) Cropping
C) Linking
D) Embedding
Answer: https://biology-forums.com/index.php?topic=271208

Question 324
To Create a new Conditional Formatting Rule, click Conditional Formatting from the Cell ________ group and select New Rule.
Answer: https://biology-forums.com/index.php?topic=270881

Question 325
Where can you store data such as an author's name, purpose of the file, and the intended audience, that won't be seen directly in the document?
A) Document Panel
B) Print Preview features
C) Document Inspector
D) Compatibility Checker feature
Answer: https://biology-forums.com/index.php?topic=271307

Question 326
Items such as a Pencil tool, Brushes, Colors, and Shapes are a part of the ________ program.
A) WordPad
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B) Paint
C) Notepad
D) Snipping Tool
Answer: https://biology-forums.com/index.php?topic=271612

M

Question 327

M
S.
C
O

The Shapes gallery can be accessed from the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271158

Question 328

R
U

The IF function
A) contains data for the basis of the lookup and data to be retrieved.
B) looks up a value and returns a related result from the lookup table.
C) evaluates a condition and returns one value if the condition is true and a different value if the condition is false.
D) contains another function embedded inside one or more of its arguments.
Answer: https://biology-forums.com/index.php?topic=270689

Question 329

YFO

If you have only one account on your computer, it would be known as a(n) ________ account.
A) client
B) administrator
C) user
D) programmer
Answer: https://biology-forums.com/index.php?topic=271618

Question 330

G

A clip art image that has been broken apart into individual pieces has been ________.
Answer: https://biology-forums.com/index.php?topic=271175

LO

Question 331

A(n) ________ view displays the slide icon, the title, and the slide content.
Answer: https://biology-forums.com/index.php?topic=271089

IO

Question 332

B

Match the keystrokes to their descriptions:
I.Page UpA.Move insertion point up one screen
II.Page DownB.Move insertion point down one screen
III.TabC.Move right one cell in the same row
IV.Ctrl + HomeD.Move insertion point to Cell A1
V.Ctrl + EndE.Move insertion point to the last active corner in the worksheet
Answer: https://biology-forums.com/index.php?topic=270664

Question 333
Semi-selection is often called ________ because you use the mouse to select cells as you build the formula.
Answer: https://biology-forums.com/index.php?topic=270707

Question 334
A(n) ________ view of a presentation outline displays only the icon and title of each slide.
Answer: https://biology-forums.com/index.php?topic=271088

Question 335
Jenny is working on a database that stores invoices. She needs to include the current day, month, and year, which will be derived from the computer
system, on each new invoice. She should use the ________ function for this purpose.
A) DatePart
B) Date
C) DateDiff
D) DateArithmetic
Answer: https://biology-forums.com/index.php?topic=270475
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Question 337

M
S.
C
O

To create a table from an existing range of data,
A) click within the range, click the Table Tools Design tab, and then select Convert to Table.
B) select any cell in the worksheet then click Existing Range in the Tools group.
C) click in a cell and on the Home tab, click the Insert arrow in the Cells group.
D) click the Insert tab and then click Table in the Tables group.
Answer: https://biology-forums.com/index.php?topic=270829

A chart ________ is the label that describes the entire chart; it should reflect the purpose of the chart.
Answer: https://biology-forums.com/index.php?topic=270799

Question 338

YFO

R
U

What displays in the Preview pane when you are checking out a template?
A) All of the slides of the template
B) Only the first and last slides of the template
C) Only the file name of the template that you are interested in downloading
D) Only the title slide of the template
Answer: https://biology-forums.com/index.php?topic=271046

Question 339

G

What is the primary purpose of the Snipping Tool in Windows 7?
A) To capture screen displays
B) To capture as scanned image
C) To capture a portion of a WordPad or Notepad file
D) To cut and paste a portion of the desktop into a file
Answer: https://biology-forums.com/index.php?topic=271613

LO

Question 340

IO

Which of the following statements is INCORRECT regarding aggregate functions?
A) Aggregate functions perform calculations on entire columns of data
B) Access refers to aggregate functions as Totals.
C) Aggregate functions are not designed to perform calculations on individual records in a table or query
D) Aggregate functions can return multiple values
Answer: https://biology-forums.com/index.php?topic=270488

B

Question 341

Which of the following refers to moving an object around its axis?
A) Resizing
B) Grouping
C) Aligning
D) Rotating
Answer: https://biology-forums.com/index.php?topic=271148

Question 342
Sheet ________ show the names of the worksheets contained in the workbook.
Answer: https://biology-forums.com/index.php?topic=270643

Question 343
A hierarchy of organized text with main points and subpoints is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271084

Question 344
The HLOOKUP function
A) is the periodic interest rate, such as a monthly interest rate.
B) calculates the periodic payment for a loan with a fixed interest rate and fixed term.
C) looks up a value in a lookup table where the first column contains the values to compare with the lookup value.
D) looks up a value in a lookup table where the first row contains the values to compare with the lookup value.
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Answer: https://biology-forums.com/index.php?topic=270698

Question 345

M

Photographs, clip art, shapes, and screenshots are all considered ________ and retain a separate nature when inserted into a document.
Answer: https://biology-forums.com/index.php?topic=270950

M
S.
C
O

Question 346
Match the grammar or spelling error with the Office 2010 identification or button to click:
I.you write "there" instead of "their"A.Ignore All
II.you write "recieve" instead of "receive"B.red wavy underline
III.you leave out a necessary commaC.green underline
IV.you want it to not stop on your name
in the future D.blue underline
V.you want to bypass all occurrences of "daycare"E.Add to Dictionary
Answer: https://biology-forums.com/index.php?topic=270961

R
U

Question 347

Saving a presentation as a PowerPoint ________ will allow the file to automatically open in Slide Show view.
Answer: https://biology-forums.com/index.php?topic=271010

YFO

Question 348

G

Match the logical operators to their descriptions:
I.=A.Less than or equal to
II.<> B.Equal to
III.< C.Not equal to
IV.> D.Less than
V.<= E.Greater than
Answer: https://biology-forums.com/index.php?topic=270737

LO

Question 349

IO

Which of the following is NOT a step in changing the exact measurement of an object?
A) Select the object
B) Change the Shape Height and/or Shape Weight in the Size group
C) Click the Object contextual tab
D) You can open the Format Shape dialog box from the Size Dialog Box Launcher
Answer: https://biology-forums.com/index.php?topic=271146

B

Question 350

Which of the following is NOT an option from the Delete arrow in the Comments group?
A) Delete the current comment
B) Delete all comments shown
C) Delete only the recent comments
D) Delete all comments at one time
Answer: https://biology-forums.com/index.php?topic=271427

Question 351
When designing a database, all of the following statements are true EXCEPT:
A) You need to consider the output requirements of the database
B) You need not be concerned with the future requirements of the database
C) You should store data in its smallest parts
D) Begin the design process with identification of the tables in the database
Answer: https://biology-forums.com/index.php?topic=270387

Question 352
What displays on a slide (if it hasn't been hidden) to represent an audio file?
A) A black microphone
B) A black megaphone
C) A gray speaker
D) The mouth of a person
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Answer: https://biology-forums.com/index.php?topic=271217

The V________ function looks up a value in a table and returns a result from a specified column in the table.
Answer: https://biology-forums.com/index.php?topic=270722

The ________ Mode allows you to create the same shape over and over and over.
Answer: https://biology-forums.com/index.php?topic=271160

Question 355

M
S.
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Question 354

R
U

Which of the following is NOT an automatic way for Windows 7 to arrange your windows on the desktop.
A) Side by side
B) Cascading
C) Horizontally stacked
D) Vertically stacked
Answer: https://biology-forums.com/index.php?topic=271607

Question 356

YFO

A pie chart
A) shows a relationship between two variables.
B) separates one or more pie slices from the rest of the pie chart.
C) emphasizes magnitude of changes over time by filling in the space between lines with a color.
D) shows each data point in proportion to the whole data series as a slice in a circular pie.
Answer: https://biology-forums.com/index.php?topic=270760

G

Question 357

IO

LO

Which of the following is NOT a feature or function available by using Backstage in Office 2010?
A) Save a file
B) View file properties
C) Move a file
D) Close a file
Answer: https://biology-forums.com/index.php?topic=270903

Question 358

B

A nested function
A) contains data for the basis of the lookup and data to be retrieved.
B) is the lowest value for a specific category or series in a lookup table.
C) looks up a value and returns a related result from the lookup table.
D) contains another function embedded inside one or more of its arguments.
Answer: https://biology-forums.com/index.php?topic=270691

Question 359
What is the shortcut to marking index entries?
A) Shift+M
B) Alt+Shift+I
C) Ctrl+Shift+I
D) Alt+Shift+X
Answer: https://biology-forums.com/index.php?topic=271451

Question 360
Which of the following design elements is most appropriate for an educated, adult audience?
A) Cartoon-like clip art
B) muted earth tones
C) Bright, primary colors
D) Very large fonts that are easy to read
Answer: https://biology-forums.com/index.php?topic=271071

Question 361
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Question 353

Question 362
A cell ________ identifies a cell by a column letter and a row number.
Answer: https://biology-forums.com/index.php?topic=270646

Question 363
To reverse the data series, click ________ Row/Column in the Data group.
Answer: https://biology-forums.com/index.php?topic=270788

Question 364

M
S.
C
O

What default theme is automatically used when you create a new blank presentation in PowerPoint 2010?
A) PowerPoint theme
B) Blank theme
C) Office theme
D) 2010 theme
Answer: https://biology-forums.com/index.php?topic=271041

M
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The chart area
A) contains graphical representation of values in data series.
B) contains the entire chart and all of its elements.
C) is a vertical line that borders the plot area to provide a frame of reference for measurement.
D) is a horizontal line that borders the plot area to provide a frame of reference for measurement.
Answer: https://biology-forums.com/index.php?topic=270745

Question 365

________ order sorts a list of text data in alphabetical order from A to Z, or a numeric list in lowest to highest.
Answer: https://biology-forums.com/index.php?topic=270379

G

Question 366

Question 367

LO

The ________ view organizes and displays data in a summary view.
Answer: https://biology-forums.com/index.php?topic=270433

IO

A(n) _________ SmartArt diagram shows how parts relate to a whole.
Answer: https://biology-forums.com/index.php?topic=271168

Question 368

B

In Windows Explorer, clicking the flash drive or Computer (to locate files on your own hard drive) is done in the ________ pane.
Answer: https://biology-forums.com/index.php?topic=270934

Question 369
A data label
A) is a visual representation of numerical data.
B) is the value or name of a data point.
C) is a line used to depict trends and forecast future data.
D) is a horizontal or vertical line that extends from the horizontal or vertical axis through the plot area.
Answer: https://biology-forums.com/index.php?topic=270777

Question 370
________ functions are functions that are native to Access, perform routine calculations, like Date or IIf, and can be found in the Expression Builder.
Answer: https://biology-forums.com/index.php?topic=270531

Question 371
Because the ________ function is so commonly used, it is available on the Home tab and the Formulas tab under AutoSum.
Answer: https://biology-forums.com/index.php?topic=270715

Question 372
Which of the following Word Options menu categories allows you to enable and disable macros?
A) Advanced
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Question 373

Question 374

R
U

What is displayed in the left pane of the Start menu?
A) A short list of commonly accessed programs from your hard drive
B) Access to system folders such as Documents, Pictures, and Music
C) Areas to access help, shut down the computer, and log off a user account
D) Options to adjust system settings
Answer: https://biology-forums.com/index.php?topic=271601

M
S.
C
O

Which of the following is TRUE about transitions and animations?
A) The more you can include on a slide, the better the presentation will be.
B) Very slow transitions are calming and work well for all types of audiences.
C) When transitions are part of a slide, you cannot delete just one transition, all transitions must be deleted.
D) Too many transitions and animation styles can be distracting for audiences.
Answer: https://biology-forums.com/index.php?topic=270993

YFO

Question 375

IO

LO

G

Match the chart type to their meanings:
I.A stacked column chart A.places stacks of data in segments on top of
each other in one column, with each category
in the data series represented by a different
color
II.A 100% stacked column chartB.compares values across categories using
horizontal bars
III.A 3-D chartC.places (stacks) data in one column per
category, with each column having the
same height of 100%
IV.A bar chartD.uses a line to connect data points in order
to show trends over a period of time
V.A line chartE.adds a third dimension to each data series,
creating a distorted perspective of the data
Answer: https://biology-forums.com/index.php?topic=270809

B

Question 376

You can ________ a database to rearrange the data and objects in the database and decrease its file size.
Answer: https://biology-forums.com/index.php?topic=270357

Question 377
Where does the status bar display when Word 2010 opens?
A) Across the bottom of the window
B) On the right side of the Word window
C) In its own pane at the bottom of the document
D) Directly under the Ribbon
Answer: https://biology-forums.com/index.php?topic=271274

Question 378
You can insert a ________, such as a page number or file name, into a header or footer in a document.
Answer: https://biology-forums.com/index.php?topic=271324

Question 379
The line style around each cell or around a table is referred to as the ________.
Answer: https://biology-forums.com/index.php?topic=271546

Question 380
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B) Language
C) Add-Ins
D) Trust Center
Answer: https://biology-forums.com/index.php?topic=271283
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A collection of formatting choices that includes colors, fonts, and effects is known as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271015

M
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A gridline
A) is a numeric value that describes a single value on a chart.
B) is a line used to depict trends and forecast future data.
C) is a horizontal or vertical line that extends from the horizontal or vertical axis through the plot area.
D) is a visual representation of numerical data.
Answer: https://biology-forums.com/index.php?topic=270778

Question 383

R
U

Question 382
By default, Word sequentially numbers endnotes as:
A) 1, 2, 3 ...
B) I, II, III ...
C) i, ii, and iii ...
D) A, B, C, ...
Answer: https://biology-forums.com/index.php?topic=271441

M

Question 381

YFO

A Table ________ controls the fill color of the header row, columns, and records in a table.
Answer: https://biology-forums.com/index.php?topic=270869

Question 384

The ________ gallery includes options such as soft glow, soft edges, and shadows.
Answer: https://biology-forums.com/index.php?topic=271101

G

Question 385

IO

LO

Match each set of examples with the type of item they represent:
I.reflections, glowsA.lines
II.short dashes, dotsB.shape effects
III.marble, canvasC.arrowheads
IV.light and dark variationsD.gradient fill
V.points, circles, diamondsE.texture fill
Answer: https://biology-forums.com/index.php?topic=271184

B

Question 386

Video clips available from the PowerPoint Clip Art task pane are animated ________ files
A) JPG
B) GIF
C) WMV
D) MPG
Answer: https://biology-forums.com/index.php?topic=271207

Question 387
________ spacing refers to the amount of horizontal space between letters, numbers, and symbols.
Answer: https://biology-forums.com/index.php?topic=271391

Question 388
How often does the AutoRecover feature save a Word document (by default)?
A) Every five minutes
B) Every ten minutes
C) Every fifteen minutes
D) Every twenty minutes
Answer: https://biology-forums.com/index.php?topic=271303

Question 389
Steven is working on a database that stores student data. He needs to find students majoring in either one of two majors. He is looking for students
majoring in Economics. He also is looking for students majoring in History. Which operator would Steven use to find this information?
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A) AND
B) OR
C) NOT
D) NULL
Answer: https://biology-forums.com/index.php?topic=270410

M
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Question 390
Match the following features in Office 2010 to their description:
I.groupA.contains related groups of tasks
II.tabB.contains tabs, groups, and commands
III.commandC.window to make selections beyond those
provided on the Ribbon
IV.RibbonD.button or area within a group
V.dialog boxE.contains related commands
Answer: https://biology-forums.com/index.php?topic=270962

R
U

Question 391

YFO

A Value (as it applies to Excel)
A) controls the sequence in which Excel performs arithmetic operations.
B) is a number that represents a quantity and can be the basis of calculations.
C) includes letters, numbers, and spaces.
D) is a combination of cell references, operators, values, and/or functions used to perform calculations.
Answer: https://biology-forums.com/index.php?topic=270613

Question 392

The ________ view of an Access table looks similar to an Excel spreadsheet.
Answer: https://biology-forums.com/index.php?topic=270456

G

Question 393

Question 394

LO

A ________ rule verifies data entered into a field and ensures that the data is of the correct type for the field.
Answer: https://biology-forums.com/index.php?topic=270443

IO

A(n) ________ is a Windows 7 feature that allows a user to share music, pictures, and libraries with other people within the home network.
Answer: https://biology-forums.com/index.php?topic=270933

B

Question 395

David is working on a database that stores student exam grades. He needs to design a query that will display the lowest exam grade. He should use
the ________ function in Exprssion Builder on the column containing the exam grades.
Answer: https://biology-forums.com/index.php?topic=270517

Question 396
Freeze Top Row
A) is the sequence in which pages print.
B) enables you to adjust settings to control how the worksheet will print.
C) defines the range of data to print.
D) keeps only the top row visible as you scroll through a worksheet.
Answer: https://biology-forums.com/index.php?topic=270819

Question 397
A question you ask about the data stored in a database is called a ________.
Answer: https://biology-forums.com/index.php?topic=270435

Question 398
The ________ tab holds some of the more advanced features in Access.
A) External Data
B) Database Tools
C) Create
D) Home
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Answer: https://biology-forums.com/index.php?topic=270354

Question 399

M

When creating a chart, be sure that each data series uses the same ________.
Answer: https://biology-forums.com/index.php?topic=270784

________ is the vertical distance from the top to the bottom of a row.
Answer: https://biology-forums.com/index.php?topic=271543

Question 401

Question 402

YFO

Using a(n) ________ keeps text on both sides of a hyphen together.
Answer: https://biology-forums.com/index.php?topic=271394

R
U

Referential integrity should be enforced in a database with related tables because it
A) makes the database easier to back up.
B) helps ensure invalid data is not entered into a table.
C) makes the database easier to repair.
D) helps ensure data is automatically updated.
Answer: https://biology-forums.com/index.php?topic=270418

M
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Question 400

Question 403

Excel displays a ________ when you create a multiple series chart. By default it appears on the right side of the plot area.
Answer: https://biology-forums.com/index.php?topic=270800

G

Question 404

IO

LO

What information does the title bar of Office 2010 contain?
A) The file name and the application
B) The file name and the drive
C) The file name, folder name, and drive
D) The application and the drive
Answer: https://biology-forums.com/index.php?topic=270904

Question 405

B

Is it possible to change the spelling and grammar checker default settings in Office 2010?
A) No, the settings cannot be changed.
B) Yes, by clicking the Review tab and the Spelling & Grammar button.
C) Yes, but the setting changes are only active for the current document upon which you are working.
D) Yes, by clicking the File tab and clicking the Options button.
Answer: https://biology-forums.com/index.php?topic=270928

Question 406
________ view displays a presentation in hierarchy format with levels according to the points and subpoints on each slide.
Answer: https://biology-forums.com/index.php?topic=271085

Question 407
Which of the following statements best describes a one-to-many relationship between two tables?
A) A primary key in the first table matches several foreign keys in the second table.
B) A foreign key in the first table matches several primary keys in the second table.
C) A primary key in the first table matches exactly one foreign key in the second table.
D) Primary and foreign keys have multiple cross matches between a first and second table.
Answer: https://biology-forums.com/index.php?topic=270423

Question 408
Which of the following is NOT a Video Tools Playback tab option?
A) Size the video
B) Trim the video
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C) Fade the video
D) Set the video to play full screen
Answer: https://biology-forums.com/index.php?topic=271212

What is the first step in opening a new template in PowerPoint?
A) Click the File tab
B) Click the Home tab
C) Click the Open button on the Quick Access Toolbar
D) Quick Access Toolbar
Answer: https://biology-forums.com/index.php?topic=271042

Question 410

R
U

Which of the following PowerPoint features is accessed through the File tab?
A) Print
B) Slide Orientation
C) New Slide
D) Header & Footer
Answer: https://biology-forums.com/index.php?topic=271005

M
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Question 409

YFO

Question 411

A(n) ________ is a listing of topics and page numbers where the topic is located.
Answer: https://biology-forums.com/index.php?topic=271482

Question 412

G

________ writing or editing style is often used in the social and behavioral sciences.
Answer: https://biology-forums.com/index.php?topic=271478

Question 413

B

IO

LO

Match the order of steps with marking an Index entry in a document:
I.first stepA.revise main entry text, if desired
II.second stepB.press Alt+Shift+X to mark an entry
III.third stepC.select a word or phrase that you want in the index
IV.fourth stepD.may want to use Find to locate the next word or
phrase to mark
V.fifth stepE.click Mark or Mark All to include occurrence(s)
Answer: https://biology-forums.com/index.php?topic=271495

Question 414

A(n) ________ operator, such as the greater than or less than symbol, can can be used in a query ciriterion to limits the results produced by the
query.
A) operand
B) wildcard
C) comparison
D) delimiter
Answer: https://biology-forums.com/index.php?topic=270417

Question 415
Match the following terms to their meanings:
I.Worksheet tabsA.Double click the worksheet tab
II.Sheet1, Sheet2, …B.Click "insert worksheet" next to the
worksheet tabs
III.Change a worksheet nameC.Default worksheet names
IV.Insert a new worksheetD.Right click the tab and select "delete"
V.Delete a worksheetE.Names and colors can be changed
Answer: https://biology-forums.com/index.php?topic=270669

Question 416
What happens when you move your mouse pointer over a cross-reference that's been specified as a hyperlink?
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A) The page number will appear
B) The mouse will automatically change to the cross-reference location
C) A ScreenTip appears
D) The cross-reference paragraph number will appear
Answer: https://biology-forums.com/index.php?topic=271460

M
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Question 417
The ________ returns one value if a condition is true and another value if a condition is false.
Answer: https://biology-forums.com/index.php?topic=270720

Default tab stops are set every ________ across a page.
A) inch
B) quarter-inch
C) one-half inch
D) ten centimeters
Answer: https://biology-forums.com/index.php?topic=271359

Question 419

R
U

Question 418

YFO

Formatting in Word 2010 occurs at three levels: character, paragraph, and ________.
Answer: https://biology-forums.com/index.php?topic=271325

Question 420

LO

Question 421

G

The ________ command is helpful in preventing data from looking squeezed together.
A) Alignment
B) Border
C) Cell Size
D) Cell Margins
Answer: https://biology-forums.com/index.php?topic=271510

B

IO

The MIN function
A) identifies the highest value in a range.
B) tallies the number of blank cells in a range.
C) displays the lowest value in a range.
D) tallies the number of cells in a range that contain values.
Answer: https://biology-forums.com/index.php?topic=270682

Question 422

Maria is working on a database that stores client invoice data. She needs to design a query that will display the average balance of all invoices. She
should use the ________ function in Expression Builder on the column containing invoice amounts.
Answer: https://biology-forums.com/index.php?topic=270519

Question 423
"Accurate and swift typing is a skill needed by students" is an example of ________ voice and should be primarily avoided on slides.
Answer: https://biology-forums.com/index.php?topic=271012

Question 424
The ________ data type can be used for fields that contain monetary values.
Answer: https://biology-forums.com/index.php?topic=270454

Question 425
Many dialog boxes offer a help feature by clicking:
A) the F12 key.
B) a question mark.
C) the F1 key.
D) a light bulb.
Answer: https://biology-forums.com/index.php?topic=270910
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Question 426

M

Press the ________+Tab keys to move the insertion point from one cell of a table to the previous cell.
Answer: https://biology-forums.com/index.php?topic=271020

Question 427

M
S.
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O

Shapes is in the ________ group on the Insert tab.
A) Illustrations
B) Images
C) Symbols
D) Media
Answer: https://biology-forums.com/index.php?topic=271118

Question 428

R
U

To show a "hidden" row one or a "hidden" column A, type ________ in the name box and then press "Enter".
Answer: https://biology-forums.com/index.php?topic=270659

Question 429

YFO

Which of the following is TRUE about the Zoom slider in file preview?
A) When you change the appearance of the font size by adjusting the zoom, the actual font size of the document when printed is changed.
B) If you increase the appearance of the font of a file preview, the new font size is not saved with the file.
C) The Zoom slider is located on the Quick Access Toolbar.
D) To return a preview of a document to its original size, click Zoom on the Zoom slider.
Answer: https://biology-forums.com/index.php?topic=270915

Question 430

LO

Question 431

G

A(n) ________ box within a dialog box allows for non-mutually exclusive choices.
Answer: https://biology-forums.com/index.php?topic=271643

B

IO

Prior to creating an index in a document, what must you do?
A) Format each heading with the same style
B) Format each paragraph with a different style
C) Mark each occurrence of a word that you want to appear as an entry in the Index.
D) Mark only one occurrence of each word that you want to appear as an entry in the Index.
Answer: https://biology-forums.com/index.php?topic=271450

Question 432

The plot area
A) contains graphical representation of values in data series.
B) is a vertical line that borders the plot area to provide a frame of reference for measurement.
C) is a horizontal line that borders the plot area to provide a frame of reference for measurement.
D) provides descriptive group names for subdividing the data series.
Answer: https://biology-forums.com/index.php?topic=270746

Question 433
Match the following shortcut keys in PowerPoint 2010 to their function:
I.Ctrl+P in Slide Show viewA.changes the pointer to a drawing pointer
II.Ctrl+A in Slide Show viewB.starts a blank presentation
III.Ctrl+TabC.inserts an indent within a table cell
IV.Ctrl+ND.moves the insertion point within a table to the
previous cell
V.Shift+TabE.changes the mouse pointer to an arrow
Answer: https://biology-forums.com/index.php?topic=271033

Question 434
Which of the following is most synonymous with "font"?
A) Typeface
B) Typography
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C) Type style
D) Styles
Answer: https://biology-forums.com/index.php?topic=271349

M

Question 435

M
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To copy the contents of a cell or range by dragging is called using Auto ________.
Answer: https://biology-forums.com/index.php?topic=270658

Question 436
All of the following are form creation tools EXCEPT:
A) Form Design
B) Form Wizard
C) Form Layout
D) Blank Form
Answer: https://biology-forums.com/index.php?topic=270540

R
U

Question 437

YFO

A color scale
A) highlights cells meeting specified criteria with a specified color, font, or border.
B) is a conditional format that displays an icon representing a value in the top third, quarter, or fifth based on colors in the selected range.
C) calculates an aggregate for values in a range or database.
D) is a conditional format that displays a particular color based on the relative value of the cell contents to other selected cells.
Answer: https://biology-forums.com/index.php?topic=270852

Question 438

G

In order to find specific information in a database, you can run a(n) ________ which asks a question about data stored in a database.
Answer: https://biology-forums.com/index.php?topic=270359

Question 439

Question 440

LO

Address labels that can be attached to an envelope for mailing would require ________ as the main document type in a mail merge.
Answer: https://biology-forums.com/index.php?topic=271558

B

IO

A(n) ________ is an unbound control that displays text.
A) label
B) roster
C) index
D) listing
Answer: https://biology-forums.com/index.php?topic=270564

Question 441
The intensity of the colors in an image on a PowerPoint slide is referred to as ________.
Answer: https://biology-forums.com/index.php?topic=271241

Question 442
Which of the following could be a merge field in a Word document?
A) <<Last Name>>
B) [dict]Address[/dict]
C) ((City))
D) <<FirstName>>
Answer: https://biology-forums.com/index.php?topic=271532

Question 443
Which of the following is FALSE about page numbers in Word 2010?
A) The Page Number command is in the Page Layout tab.
B) Page numbers can be located at the top of the page.
C) Page numbers are located in a header or footer.
D) When adding new pages, page numbers automatically adjust.
Answer: https://biology-forums.com/index.php?topic=271280
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Question 445
You can ________ or move an object around its axis.
Answer: https://biology-forums.com/index.php?topic=271173

Question 446

M
S.
C
O

What determines if a slide title is viewable in the Outline view of a presentation?
A) Only if the title is bolded is it displayed in the Outline view
B) Only if you expand the view of the slides can you see the title
C) Only if there is a title placeholder will you see the title text
D) Title text is always displayed for each slide in Outline view
Answer: https://biology-forums.com/index.php?topic=271048

M

Question 444

YFO
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When you scan an image in order to include it in a PowerPoint presentation, where does it initially appear?
A) Directly in the center of your slide
B) In the PowerPoint images folder
C) In the Clip Art task pane
D) In the My Collections folder
Answer: https://biology-forums.com/index.php?topic=271195

Question 447

G

Which of the following refers to a method applied to data to reduce the size of a file?
A) Embedding
B) Codec
C) Compression
D) Saturation
Answer: https://biology-forums.com/index.php?topic=271194

LO

Question 448

The H________ function looks up a value in a horizontal table and returns a result from a row in the table.
Answer: https://biology-forums.com/index.php?topic=270724

IO

Question 449

B

Match the following terms to their meanings:
I.FieldA.A field or collection of fields whose values uniquely
identify each record in a table
II.Relational DatabaseB.Connects the records in separate tables
III.Common FieldC.A primary key from one table that is used to form a
relationship with a second table
IV.Primary KeyD.The smallest data element contained in a table.
V.Foreign KeyE.A collection of related tables.
Answer: https://biology-forums.com/index.php?topic=270381

Question 450
________ writing or editing style is often used in the humanities and business disciplines.
Answer: https://biology-forums.com/index.php?topic=271477

Question 451
________ is the value used to describe a blank field in an Access table.
Answer: https://biology-forums.com/index.php?topic=270431

Question 452
Which of the following is the best description of a markup balloon?
A) A colored circle in the margin of a document with a line drawn to the object of the comment
B) A colored circle with written text that displays within the Reviewing Pane
C) A colored circle with text of citation sources within a current document
D) Footnote text of a citation located within a colored circle in the margin of a document
Answer: https://biology-forums.com/index.php?topic=271424
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Question 453

M

As you customize a chart, remember that its purpose is to ________ a message to your audience.
Answer: https://biology-forums.com/index.php?topic=270798

Question 454

Question 455
The table of contents feature in Word 2010 is located on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271481

Question 456

YFO

R
U

Which of the following is FALSE about the photo album feature in PowerPoint 2010?
A) The order of photos can be changed after the album is created.
B) Transitions can be added to slides in a photo album presentation.
C) The Photo Album feature is accessed from the Design tab.
D) Slide images may be reduced to fit into slide placeholders.
Answer: https://biology-forums.com/index.php?topic=271229

M
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Phil is designing a report in Access. He needs to change the design of some elements of the report, but also needs to use a filter to exclude some
records in the report. He can use the ________ view to accomplish his tasks.
Answer: https://biology-forums.com/index.php?topic=270595

Question 457

Another word for joining two or more cells together is to ________ the cells.
Answer: https://biology-forums.com/index.php?topic=271542

G

Question 458

IO

LO

Sorting Text A to Z
A) is the process of displaying only records that meet specific conditions.
B) arranges data in alphabetical order.
C) displays data in chronological order, oldest to newest.
D) arranges values (numbers) in sequential order.
Answer: https://biology-forums.com/index.php?topic=270838

Question 459

B

Match the chart Design tab options to their meanings:
I.Moving a ChartA.Preview the chart in Backstage view before you
do this to check margins, spacing, and page
breaks to ensure balance
II.Printing ChartsB.If you do this you must decide if you want to print
the data only, the data and the chart, or the chart only
III.Print an Embedded ChartC.If moved the chart is the only item on that worksheet.
The chart will print as a full-page chart. You can
change the setting to Print Entire Workbook
IV.Chart1, Chart2...D.Can and should be changed to be more descriptive
V.Print a Chart SheetE.Excel creates charts on the same worksheet as the
original data set, but you can put the chart on its
own chart sheet
Answer: https://biology-forums.com/index.php?topic=270813

Question 460
The ________ feature reduces the size of an object.
Answer: https://biology-forums.com/index.php?topic=271412

Question 461
When defining a field, the field ________ property determines how much physical storage space the field requires.
A) size
B) input mask
C) caption
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D) format
Answer: https://biology-forums.com/index.php?topic=270391

Question 463
An Excel ________ is a pre-defined computation that simplifies creating formulas.
Answer: https://biology-forums.com/index.php?topic=270712

Question 464

YFO

R
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Which of the following is FALSE about sorting data in a Word table?
A) Sorting data in a table from 1 to 100 would be an ascending order sort.
B) Field names (also referred to as column names) should be included in a sort.
C) Data in a table can be sorted by date.
D) Data can be arranged in descending order.
Answer: https://biology-forums.com/index.php?topic=271516

M
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Which view is a condensed view of a document that is used in conjunction with styles?
A) Draft
B) Print Layout
C) Outline
D) Full Screen Reading
Answer: https://biology-forums.com/index.php?topic=271377

M

Question 462

Question 465

Question 466

LO

G

Which of the following is TRUE about tables in PowerPoint 2010?
A) Tables organize information on a slide in columns and rows.
B) Clicking the Table button in the Tables group and the Insert Table button on a slide layout creates the exact same table.
C) After a table is inserted, columns can be widened but rows cannot be changed.
D) PowerPoint can only create simple, uncomplicated tables.
Answer: https://biology-forums.com/index.php?topic=270986

IO

Windows ________ can run in real time and thus, will alert you when spyware attempts to install itself or change your computer settings.
Answer: https://biology-forums.com/index.php?topic=271649

Question 467

B

How does inserting an image with the Insert tab differ from inserting an image into a placeholder.
A) The image may be cropped when using the Insert tab but with no cropping in the placeholder.
B) The image comes in full size with the Insert tab; the image may be distorted to fit the placeholder.
C) The image comes in full size with the Insert tab; possibly cropped in a placeholder.
D) The image comes onto the slide as a consistent 3" x 3" while an image may be cropped when inserted in a placeholder.
Answer: https://biology-forums.com/index.php?topic=271197

Question 468
If you want the same information to be included at the top of each page of a handout or notes page given to the audience, create a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271024

Question 469
Which of the following statement is true in reference to the report Detail section?
A) The Detail section prints the value of each unique instance for a grouped field.
B) The Detail section appears at the top of a report.
C) The Detail section repeats for every record in the record source.
D) The Detail section holds the report title, the organization’s name, and the company logo.
Answer: https://biology-forums.com/index.php?topic=270558

Question 470
A column ________ displays data comparisons vertically in columns.
Answer: https://biology-forums.com/index.php?topic=270782
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Question 471

M

The ________ view can be used to view to add, edit, and delete data in a form, but cannot be used to change the design of the form.
Answer: https://biology-forums.com/index.php?topic=270585

Question 472

Question 473

M
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Live ________ of a theme means when you position the mouse pointer over a theme, it displays on the current slide prior to selecting it.
Answer: https://biology-forums.com/index.php?topic=271016

You want to create a table based on the data contained in an Excel spreadsheet. You will use the ________ tab to import the data from Excel.
Answer: https://biology-forums.com/index.php?topic=270461

Question 474

R
U

________ can be named, organized, and offer a location in which to store files.
Answer: https://biology-forums.com/index.php?topic=270931

Question 475

YFO

A report containing more than one page should have page numbers included in the ________ section.
Answer: https://biology-forums.com/index.php?topic=270594

Question 476

List, Process, and Cycle are categories of ________.
Answer: https://biology-forums.com/index.php?topic=271166

G

Question 477

B
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LO

Match the following terms to their meanings:
I.Order of PrecedenceA.Controls the sequence of arithmetic
operations
II.Actual values in FormulasB.Not recommended unless the value is a
constant
III.Auto FillC."Show Formulas" on the Formulas tab or
Ctrl + ` combination
IV.Fill HandleD.Copying the contents of a cell or range by
dragging
V.Display formulas in the cellE.Small black square at the bottom-right corner
of a cell
Answer: https://biology-forums.com/index.php?topic=270668

Question 478
The ________ bar displays the name of the file and the program.
Answer: https://biology-forums.com/index.php?topic=271642

Question 479
What is the best and easiest way to locate a section break in a document?
A) Change to Page Layout view
B) Click the Header & Footer Tools tab
C) Click the Link to Previous button
D) Change to Draft view
Answer: https://biology-forums.com/index.php?topic=271295

Question 480
Match the chart Design tab options to their meanings:
I.Changing the Chart TypeA.reverse how the chart presents the data;
place the column labels on the category
axis and the row labels in the legend
II.Changing the Data SourceB.predefined-control the color of the chart
area, plot area, and data series-affect the
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Soft Edges and 3-D Rotation are types of:
A) type styles.
B) typefaces.
C) paragraph styles.
D) picture styles.
Answer: https://biology-forums.com/index.php?topic=271381

M
S.
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O

look of the data series, such as flat, 3-D,
or beveled
III.Changing the Data StructureC.predefined-determines which chart elements
appear in the chart area and how they are
positioned within the chart area
IV.Applying a Chart LayoutD.change how the data are depicted by using
other chart types
V.Applying a Chart StyleE.add or delete data from the chart by clicking
Select Data
Answer: https://biology-forums.com/index.php?topic=270812

M
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Question 482

G

YFO

Match the following terms with their description:
I.placeholderA.container that holds content on a slide
II.layoutB.PowerPoint show
III.file with .ppsx extensionC.multiple slides
IV.slide showD.PowerPoint presentation
V.file with .pptx extensionE.determines the position of objects and text on
a slide
Answer: https://biology-forums.com/index.php?topic=271040

Question 483

Question 484

LO

_______ is a Windows 7 feature that automatically places a window on the side of the desktop.
Answer: https://biology-forums.com/index.php?topic=271640

IO

Excel treats phone numbers and social security numbers as ________.
Answer: https://biology-forums.com/index.php?topic=270650

B

Question 485

If you have a Title slide selected and you click on the New Slide button (not the New Slide arrow), the new slide will have a ________ layout.
A) Title and Content
B) Title Slide
C) Blank
D) Title Only
Answer: https://biology-forums.com/index.php?topic=270980

Question 486
Default tab stops are ________ aligned.
Answer: https://biology-forums.com/index.php?topic=271397

Question 487
A ________ displays a subset of records based on specified criteria.
A) filter
B) form
C) table
D) primary key
Answer: https://biology-forums.com/index.php?topic=270351

Question 488
Match the math and statistical functions to their descriptions:
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I. =PI()A.Identifies a value's rank within a list
of values; returns an average rank for
identical values
II. =PRODUCT(number1, [number2],...)B.Generates a random number between
two numbers you specify
III. =RANDBETWEEN(bottom,top)C.Multiplies all values in the argument list
IV. =RANK.AVE(number,ref,[order])D.Returns the value of pi accurate up to
15 digits
V. =RANK.EQ(number,ref,[order])E.Identifies a value's rank within a list
of values; the top rank is identified
for all identical values
Answer: https://biology-forums.com/index.php?topic=270734

M
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A surface chart
A) displays values as percentages of the whole but may contain more than one data series.
B) displays relationships among three values by using bubbles.
C) displays trends using two dimensions on a continuous curve.
D) contains a single chart and no spreadsheet data.
Answer: https://biology-forums.com/index.php?topic=270765

YFO

Question 490

IO

Question 491

LO

G

Match the filter options to their explanations:
I.FilteringA.Text Filter
II.Filtering to show only records that begin with the letter SB.arranges records
in a table by the
value in field(s)
within a table
III.Filtering to show only records older than January 2001C.Number Filter
IV.Filtering to show only records Greater than $10,000D.displays only
records that meet
specific conditions
V.SortingE.Date Filter
Answer: https://biology-forums.com/index.php?topic=270887

B

Which of the following is FALSE about tables in Word 2010?
A) You can format a row or column differently than the rest of a table, but not an individual cell.
B) From the Table command, you drag to select the number of columns and rows you want.
C) A table is created from the Insert tab.
D) Text wraps in cells and, therefore, does not affect the entries in other cells.
Answer: https://biology-forums.com/index.php?topic=271499

Question 492
Expression Builder inserts ________ that tell you where each argument belongs.
A) rows
B) fields
C) columns
D) placeholders
Answer: https://biology-forums.com/index.php?topic=270477

Question 493
In the table pictured above, the ________ field would make the best primary key.
A) First Name
B) Last Name
C) Telephone Number
D) Client ID
Answer: https://biology-forums.com/index.php?topic=270332

Question 494
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Question 495

R
U

Match the following programs or features to their descriptions:
I.Windows DefenderA.identifies and removes spyware
II.SpywareB.software that gains information through a user's
Internet connection
III.firewallC.software or hardware to protect a computer from
unauthorized access
IV.User Account ControlD.Windows 7 maintenance and security settings area
V.Action CenterE.Windows 7 feature that asks a user if they choose
to permit a program to make changes to their system
prior to changing system settings
Answer: https://biology-forums.com/index.php?topic=271664

M
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When you click the Shapes button and start to drag the mouse pointer to create the position of the shape, the mouse arrow changes to a:
A) four-headed arrow.
B) double-headed arrow.
C) cross-hair pointer.
D) plus sign.
Answer: https://biology-forums.com/index.php?topic=271117

Question 496

YFO

To decrease typing time and ensure accuracy, use semi-________ to select cells.
Answer: https://biology-forums.com/index.php?topic=270706

Question 497

You can see a template prior to downloading or creating the file by viewing it in the ________ pane.
Answer: https://biology-forums.com/index.php?topic=271082

G

Question 498

IO

LO

In the table pictured above, if you wanted to organize the data from the lowest Client ID to the highest Client ID, you would ________ the Client ID
field.
A) sort
B) report
C) query
D) form
Answer: https://biology-forums.com/index.php?topic=270334

B

Question 499

Match the following terms to their descriptions:
I.plagiarismA.note recognizing the source of information or
a quote
II.citationB.citation that appears at the bottom of a page in
a document
III.footnoteC.act of using or documenting ideas or words as
one's own
IV.APAD.style used in the social sciences
V.MLAE.style used in business
Answer: https://biology-forums.com/index.php?topic=271497

Question 500
Compression where no data is lost when decompressed is referred to as ________.
Answer: https://biology-forums.com/index.php?topic=271235

Question 501
Alice is working in a database containing the names, service locations, and services offered by landscapers. She needs to find landscapers in that
offer services in the Washington area and that service rare flowers. The best way for her to search for this data is to perform a:
A) Filter by Form.
B) Filter by Selection.
C) Sort Ascending.
D) Sort Descending.
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Answer: https://biology-forums.com/index.php?topic=270349
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Which of the following is CORRECT about fonts on slides?
A) If your presentation will be delivered through a projection device, use sans serif fonts.
B) If you are printing your presentation, use sans serif fonts.
C) Sans serif fonts help guide the reader's eyes across a page of text.
D) Decorative fonts should be usually frequently on slides.
Answer: https://biology-forums.com/index.php?topic=271075

M

Question 502

Print order
A) represents a Field which is an individual piece of data.
B) is the sequence in which pages print.
C) represents a record.
D) is the command to print in Excel 2010
Answer: https://biology-forums.com/index.php?topic=270823

Question 504

YFO

Remote ________ is available through Windows 7 Help and Support.
Answer: https://biology-forums.com/index.php?topic=271658

R
U

Question 503

Question 505

LO

Question 506

G

The ________ displays format properties within a document?
A) Show/Hide button
B) Paragraph styles
C) Styles task pane
D) Reveal Formatting task pane
Answer: https://biology-forums.com/index.php?topic=271375

B

IO

By selecting the ________ option, you can make sure that data entered into a related table first exists in the primary table.
A) sort
B) form wizard
C) query wizard
D) referential integrity
Answer: https://biology-forums.com/index.php?topic=270335

Question 507

The ________ box displays the address of the (active) cell currently in use.
Answer: https://biology-forums.com/index.php?topic=270641

Question 508
A ________ is a PowerPoint presentation with multiple pictures organized similarly to a traditional album.
Answer: https://biology-forums.com/index.php?topic=271259

Question 509
When you click on a video in a presentation, the video Tools tab displays two tabs: the Format tab and the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271247

Question 510
Of the following, which is NOT a method to advance through a slide show?
A) Press the Spacebar
B) Press Page Down
C) Press P
D) Press Enter
Answer: https://biology-forums.com/index.php?topic=270995
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Question 511
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Which of the following mouse clicks is correct?
A) Single-click a file or folder to select it; double-click to open it
B) Double-click a file or folder to select it as well as open it
C) Double-click a file or folder to select it; triple-click to open it
D) Single-click a file or folder to select it; double-click to delete it
Answer: https://biology-forums.com/index.php?topic=270901

Question 512

R
U

Use the ________ feature to line up three objects on a slide that are scattered about the slide.
A) Distribute
B) Align
C) Rotate
D) Grid
Answer: https://biology-forums.com/index.php?topic=271155

Question 513

YFO

What happens when you've selected text and you click the Text Direction button in the Alignment group?
A) The Text Direction dialog box opens
B) The text flips horizontally or vertically
C) The text rotates
D) The text changes from vertical to horizontal or horizontal to vertical depending on which direction the text starts
Answer: https://biology-forums.com/index.php?topic=271509

Question 514

IO

Question 515

LO

G

Match the following terms with their descriptions:
I.data sourceA.listing of information used in a mail merge
II.fieldB.single piece of data in a data source
III.recordC.placeholder for data inserted into a main document
IV.header rowD.group of related fields
V.merge fieldE.first row in a data source
Answer: https://biology-forums.com/index.php?topic=271567

B

The ________ function calculates loan payments.
Answer: https://biology-forums.com/index.php?topic=270511

Question 516

If you were creating your own dialog box, which of the following features would be most appropriate beside Number of copies within a Print dialog
box?
A) Option button
B) Text box
C) Spin arrow
D) Check box
Answer: https://biology-forums.com/index.php?topic=271605

Question 517
Which of the following is NOT an option from the Finish & Merge command?
A) Edit Individual Documents
B) Print Documents
C) Print Labels
D) Send E-mail Messages
Answer: https://biology-forums.com/index.php?topic=271533

Question 518
Which of the following is FALSE about an index in Word 2010?
A) You first create the index from the Insert Index button, then mark the index entries.
B) You can select Mark or Mark All to include occurrences in an index.
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C) The Insert Index button is on the References tab.
D) An index provides an alphabetical listing of topics in the document.
Answer: https://biology-forums.com/index.php?topic=271452

Match the following terms with their description:
I.distributeA.divide or evenly spread objects over a given area
II.alignB.arrange objects in a line to be parallel
III.guideC.set of intersecting lines
IV.gridD.layered objects
V.stacking orderE.straight horizontal or vertical line used to align objects
Answer: https://biology-forums.com/index.php?topic=271187

YFO

Question 521
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Question 520
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It is suggested that you end a presentation with any of the following EXCEPT a:
A) restatement of the purpose of your presentation.
B) call to action.
C) new key thought.
D) review of your main points.
Answer: https://biology-forums.com/index.php?topic=270975

M

Question 519

A (n) ________ is a database object that is used to add data into a table.
Answer: https://biology-forums.com/index.php?topic=270575

Question 522

IO

Question 523

LO

G

Which of the following files will import all of the outline text into one placeholder on one slide?
A) Outline1.docx
B) Outline2.htm
C) Outline3.rtf
D) Outline4.txt
Answer: https://biology-forums.com/index.php?topic=271062

B

Match the following terms with their descriptions:
I.annotationA.written note on a slide
II.animationB.movement applied to text or an object
III.transitionC.movement applied to slides as one replaces another
IV.themeD.determines the position of objects on a slide
V.layoutE.designs that include colors and fonts
Answer: https://biology-forums.com/index.php?topic=271036

Question 524
A 100% stacked column chart
A) uses a line to connect data points in order to show trends over a period of time.
B) places (stacks) data in one column per category, with each column having the same height of 100%.
C) compares values across categories using horizontal bars.
D) adds a third dimension to each data series, creating a distorted perspective of the data.
Answer: https://biology-forums.com/index.php?topic=270756

Question 525
Which of the following is NOT part of the Media Controls bar?
A) Edit Video
B) Play/Pause
C) Mute/Unmute
D) Move Back 0.25 Seconds
Answer: https://biology-forums.com/index.php?topic=271209

Question 526
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A(n) ________ font is a font that does not have small lines at the end of letters.
Answer: https://biology-forums.com/index.php?topic=271098
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Which of the following video file formats compresses audio and video and requires minimal amount of storage?
A) Windows Media Video file
B) Windows Media file
C) Movie file
D) Adobe Flash Media file
Answer: https://biology-forums.com/index.php?topic=271206

M

Question 527

Question 528

R
U

Which of the following needs more words to communicate your ideas and may make your presentation seem flat?
A) Active voice
B) Parallel construction
C) Beginning bullets with a verb
D) Passive voice
Answer: https://biology-forums.com/index.php?topic=270976

Question 529

YFO

The file format ________, recognized by PowerPoint, is a format that can be transferred among platforms and can be used to transfer formatted text
documents among applications.
A) .rtf
B) .docx
C) .doc
D) .txt
Answer: https://biology-forums.com/index.php?topic=271058

G

Question 530

IO

LO

The PMT function is BEST suited to determine:
A) The rate of interest on a car loan
B) The due date of a car loan
C) The monthly payment on a car loan
D) The average payment of a car loan
Answer: https://biology-forums.com/index.php?topic=270487

Question 531

B

By default, how long does audio play on a slide?
A) Until the slide changes
B) Until it ends or the next bullets enters
C) Until it ends or the next mouse click
D) Until the next mouse click or the slide show ends
Answer: https://biology-forums.com/index.php?topic=271221

Question 532
A Border (as it applies to Excel)
A) is data from another cell that is only temporarily residing in the active cell.
B) is a line that surrounds a cell or a range of cells.
C) never prints.
D) is preset and weight cannot be adjusted.
Answer: https://biology-forums.com/index.php?topic=270632

Question 533
The thickness of a shape outline is measured in ________.
A) inches
B) weight
C) points
D) centimeters
Answer: https://biology-forums.com/index.php?topic=271128
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A 3-D chart
A) uses a line to connect data points in order to show trends over a period of time.
B) shows each data point in proportion to the whole data series as a slice in a circular pie.
C) compares values across categories using horizontal bars.
D) adds a third dimension to each data series, creating a distorted perspective of the data.
Answer: https://biology-forums.com/index.php?topic=270757

M

Question 534

Question 535
A ________ area defines the range of data to print.
Answer: https://biology-forums.com/index.php?topic=270863

Question 536

YFO

R
U

The COUNT function
A) tallies the number of cells in a range that are not empty.
B) tallies the number of blank cells in a range.
C) displays the current date.
D) tallies the number of cells in a range that contain values.
Answer: https://biology-forums.com/index.php?topic=270684

Question 537

G

Which of the following programs provides alerts in regard to monitoring your system for maintenance and security settings?
A) Action Center
B) Windows Defender
C) Windows Updates
D) Windows firewall
Answer: https://biology-forums.com/index.php?topic=271620

LO

Question 538

B

IO

Match the following button or checkbox to the group where it is located:
I.Increase List LevelA.Clipboard group
II.CutB.Slides group
III.FindC.Paragraph group
IV.SectionD.Backgrounds
V.Hide Background GraphicsE.Editing group
Answer: https://biology-forums.com/index.php?topic=271112

Question 539

Rather than displaying records based on a question as in a query, a(n) ________ hides records that do not match a set criteria.
Answer: https://biology-forums.com/index.php?topic=270369

Question 540
________ arranges records in a table by the value in field(s) within a table.
Answer: https://biology-forums.com/index.php?topic=270871

Question 541
Ben is working in a database that stores student information. He wants to determine each student’s age based on the student’s birthday. Which of the
following statements accurately describe how the fields should be designed?
A) The birthday should be a stored field and the age should be a calculated field
B) The birthday should be a calculated field and the age should be a stored field
C) Both the birthday and age fields should be calculated fields
D) Both the birthday and age fields should be stored fields
Answer: https://biology-forums.com/index.php?topic=270389

Question 542
If the Shapes gallery doesn't open, click the ________ button in the Drawing group.
Answer: https://biology-forums.com/index.php?topic=271159
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Question 544

Question 545

YFO

Selecting data by means of a query:
A) deletes unrelated data.
B) displays only the data that matches the query selection criteria.
C) locks all other users out of the database.
D) creates a report.
Answer: https://biology-forums.com/index.php?topic=270326

R
U

To reverse the Data Series of a chart
A) change the numbers in the spread sheet.
B) use a different chart type.
C) use the Select Data Source dialog box from the Select Data button.
D) click Switch Row/Column in the Data group.
Answer: https://biology-forums.com/index.php?topic=270772

M
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The logical test
A) is the lowest value for a specific category or series in a lookup table.
B) evaluates true or false.
C) contains another function embedded inside one or more of its arguments.
D) contains data for the basis of the lookup and data to be retrieved.
Answer: https://biology-forums.com/index.php?topic=270690

M

Question 543

Question 546

G

Styles can be created and applied from the Styles group on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271407

LO

Question 547

IO

Bitmap images are created by bits or ________.
A) mathematical statements
B) bytes
C) pixels
D) shapes
Answer: https://biology-forums.com/index.php?topic=271192

B

Question 548

Steve is working in a database that holds patient data for a medical center. A patient’s identification number serves as a primary key in the Patient
table. A patient’s identification number serves as a foreign key in the Doctor table. Steve wants to create a Form that displays Doctor table records
with foreign key values that match the primary key value in the Patient table. How should Steve proceed?
A) Use the Form tool to create the form and Access will analyze the table relationships Steve created in the database, and automatically add a
subform to his form.
B) Use the Form tool to create the form and Access will analyze the table relationships Steve created in the database, and automatically add a Split
form to his form.
C) Use the Form tool to create the form and Access will analyze the table relationships Steve created in the database, and automatically add a
Multi-items form to his form.
D) Steve can only create a form that displays one record source at a time.
Answer: https://biology-forums.com/index.php?topic=270545

Question 549
Each ________ in an Excel table represents a record.
Answer: https://biology-forums.com/index.php?topic=270866

Question 550
A chart title
A) is a horizontal or vertical line that extends from the horizontal or vertical axis through the plot area.
B) is a label that describes the chart.
C) is a label that describes either the category axis or the value axis.
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D) is the value or name of a data point.
Answer: https://biology-forums.com/index.php?topic=270775

Question 551

The result of a query, which appears similar to a table, is called a ________.
A) recordset
B) report
C) form
D) datasheet
Answer: https://biology-forums.com/index.php?topic=270416

Question 553

M
S.
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Question 552

M

A database ________ is an organized group of related records that contain fields.
Answer: https://biology-forums.com/index.php?topic=271562

Question 554

YFO

The ________ function displays the current date (not time) in a cell.
Answer: https://biology-forums.com/index.php?topic=270718

R
U

The set of rules that Access follows when evaluating expressions in calculated fields is called ________.
Answer: https://biology-forums.com/index.php?topic=270507

Question 555

The ________ data type is used for fields that will be used in mathematical calculations except those involving money.
Answer: https://biology-forums.com/index.php?topic=270436

G

Question 556

IO

LO

A spreadsheet PROGRAM is defined as
A) a software application used to create and modify spreadsheets.
B) a software application used to create and modify text-based documents.
C) a software application used to create and modify video presentations.
D) a software application used to create and modify a database.
Answer: https://biology-forums.com/index.php?topic=270606

Question 557

B

When you first insert an image into a document, which of the following is TRUE?
A) It comes in a predefined size.
B) It always comes in at 2 inches by 2 inches.
C) It always comes in at the top-right corner.
D) It comes in at the bottom center of the document.
Answer: https://biology-forums.com/index.php?topic=271378

Question 558
By using different combinations of numbers between 0 and 255, over _______ colors can be created.
A) 100,000
B) a million
C) 16 million
D) 24 million
Answer: https://biology-forums.com/index.php?topic=271126

Question 559
Match the following Mail Merge commands with their description:
I.Match FieldsA.copies the merge fields from the first label to all
other labels
II.Update LabelsB.enables you to locate data in one or more specific
fields
III.Preview ResultsC.displays decision-making criteria
IV.Find RecipientD.displays data from the data source in the fields of the
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main document
V.RulesE.enables you to select fields from another data source
and coordinate with Word fields
Answer: https://biology-forums.com/index.php?topic=271573

M

Question 560

M
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Which of the following is TRUE about rows and columns in a table?
A) Rows in a table are identified by letters.
B) Row and column labels do not appear within a table.
C) Formulas cannot be entered into cells in a Word table.
D) Columns in a table are identified by numbers.
Answer: https://biology-forums.com/index.php?topic=271511

Question 561

R
U

To select a variety of files that are not adjacent in order to delete them as a group, hold down the ________ while selecting each one.
A) F1
B) Alt
C) Shift
D) Ctrl
Answer: https://biology-forums.com/index.php?topic=270900

YFO

Question 562

G

What key combination inserts an indent within the cell of a table on a slide?
A) Shift+Tab
B) Alt+Tab
C) Ctrl+right arrow
D) Ctrl+Tab
Answer: https://biology-forums.com/index.php?topic=270988

LO

Question 563

IO

How many levels of sorting does Word 2010 allow?
A) Four
B) Three
C) Two
D) One
Answer: https://biology-forums.com/index.php?topic=271531

B

Question 564

Of the following, ________ is not an option on the PowerPoint status bar.
A) the Fit slide to current window button
B) a Zoom slider
C) the Close button
D) the Zoom level button
Answer: https://biology-forums.com/index.php?topic=270970

Question 565
The ________ view is the most frequently used view.
Answer: https://biology-forums.com/index.php?topic=271328

Question 566
Which of the following is FALSE about the Colors gallery?
A) You can create your own color theme.
B) All color themes provides a set of colors.
C) Each color of a color theme is assigned to a different element in the theme design.
D) To select a color theme, right-click the choice in one of the Theme Colors to apply it
Answer: https://biology-forums.com/index.php?topic=271080

Question 567
How would you know that Word identified a contextual spelling error in your document?
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M

A) It is indicated by a red wavy underline
B) The text is bolded and flashes
C) The text is indicated in red bold
D) It is indicated by a blue wavy underline
Answer: https://biology-forums.com/index.php?topic=271297

To insert a function by typing first type an (a) ________ sign.
Answer: https://biology-forums.com/index.php?topic=270713

Question 569

Question 570

YFO

Which of the following is NOT included as part of a theme?
A) Colors
B) Fonts
C) Clip art
D) Special effects
Answer: https://biology-forums.com/index.php?topic=270982

R
U

Match the following Multimedia Copyright Guidelines with their description:
I.percentage of a copyright work that can be usedA.2
II.number of images from a collection that can be usedB.5
III.seconds of music or sound that can be usedC.10
IV.number of copies that can be distributedD.15
V.number of works by an artist or photographer that can be usedE.30
Answer: https://biology-forums.com/index.php?topic=271266
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Question 568

G

Question 571

IO

LO

Which of the following statements is true about date formatting?
A) Date formatting changes the underlying value of the date.
B) Date formatting changes the starting date that Access uses to determine the time elapsed between the current date and a starting date.
C) Date formatting returns a portion of the date such as the month, or year for use in functions.
D) Date formatting changes the way a date is displayed without changing the value of the date
Answer: https://biology-forums.com/index.php?topic=270476

Question 572

B

________ references usually cause inaccurate results.
Answer: https://biology-forums.com/index.php?topic=270711

Question 573

When designing an expression for a calculated field, the name of the calculated field followed by a(n):
A) Colon
B) Exclamation Point
C) Bracket
D) Parentheses
Answer: https://biology-forums.com/index.php?topic=270494

Question 574
A ________ is an electronic file that contains a grid of columns and rows.
Answer: https://biology-forums.com/index.php?topic=270634

Question 575
The Report Wizard gives users a choice to select ________ statistics if the user wants to see the aggregate data of a table.
Answer: https://biology-forums.com/index.php?topic=270528

Question 576
Which of the following is an advanced form of font designed for both Windows and Macintosh?
A) Kerning
B) Typography
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C) OpenType
D) Proportional
Answer: https://biology-forums.com/index.php?topic=271353

The Start button is located:
A) on the title bar.
B) on the desktop.
C) on the taskbar.
D) in the Notification area.
Answer: https://biology-forums.com/index.php?topic=271579

YFO

Question 579

R
U

Question 578

M
S.
C
O

Which of the following is NOT a Windows Update setting available for Windows 7?
A) Never check for updates
B) Have Windows both download and install updates automatically
C) Download manually and install the updates automatically
D) Only download but let you install the downloads
Answer: https://biology-forums.com/index.php?topic=271619

M

Question 577

What function in a Totals Row would calculate the least valued data item in a group?
A) Maximum
B) Count
C) Average
D) Minimum
Answer: https://biology-forums.com/index.php?topic=270501

G

Question 580

Question 581

LO

Charts help reveal ________, patterns, and other tendencies that are difficult to identify by just looking at values in a worksheet.
Answer: https://biology-forums.com/index.php?topic=270804

B

IO

Match each term with the appropriate definition.
I.Split FormA.A control that is linked to a record source
II.Multiple Items B.The underlying table or query that provides the fields for
the form
III.Record Source C.A control not linked to a record source, used to label form objects
IV.Unbound D.A customizable form that displays multiple records from a
source table or query in a datasheet format
V.BoundE.Creates a customizable form displaying the record source in
two views at the same time
Answer: https://biology-forums.com/index.php?topic=270602

Question 582
If you needed to design a query to calculate the year contained in a date field, you would use the ________ function.
Answer: https://biology-forums.com/index.php?topic=270515

Question 583
A primary key from one table that is used to form a relationship with a second table is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270362

Question 584
In many open program windows a Search box is available at the ________ of the window.
A) bottom right corner
B) near the bottom center
C) top right corner
D) top left corner
Answer: https://biology-forums.com/index.php?topic=271622
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Question 585

Question 586

M
S.
C
O

The ________ property can be applied to change the way a field is displayed or printed.
Answer: https://biology-forums.com/index.php?topic=270442

M

The ________ tab allows you to include a media object in your presentation.
Answer: https://biology-forums.com/index.php?topic=271018

Question 587

R
U

Windows 7's Help and Support feature is available:
A) from the Start menu.
B) in the Notification area.
C) from the desktop.
D) from the taskbar.
Answer: https://biology-forums.com/index.php?topic=271627

Question 588

YFO

You can rename a chart sheet before you click OK in the ________ Chart dialog box.
Answer: https://biology-forums.com/index.php?topic=270792

Question 589

LO

Question 590

G

Which of the following is TRUE about cropping?
A) Cropping adjusts the amount of a picture that displays.
B) Cropping reduces the size of a graphic.
C) If you crop half of an image, the size of the Word document is reduced.
D) When you crop an image, the portion cropped from the photo is deleted.
Answer: https://biology-forums.com/index.php?topic=271382

A(n) file ________ is an identifier of a file, possibly the author or date created.
Answer: https://biology-forums.com/index.php?topic=271653

IO

Question 591

B

What is the difference between a SmartArt List diagram and a SmartArt Process diagram?
A) The List is for nonsequential information; the Process is steps in a process.
B) Lists are always horizontally displayed while Processes are always displayed vertically.
C) They both show a process or timeline but Lists are vertical and Processes are horizontal.
D) Lists are always vertically displayed while Processes are always displayed horizontally.
Answer: https://biology-forums.com/index.php?topic=271133

Question 592
Which of the following wrapping options in the Table Properties dialog box allows you to display text on the side of a table?
A) Left
B) None
C) Around
D) Center
Answer: https://biology-forums.com/index.php?topic=271507

Question 593
The .txt extension represents ________ format.
Answer: https://biology-forums.com/index.php?topic=271092

Question 594
All of the following are Form views EXCEPT:
A) Tabular View
B) Layout View
C) Form View
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D) Design View
Answer: https://biology-forums.com/index.php?topic=270542

Question 596

YFO

R
U

To put a long text label on two or more lines within a single cell
A) type the first line, then hit "Enter".
B) insert a line break with the "Alt + Enter" key combination.
C) type the second line then use the Backspace key.
D) insert a text box using F4.
Answer: https://biology-forums.com/index.php?topic=270611

M
S.
C
O

Match the following Ribbon Tab or Group items to their description:
I.FileA. Contains tools relating to the more advanced features of
Access
II.HomeB.Contains access to tools such as Compact and Repair and
Backup Database
III.Create C.Contains basic editing functions and formatting tools
IV.External DataD.Contains the tools necessary for producing reports and
forms
V.Database ToolsE.Contains the tools necessary for data import and export
Answer: https://biology-forums.com/index.php?topic=270384

M

Question 595

Question 597

Question 598

LO

G

You can add Visual Basic for Applications (VBA) code to a form in ________ view.
A) Report View
B) Design View
C) Layout View
D) Print Preview
Answer: https://biology-forums.com/index.php?topic=270559

B

IO

You can do all EXCEPT ________ from the Audio Tools Playback tab.
A) record narration
B) add a bookmark
C) trim an audio file
D) fade in and fade out
Answer: https://biology-forums.com/index.php?topic=271220

Question 599

Match each element of an expression with is definition:
I.Identifiers A.Produce results based on inputs
II.OperatorsB.Values that do not change
III.FunctionsC.Arithmetic instructions such as * , / , + , or —
IV.ConstantsD.Inputs that are needed to produce output for a function
V.Variables E.The names of fields, controls, or properties
VI.ArgumentsF.Elements with a changing value
Answer: https://biology-forums.com/index.php?topic=270533

Question 600
Which of the following keys will not navigate forward or backward while in Slide Show view?
A) N and P
B) Shift and Ctrl
C) Spacebar and Backspace
D) Page Down and Page Up
Answer: https://biology-forums.com/index.php?topic=270999

Question 601
The value axis
A) displays incremental values to identify the values of the data series.
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B) groups or clusters similar data in columns to compare values across categories.
C) compares two or more sets of data in one chart.
D) compares values for one set of data.
Answer: https://biology-forums.com/index.php?topic=270750

Question 603

M
S.
C
O

Which of the following statements is true in reference to calculated fields:
A) Calculated fields can be used as input for other calculated fields
B) Calculated field names should contain spaces
C) Calculated fields cannot be created with Expression Builder
D) Calculated fields cannot be added to tables
Answer: https://biology-forums.com/index.php?topic=270481

M

Question 602

R
U

While viewing slides in the Slide Sorter, a(n) ________ icon indicates that a slide has animation.
A) arrow
B) check mark
C) red circle
D) star
Answer: https://biology-forums.com/index.php?topic=270992

YFO

Question 604

A mathematical symbol such as an addition or subtraction sign is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270432

Question 605

IO

Question 606

LO

G

A form can be used to:
A) select records that meet specific criteria.
B) automate the retrieval and update process.
C) sort data in ascending or descending order.
D) enter, edit, and view records in a database.
Answer: https://biology-forums.com/index.php?topic=270327

The ________ button in the Edit Photo Album dialog box allows you to turn an image 90 degrees each time it is clicked.
Answer: https://biology-forums.com/index.php?topic=271262

B

Question 607

A(n) ________ style stores character formatting and affects only selected text.
Answer: https://biology-forums.com/index.php?topic=271406

Question 608
A(n) ________ is digital video compression used to compress movies and then decompress for playback.
Answer: https://biology-forums.com/index.php?topic=271246

Question 609
The ________ gallery pairs a title text style with a body text style.
Answer: https://biology-forums.com/index.php?topic=271106

Question 610
Which of the following is NOT a typical way to add audio to a PowerPoint presentation?
A) Insert audio directly from a Web page
B) Insert audio from a file
C) Record audio
D) Insert from the Clip Art pane
Answer: https://biology-forums.com/index.php?topic=271225

Question 611
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Question 612
What happens to the mouse pointer when you place it on a border of a window?
A) It becomes a four-headed arrow
B) It changes to a double-headed arrow
C) It disappears
D) It turns red
Answer: https://biology-forums.com/index.php?topic=271603

Question 613

M
S.
C
O

M

Which of the following is NOT an actual gallery in PowerPoint 2010?
A) Colors gallery
B) Fonts gallery
C) Page Setup gallery
D) Styles gallery
Answer: https://biology-forums.com/index.php?topic=271077

YFO

R
U

Which of the following is TRUE about background shapes and graphics?
A) Shapes and graphics can be hidden on all background themes.
B) The intense background styles can be changed and hidden; the subtle cannot.
C) Backgrounds cannot be changed by the user.
D) Background shapes and graphics can be hidden on ALL slides but not on one individual slide.
Answer: https://biology-forums.com/index.php?topic=271079

Question 614

IO

Question 615

LO

G

Match the following views in PowerPoint 2010 with its function:
I.Notes Page viewA.deliver a presentation on two monitor
simultaneously
II.Slide Sorter viewB.view one slide at a time with a title bar and
Close button
III.Slide Show viewC.to enter and edit large amounts of text for the
speaker to refer to
IV.Reading viewD.view multiple slide at one time
V.Presenter viewE.deliver the final presentation to an audience
Answer: https://biology-forums.com/index.php?topic=271031

B

_______ Connect is a Windows 7 help feature that allows two users both using Windows 7 to take advantage of the Remote Assistance feature.
Answer: https://biology-forums.com/index.php?topic=271659

Question 616

Which of the following is NOT a Zoom option?
A) Two pages
B) Whole page
C) Many pages
D) Page width
Answer: https://biology-forums.com/index.php?topic=271300

Question 617
When using Remote Assistance, if the person you are connected with is also using Windows 7, you can use a method called:
A) Remote Connect
B) Connect with 7
C) Easy Connect
D) Windows 7 Connect
Answer: https://biology-forums.com/index.php?topic=271632

Question 618
Match the following terms with their description:
I.libraryA.an organization method that collects files and
displays them as one unit
II.backupB.predesigned file
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III.templateC.switch from one setting to another
IV.toggleD.graphic file
V.pictureE.copy of a file
Answer: https://biology-forums.com/index.php?topic=270965

The MAX function
A) tallies the number of cells in a range that are not empty.
B) identifies the highest value in a range.
C) tallies the number of blank cells in a range.
D) tallies the number of cells in a range that contain values.
Answer: https://biology-forums.com/index.php?topic=270683

Question 620

R
U

The Hide Background Graphics button is located in the ________ group.
Answer: https://biology-forums.com/index.php?topic=271105

M
S.
C
O

M

Question 619

Question 621

YFO

Which of the following is recommended as the first step in planning a presentation?
A) Research your audience
B) Determine the goal
C) Brainstorm how to deliver your message
D) Sketch out your thoughts about the presentation
Answer: https://biology-forums.com/index.php?topic=270972

Question 622

IO

Question 623

LO

G

You have been working in a database. Your boss asks you to design and print out a report for an upcoming board meeting. What view should you
use to ensure that the report will print out as intended?
A) Layout view
B) Print Preview
C) Design view
D) Report view
Answer: https://biology-forums.com/index.php?topic=270550

B

Forms may include ________ controls, which are decorative or design elements, but not connected to a data source.
Answer: https://biology-forums.com/index.php?topic=270589

Question 624

A ________ is an area in the worksheet that contains rows and columns of related data formatted to enable data management and analysis.
Answer: https://biology-forums.com/index.php?topic=270864

Question 625
Which of the following is a new Office 2010 feature?
A) Changing the contrast and brightness within the same image
B) Inserting symbols into a document
C) The ability to remove the background of a picture
D) Compressing the size of all images in a document
Answer: https://biology-forums.com/index.php?topic=271384

Question 626
Which of the following is FALSE about saving a search?
A) To conduct a saved search, open the Computer window.
B) To save a search, click Save search on the toolbar.
C) Saved searches are displayed in the Documents library section of the Computer window.
D) You only need to click the link of a saved search to get new results.
Answer: https://biology-forums.com/index.php?topic=271626

Question 627
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A ________ reference is a tag or use of a table element as a reference in a formula.
Answer: https://biology-forums.com/index.php?topic=270875

Question 628

M

For fields containing social security numbers or dates, a(n) ________ can automatically provide characters such as hyphens or slashes.
Answer: https://biology-forums.com/index.php?topic=270440

M
S.
C
O

Question 629

Semi-selection or pointing
A) indicates a cells relative location from the cell containing the formula.
B) indicates a cell's specific location and the reference does not change when you copy the formula.
C) is the process of using the mouse to select cells while building a formula.
D) creates an Equals (=) sign.
Answer: https://biology-forums.com/index.php?topic=270670

Question 630

YFO

R
U

Match the following windows features or parts to their meanings:
I.title barA.found on the right side of the title bar
II.control buttonsB.hide the window from view
III.Minimize buttonC.used to close a window
IV.Close buttonD.restore down or fill the desktop
V.Maximize buttonE.includes the file name and the program
Answer: https://biology-forums.com/index.php?topic=271662

Question 631

G

After you have entered information into the Document Panel of a file, you can use it as search criteria when you use the ________ search tool.
Answer: https://biology-forums.com/index.php?topic=271336

Question 632

IO

LO

What is a quick and easy way to delete a folder in Windows Explorer?
A) Simply double-click the folder name to delete it
B) Right-click and choose Delete
C) Right-click and choose Cut
D) Triple-click the folder name in order to delete it
Answer: https://biology-forums.com/index.php?topic=270896

B

Question 633

A multiple data series chart
A) groups or clusters similar data in columns to compare values across categories.
B) compares two or more sets of data in one chart.
C) is a key that identifies the color, gradient, picture, texture, or pattern fill assigned to each data series in a chart.
D) places stacks of data in segments on top of each other in one column, with each category in the data series represented by a different color.
Answer: https://biology-forums.com/index.php?topic=270752

Question 634
Match the following options with the tab where it can be accessed:
I.add a picture to a slideA.Picture Tools Format tab
II.remove a background from an imageB.Design tab
III.create a background from a pictureC.Video Tools Playback tab
IV.crop a videoD.Video Tools Format tab
V.fade video in and outE.Insert tab
Answer: https://biology-forums.com/index.php?topic=271270

Question 635
The Start button, open window buttons, and the ________ area are located on the taskbar.
Answer: https://biology-forums.com/index.php?topic=271641

Question 636
A note that refers a reader to another place within a document for more information about a topic is known as a(n) ________.
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Answer: https://biology-forums.com/index.php?topic=271487

Question 638

M
S.
C
O

How do you constrain the rotation of a selected object to 15-degree angles?
A) Hold the Ctrl key
B) Click on the Constrain Angle button
C) Hold the Shift key
D) Click the object border one time for each 15-degree change
Answer: https://biology-forums.com/index.php?topic=271149

M

Question 637

R
U

If you were creating your own dialog box, which of the following features would be most appropriate to show five different print options?
A) List box
B) Text box
C) Spin arrow
D) Check box
Answer: https://biology-forums.com/index.php?topic=271606

Question 639

YFO

________ is the horizontal width of a column.
Answer: https://biology-forums.com/index.php?topic=271544

Question 640

LO

Question 641

G

A formula in Excel must begin with
A) a cell's specific location.
B) a cells relative location.
C) both an absolute and a relative cell reference.
D) an Equals (=) sign.
Answer: https://biology-forums.com/index.php?topic=270671

B

IO

Match the arithmetic operators in order of precedence:
I.ParenthesesA.3rd in order of precedence
II.ExponentB.1st in order of precedence
III.MultiplicationC.4th in order of precedence
IV.DivisionD.5th in order of precedence
V.AdditionE.2nd in order of precedence
Answer: https://biology-forums.com/index.php?topic=270667

Question 642

Constants that are used as arguments in expressions can be defined as ________.
A) Variables that do not change
B) Objects that do not change
C) Values that do not change
D) Functions that do not change
Answer: https://biology-forums.com/index.php?topic=270470

Question 643
The ________ of a field determines the kind of content that can be entered or operations that can be performed on the field content.
Answer: https://biology-forums.com/index.php?topic=270447

Question 644
Click a(n) ________ to resize a shape that you've inserted on a slide.
A) adjustment handle
B) rotation handle
C) sizing handle
D) shape line
Answer: https://biology-forums.com/index.php?topic=271119
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Question 645

Question 646

R
U

Match the following tabs in PowerPoint 2010 with an available feature on that tab:
I.HomeA.New
II.FileB.Decrease List Level
III.DesignC.Header & Footer
IV.ViewD.Theme gallery
V.InsertE.Slide Sorter
Answer: https://biology-forums.com/index.php?topic=271111

M
S.
C
O

M

Margins are only viewable if you are in ________ view or in Backstage.
A) Draft or Outline
B) Draft
C) Draft or Page Layout
D) Print Layout or Page Layout
Answer: https://biology-forums.com/index.php?topic=270929

Question 647

YFO

Freddie is working on a database that stores inventory information. His boss has asked him to print a report for review by auditors. Freddie wants to
make sure the report prints correctly. He should view the report using ________ before printing the report.
Answer: https://biology-forums.com/index.php?topic=270591

Question 648

The first step when saving a file for someone running Word 97-2003 is to click the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271330

G

Question 649

IO

LO

All of the following are sections of an Access Form EXCEPT:
A) Detail Section
B) Header Section
C) Page Header Section
D) Footer Section
Answer: https://biology-forums.com/index.php?topic=270547

Question 650

B

Sarah is working in a database that stores resort vacation information. She needs to design a field that will allow a user to link to an external website.
The data type she should apply to this field is:
A) Memo
B) OLE
C) Hyperlink
D) Attachment
Answer: https://biology-forums.com/index.php?topic=270398

Question 651
The ________ displays form fields in vertical column, and displays one record at a time.
A) Stacked Layout
B) Layout View
C) Tabular Layout
D) Print Preview
Answer: https://biology-forums.com/index.php?topic=270536

Question 652
In the table pictured above, the column labeled Last Name is an example of a:
A) record.
B) field.
C) table.
D) query.
Answer: https://biology-forums.com/index.php?topic=270333
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Question 653

M

Expressions to perform calculations such as using a birthdate to find a person's age can be built using ________.
Answer: https://biology-forums.com/index.php?topic=270514

Question 654

M
S.
C
O

What level are styles created on?
A) Word and sentence
B) Character and page
C) Page and document
D) Character and paragraph
Answer: https://biology-forums.com/index.php?topic=271372

YFO

Match the following terms with their descriptions:
I.portion of a picture to be removedA.foreground
II.portion of a picture to be retainedB.compress
III.reduce the file size of an objectC.contrast
IV.difference between light and dark parts
of an imageD.background
V.ratio between lightness and darkness
of an imageE.brightness
Answer: https://biology-forums.com/index.php?topic=271422

R
U

Question 655

Question 656

Question 657

LO

G

The ________ button in the Paragraph group reveals formatting marks in your document.
A) Section break
B) Draft view
C) Show/Hide
D) Paragraph
Answer: https://biology-forums.com/index.php?topic=271277

B

IO

Match the following Microsoft Office 2010 feature with the tab where it can be found:
I.open Office BackstageA.contextual tab
II.modify textB.File tab
III.create a new chart in ExcelC.Home tab
IV.modify an object D.Page Layout tab
V.change margins in WordE.Insert tab
Answer: https://biology-forums.com/index.php?topic=270964

Question 658
What is the difference between the information you initially see in the Backstage view of a file and the information in the Document Panel?
A) The information is exactly the same in both places
B) The Document Panel offers more properties that can be entered and edited
C) The Document Panel offers fields only for the author while the initial Backstage view offers file information
D) The Backstage view offers a visual of the document information while the Document Panel offers the data that can be edited
Answer: https://biology-forums.com/index.php?topic=271310

Question 659
Ribbon Commands with arrows indicate
A) a shortcut to cell A1.
B) there are two or more sub-commands related to the command.
C) the next step in the process.
D) directionality.
Answer: https://biology-forums.com/index.php?topic=270618

Question 660
By default, Word inserts a(n) ________ at the beginning of a caption created in Word 2010.
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M

A) letter
B) two-word title
C) ScreenTip
D) number
Answer: https://biology-forums.com/index.php?topic=271455

M
S.
C
O

Question 661
Predesigned files that Office provides are called ________.
Answer: https://biology-forums.com/index.php?topic=270943

Question 662

Question 663

YFO

The ________ bar informs a user of the current drive or folder.
Answer: https://biology-forums.com/index.php?topic=270935

R
U

An exploded pie chart
A) shows the high, low, and close prices for individual stocks over time.
B) emphasizes magnitude of changes over time by filling in the space between lines with a color.
C) shows a relationship between two variables.
D) separates one or more pie slices from the rest of the pie chart.
Answer: https://biology-forums.com/index.php?topic=270761

Question 664

The Change Case button is located in the Font group on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271393

G

Question 665

IO

Question 666

LO

Which of the following is NOT an option when clicking the Full Page Slides button?
A) Scale to Fit
B) High Quality
C) Grayscale
D) Frame
Answer: https://biology-forums.com/index.php?topic=271002

B

A(n) ________ control displays the data found in a field in a form’s record source.
Answer: https://biology-forums.com/index.php?topic=270587

Question 667

When you use the form tool to create a form, Access analyzes relationships between tables, and automatically adds a(n) ________, which displays
records with foreign key values that match the primary key value in the main form.
Answer: https://biology-forums.com/index.php?topic=270580

Question 668
Match the following Word 2010 tabs with the function available on that tab:
I.Home tabA.apply font attributes
II.Insert tabB.include a nonbreaking space or hyphen in a
document through the Symbols gallery
III.Page Layout tabC.see the outline in a document
IV.View tabD.format text into columns
V.Picture Tools Format tabE.use the Height and Width commands
Answer: https://biology-forums.com/index.php?topic=271417

Question 669
How do you activate the Lock Drawing Mode feature in PowerPoint 2010?
A) Click the Lock Drawing Mode button on the Insert tab
B) Right-click the Shapes button and select Lock Drawing Mode
C) Click the Lock Drawing Mode option below the Shape gallery
D) Right-click the shape you want and select Lock Drawing Mode

Page 80 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Answer: https://biology-forums.com/index.php?topic=271120

Question 670

M

A form that displays records horizontally, with label controls across the top and the data values in rows under the labels is in a ________ layout.
Answer: https://biology-forums.com/index.php?topic=270578

M
S.
C
O

Question 671

An expression or integer value specifying total number of payments in a loan is the ________ argument in the PMT function.
A) rate
B) num_periods
C) present value
D) future value
Answer: https://biology-forums.com/index.php?topic=270502

Question 672

YFO

R
U

Word uses ________ to identify data in a table and formats it to be used in the formula.
A) syntax
B) field codes
C) merge fields
D) a data source
Answer: https://biology-forums.com/index.php?topic=271513

Question 673

A ________ letter is typically a printed letter mailed to multiple recipients and personalized for each one.
Answer: https://biology-forums.com/index.php?topic=271555

G

Question 674

Question 675

LO

The sequence by which operations are calculated in an expression for a calculated field is determined by the ________.
Answer: https://biology-forums.com/index.php?topic=270506

B

IO

Which of the following query criteria would be used to produce results for Date/Time fields containing a date of December 12th, 2010?
A) 12/12/2010
B) #12/12/2010#
C) Between #12/11/2010# and #12/14/2010#
D) 12/11/2010
Answer: https://biology-forums.com/index.php?topic=270390

Question 676

If you open a Word document in PowerPoint and each item becomes a title for a slide, what happened?
A) The Word document is actually a bulleted list rather than an outline.
B) It is not an actual Word document.
C) It is likely a Word document saved in a version prior to Word 2010.
D) The file was incorrectly saved within Word.
Answer: https://biology-forums.com/index.php?topic=271064

Question 677
Sum, Avg, and Max are examples of ________ functions that are used to evaluate entire columns of data.
A) Date
B) Aggregate
C) Number
D) Totalling
Answer: https://biology-forums.com/index.php?topic=270468

Question 678
The ________ in a mail merge contains the information that remains constant for all recipients.
A) data source
B) header row
C) merge fields
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D) main document
Answer: https://biology-forums.com/index.php?topic=271521

A ________ bar is a horizontal gradient or solid fill indicating the cell's relative value compared to other selected cells.
Answer: https://biology-forums.com/index.php?topic=270878
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Question 680
Click the ________ tab to print a presentation in Outline view.
Answer: https://biology-forums.com/index.php?topic=271090

Question 681
The ________ function displays the current date and time in a cell.
Answer: https://biology-forums.com/index.php?topic=270719

YFO

R
U

Question 682
All of the following are acceptable field names EXCEPT:
A) Clientnumber
B) ClientNumber
C) ClientID
D) ClientNum
Answer: https://biology-forums.com/index.php?topic=270407

Question 683

LO

G

The TODAY function
A) evaluates a condition and returns one value if the condition is true and a different value if the condition is false.
B) displays the current date and time.
C) displays the current date.
D) evaluates true or false.
Answer: https://biology-forums.com/index.php?topic=270687

Question 684

M

Question 679

IO

A ________ query is used to display only aggregate data when the query is run.
Answer: https://biology-forums.com/index.php?topic=270529

Question 685

B

Each ________ in a bitmap image contains information about the color to be displayed on a monitor.
Answer: https://biology-forums.com/index.php?topic=271233

Question 686
The ________ of a picture is the area to be kept with the Remove Background tool.
Answer: https://biology-forums.com/index.php?topic=271238

Question 687
How do you apply a table of contents style in Word 2010?
A) Click the References tab, click the Table of Contents button
B) Click the Page Layout tab, click the Table of Contents button
C) Click the Insert tab, click the Table of Contents button
D) Click the Insert tab and click the Table of Contents button in the References group
Answer: https://biology-forums.com/index.php?topic=271447

Question 688
What displays on the Media Control bar to indicate a bookmark location in a video?
A) A purple square box
B) A circle
C) A green triangle
D) A black triangle
Answer: https://biology-forums.com/index.php?topic=271213
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When you select a chart, Excel displays a Chart Tools contextual tab with three specific tabs:
A) Design, Layout, and Format
B) Home, Insert, and Page Layout
C) Chart, Type, and Formulas
D) Data, Review, and Data
Answer: https://biology-forums.com/index.php?topic=270770

Question 690

Question 691

YFO

A typical storyboard includes sections for all of the following EXCEPT:
A) the title slide.
B) to introduce the topic.
C) develop the topics.
D) add animations.
Answer: https://biology-forums.com/index.php?topic=270973

R
U

In the table pictured above, each column represents a:
A) field.
B) record.
C) table.
D) primary key.
Answer: https://biology-forums.com/index.php?topic=270330

Question 692

M

Question 689

G

For a long text label use the "________" key and "Enter" key combination to insert a line break so the text appears on two lines within the cell.
Answer: https://biology-forums.com/index.php?topic=270651

LO

Question 693

A(n) ________ is a note recognizing a source of information or a quoted passage.
Answer: https://biology-forums.com/index.php?topic=271474

IO

Question 694

B

Click the ________ tab to begin the process of creating a photo album presentation.
Answer: https://biology-forums.com/index.php?topic=271261

Question 695

A "Range"
A) cannot be selected with the mouse.
B) are the numbers that fall between the smallest and largest in the formula.
C) is another word for the active worksheet.
D) refers to a group of adjacent or contiguous cells.
Answer: https://biology-forums.com/index.php?topic=270623

Question 696
________ keeps rows and/or columns visible as you scroll through a worksheet.
Answer: https://biology-forums.com/index.php?topic=270858

Question 697
The ________ function finds the lowest value in a list.
Answer: https://biology-forums.com/index.php?topic=270717

Question 698
A number that represents a quantity or amount is called a ________.
Answer: https://biology-forums.com/index.php?topic=270652

Question 699
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A written note or drawing that offers additional commentary or explanation and is written during a slide show is known as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271027

Question 700

M
S.
C
O

M

Katie is working in a customer table and needs to know if any customers are located in Texas. In order to locate this information, she would:
A) create a query.
B) create a new table.
C) create a form.
D) create a report.
Answer: https://biology-forums.com/index.php?topic=270325

Question 701
A(n) ________ structures information in columns and rows on a slide.
Answer: https://biology-forums.com/index.php?topic=271019

Question 702

YFO

R
U

When choosing between Access and Excel, it is best to use Excel in all of the following circumstances EXCEPT:
A) you only need a single worksheet to manage data.
B) you need to manage primarily of numeric data.
C) you need to run a series of "what if" scenarios .
D) you need to group, sort, and total data based on various parameters.
Answer: https://biology-forums.com/index.php?topic=270339

Question 703

Question 704

LO

G

What does the Custom tab of the Properties dialog box of the Document Properties feature allow you to do?
A) It allows you to print the document properties
B) It allows you to delete fields from the document properties
C) It allows you to add custom property categories and assign values to them
D) It provides useful information about the document
Answer: https://biology-forums.com/index.php?topic=271311

IO

Calculated fields requiring complex expressions can be created with ________ in Access.
Answer: https://biology-forums.com/index.php?topic=270509

Question 705

B

The ________ tab is the default Access tab and contains basic editing functions.
A) External Data
B) database Tools
C) Create
D) Home
Answer: https://biology-forums.com/index.php?topic=270353

Question 706
The Mark Entry button is located in the ________ group (the same group name as the final result of marking an entry).
Answer: https://biology-forums.com/index.php?topic=271483

Question 707
Ryan is working in a database that organizes vendor contact information. Ryan must find vendors located in two cities. The vendors must have
offices in both cities in order to meet Ryan's requirements. Ryan should use the Filter by Form ________ condition.
A) query
B) sort
C) OR
D) AND
Answer: https://biology-forums.com/index.php?topic=270341

Question 708
________ graphics are created using geometrical formulas and can be easily edited and layered.
Answer: https://biology-forums.com/index.php?topic=271176
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Question 709

Question 710

M
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Which of the following is NOT a feature that is automatically included when Word opens?
A) Horizontal ruler
B) Quick Access Toolbar
C) Zoom dialog box
D) Zoom slider
Answer: https://biology-forums.com/index.php?topic=271273

M

A(n) ________ is movement that occurs between slides and how one slide replaces another.
Answer: https://biology-forums.com/index.php?topic=271023

Question 711

YFO

R
U

After clicking File, Open, and All PowerPoint Presentations arrow, which files will be listed?
A) All files on your hard drive
B) All files on whichever drive you specify
C) Only PowerPoint files
D) All files in a format PowerPoint recognizes
Answer: https://biology-forums.com/index.php?topic=271063

Question 712

G

All of the following EXCEPT ________ is a document type available in a mail merge.
A) Letters
B) E-mail Messages
C) Tables
D) Envelopes
Answer: https://biology-forums.com/index.php?topic=271522

LO

Question 713

IO

You can create or modify a table's field names and data types in ________ view.
A) Report
B) Form
C) Datasheet
D) Design
Answer: https://biology-forums.com/index.php?topic=270347

B

Question 714

A(n) ________ is a series of rows and columns that organize data in your document.
Answer: https://biology-forums.com/index.php?topic=271539

Question 715
A(n) ________ can be a game, a puzzle, or a constantly changing data item such as a clock or calendar.
Answer: https://biology-forums.com/index.php?topic=271635

Question 716
Using Conditional Formatting to highlight ________ is useful to see where you are missing data.
Answer: https://biology-forums.com/index.php?topic=270879

Question 717
Highlight Cell Rules
A) formats the condition of the worksheet in preparation for printing.
B) calculates an aggregate for values in a range or database.
C) tags a table element as a reference in a formula.
D) highlight cells meeting specified criteria with a specified color, font, or border.
Answer: https://biology-forums.com/index.php?topic=270849

Question 718
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A(n) ________ is a citation that appears at the end of a document.
Answer: https://biology-forums.com/index.php?topic=271479

M
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Which of the following is the correct mathematical sequence for the order of operations:
A) Multiplication, Division, Exponentiation, Addition, Subtraction
B) Exponentiation, Multiplication, Division, Addition, Subtraction
C) Multiplication, Exponentiation, Division, Addition, Subtraction
D) Addition, Subtraction, Multiplication, Exponentiation, Division
Answer: https://biology-forums.com/index.php?topic=270484

Question 721

R
U

Question 720
Which of the following could be a Word table saved as a database file?
A) Oregon customers.mdb
B) Oregon_cust.docx
C) Washington customers.accdb
D) Washington_cust.accd
Answer: https://biology-forums.com/index.php?topic=271525

M

Question 719

YFO

To select a range in using the name box
A) click in the name box and type the range address such as B15:D25 and then press "Enter".
B) select the name box from the 2010 File menu and choose "Range".
C) position the mouse pointer over the column headings holding the Alt key.
D) click in the first cell of the range, hold the "Ctrl" key, and then click in the last cell of the range.
Answer: https://biology-forums.com/index.php?topic=270625

G

Question 722

IO

LO

Which of the following is NOT a Table Alignment option?
A) Center
B) Custom
C) Right
D) Top
Answer: https://biology-forums.com/index.php?topic=271508

Question 723

B

Aero ________ is a preview of any open window even when it is obscured by another window.
Answer: https://biology-forums.com/index.php?topic=271644

Question 724

The Sticky Notes feature of Windows 7 can be accessed from the Start button,:
A) All Programs, Accessories, and Sticky Notes.
B) All Programs, and Sticky Notes.
C) Control Panel, and Sticky Notes.
D) All Programs, Computer, and Sticky Notes
Answer: https://biology-forums.com/index.php?topic=271614

Question 725
________ affects the background color within a cell, group of cells, or a table.
Answer: https://biology-forums.com/index.php?topic=271545

Question 726
You create a calculated field that finds the average of a column of numbers. Access automatically names the field Expr1. Which of the following
statements is true regarding the automatic naming of the calculated field?
A) You cannot edit an expression in a calculated field that has been named Expr1 by Access
B) Access assigns Expr1 to a calculated field name when an expression contains an error.
C) You cannot edit the name of a calculated field that has been named Expr1
D) Access assigns Expr1 to a calculated field without a name, and this name can be edited
Answer: https://biology-forums.com/index.php?topic=270492
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YFO

When do contextual tabs display in Office 2010?
A) When you select a paragraph in a document
B) When you right-click the Ribbon and check a conceptual tab name
C) When you click the Home tab
D) When you select an object in a document
Answer: https://biology-forums.com/index.php?topic=270906
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Question 728

R
U

Match the conditional formatting options to their descriptions:
I.Highlight Cell RulesA.format cells based upon their value in relation to the
value of other cells such as the top 10%
II.Top Bottom RulesB.horizontal gradient or solid fill indicating the cell's
relative value compared to other selected cells
III.Data barC.highlight cells meeting specified criteria with a specified
color, font, or border
IV.Color scaleD.conditional format that displays a particular color
based on the relative value of the cell contents to other
selected cells
V.Icon setE.conditional format that displays an icon representing
a value in the top third, quarter, or fifth based on
values in the selected range
Answer: https://biology-forums.com/index.php?topic=270889

M

Question 727

Question 729

Question 730

LO

G

The ________ data type is used to hold sentences or paragraphs of descriptive data.
A) Text
B) OLE
C) Memo
D) Hyperlink
Answer: https://biology-forums.com/index.php?topic=270413

B

IO

The first two arguments of the DatePart function are ________ which describes the part of the date that will be returned; and ________ which tells
Access where to locate the date/time information.
A) <<date>>, <<interval>>
B) <<interval>>, <<date>>
C) <<date>>, <<firstdayofweek>>
D) <<date>>, <<firstweekofyear>>
Answer: https://biology-forums.com/index.php?topic=270478

Question 731
You should use cell references in formulas instead of constant values so
A) you can easily include letters, numbers, and spaces.
B) it is easier to debug the errors.
C) you can change the input values without changing the formulas.
D) you can control the sequence in which Excel performs arithmetic operations.
Answer: https://biology-forums.com/index.php?topic=270615

Question 732
A formula used to calculate new fields from the values in existing fields is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270508

Question 733
Sorting Values smallest to largest
A) arranges names in sequential order.
B) arranges numbers in sequential order.
C) arranges dates in alphabetical order.
D) is the process of displaying only records that meet specific conditions.
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Answer: https://biology-forums.com/index.php?topic=270840
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An absolute cell reference
A) causes a potential error.
B) indicates a cell's specific location and the reference does not change when you copy the formula.
C) occurs when a formula directly or indirectly refers to the cell containing the formula.
D) contains both an absolute and a relative cell reference.
Answer: https://biology-forums.com/index.php?topic=270673

M

Question 734

Question 735

R
U

Match the beginning of each sentence with the ending of each in the second column in regard to design principles:
I.Sans serif fontsA.are best used if the presentation will be printed.
II.Serif fontsB.should not be used (except as hyperlinks).
III.Underlined textC.should be used sparingly.
IV. ItalicsD.should be used when delivering a presentation on a
projector.
V.Thirty-six point fontE.should be the minimum for title placeholders.
Answer: https://biology-forums.com/index.php?topic=271113

YFO

Question 736

If an audio file is intended as background music but stops before you get to the last slide, use the ________ feature.
A) Timing
B) Play Across Slides
C) Loop Until Stopped
D) With Previous or After Previous
Answer: https://biology-forums.com/index.php?topic=271224

G

Question 737

Question 738

LO

Arranging table data from A to Z is ________ order.
Answer: https://biology-forums.com/index.php?topic=271550

IO

The ________ of a photo refers to the difference between the darkest and the lightest areas of the image.
Answer: https://biology-forums.com/index.php?topic=271240

B

Question 739

Match the type of data that can be entered into a cell with its description:
I.TextA.Stored as a "serial" number but can be displayed in
varies ways
II.ValuesB.Letters, Numbers, symbols not used in calculations
III.DatesC.Cell references, arithmetic operations, values…used in
a calculation
IV.FormulasD.Numbers that represent a quantity to be used as a basis
for calculations
V.AutoCompleteE.Displays other labels in that column that match the
letters you type
Answer: https://biology-forums.com/index.php?topic=270665

Question 740
If you are in the Backstage view and want to return to a document, press ________ on the keyboard.
Answer: https://biology-forums.com/index.php?topic=271335

Question 741
Which of the following Mail Merge Commands from the Mailings tab enables you to choose the type of main document you will work with?
A) Start Mail Merge
B) Select Recipients
C) Highlight Merge Fields
D) Match Fields
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Answer: https://biology-forums.com/index.php?topic=271536

Question 742

M
S.
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M

What is the default name of a new section?
A) Untitled Section
B) Section1
C) Section Rename
D) Section panel
Answer: https://biology-forums.com/index.php?topic=271069

Question 743

R
U

Consider the table pictured above. The value of 150 in the totals row represents the total hours worked. How was this value calculated in the totals
row?
A) This value is a result of the Count function being applied to the HoursWorked Field
B) This value is a result of the Average function being applied to the HoursWorked Field
C) This value is a result of the Sum function being applied to the HoursWorked Field
D) This value is a result of the Maximum function being applied to the HoursWorked Field
Answer: https://biology-forums.com/index.php?topic=270499

Question 744

YFO

________ can be used to mark location in a video to make it easier to advance to a specific location.
Answer: https://biology-forums.com/index.php?topic=271248

Question 745

Question 746

LO

G

Match the following examples of files to the program that likely created it:
I.NotepadA.a digital photograph with drawings added
II.WordPadB.advanced scientific programming
III.PaintC.prepare basic program statements
IV.CalculatorD.simple document with formatting
V.Snipping ToolE.capture a screen image to use in a report
Answer: https://biology-forums.com/index.php?topic=271663

IO

The ________ is the long bar in Office 2010 located directly under the Title bar that contains tabs, groups, and commands.
Answer: https://biology-forums.com/index.php?topic=270938

B

Question 747

It is most typical and often most appropriate that Word documents are printed in ________ orientation and Excel documents are printed in ________
orientation.
A) landscape; landscape
B) landscape; portrait
C) portrait; landscape
D) portrait; portrait
Answer: https://biology-forums.com/index.php?topic=270930

Question 748
Filtering the Last_Name column (field) to show only records that begin with the letter S is an application of
A) use of a table element as a formula.
B) a Number Filter.
C) a Text Filter.
D) a Date Filter.
Answer: https://biology-forums.com/index.php?topic=270842

Question 749
A(n) ________ field is used to produce a value from an expression or function.
A) AutoNumber
B) Number
C) Date
D) calculated
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Answer: https://biology-forums.com/index.php?topic=270408

To create a ________ from an existing range of data, click the Insert tab and then click Table in the Tables group.
Answer: https://biology-forums.com/index.php?topic=270867
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Question 751

M

Question 750

The ________ button in the Windows Help and Support program in Windows 7 resembles a printer.
Answer: https://biology-forums.com/index.php?topic=271656

Question 752

After you insert a sparkline, the Sparkline Tools Design contextual tab displays, with options to ________ the sparkline.
Answer: https://biology-forums.com/index.php?topic=270796

Question 753

YFO

R
U

The Header & Footer Tools Design tab allows all of the following features EXCEPT:
A) change the font and formatting options of the header and footer.
B) specify a different header or footer for the first page.
C) allow different headers and footers for odd and even pages.
D) change the distance from the paper edge to the header or footer.
Answer: https://biology-forums.com/index.php?topic=271287

Question 754

When you insert a video from an online video site, you paste the embedded ________ code into the Insert Video From Web Site dialog box.
Answer: https://biology-forums.com/index.php?topic=271251

G

Question 755

IO

LO

Match the following file extensions with their description:
I..rtfA.file format of a Web document
II..txtB.file format that retains structure and most
formatting
III..docxC.file format of Microsoft Word 2010
IV. htmD.file format that retains only text, no formatting
V..pptxE.file format of Microsoft PowerPoint 2010
Answer: https://biology-forums.com/index.php?topic=271114

B

Question 756

You use a(n) ________ control to display text or decorative elements on a form.
A) bound
B) unbound
C) graphical
D) freeform
Answer: https://biology-forums.com/index.php?topic=270563

Question 757
________ view is the three-pane PowerPoint default view.
Answer: https://biology-forums.com/index.php?topic=271009

Question 758
Match the Word 2010 view with its description:
I.Web LayoutA.Word default view
II.DraftB.hides the Ribbon
III.OutlineC.includes the ability to collapse or expand a document
IV.Print Layout D.watermarks do not display in this view
V.Full Screen ReadingE.does not show graphics, footers, or headers
Answer: https://biology-forums.com/index.php?topic=271343

Question 759
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Before designing your own functions for a query, you can open the Built-in functions folder in ________ to see if the function is already available.
Answer: https://biology-forums.com/index.php?topic=270521

M
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The lookup value
A) is the argument in a function that identifies which lookup table column from which to return a value.
B) looks in a horizontal table where the first row contains the values.
C) is a reference to a cell containing a value to look up.
D) is a range containing a lookup table.
Answer: https://biology-forums.com/index.php?topic=270695

M

Question 760

Question 761

R
U

If you click the insertion point within a document and click to insert a comment, what is assigned to the comment?
A) The word immediately following the insertion point
B) The word or object closest to the insertion point
C) The sentence immediately prior to the insertion point
D) The word immediately prior to the insertion point
Answer: https://biology-forums.com/index.php?topic=271428

Question 762

YFO

It is more efficient to copy and use an existing query for a new query when
A) the query criteria needed will be similar to the original query
B) the query will be deleted after it is run
C) the query criteria needed will be unique to the original query
D) the query will be sorted alphabetically
Answer: https://biology-forums.com/index.php?topic=270419

G

Question 763

Question 764

LO

To save a chart as a template, select the chart, click the ________ tab, and then click Save as Template in the Type group.
Answer: https://biology-forums.com/index.php?topic=270786

B

IO

Match the following terms with their descriptions:
I.ascending orderA.process of arranging data
II.descending orderB.rules for constructing an equation
III.syntaxC.contains border, shading, and other enhancements
IV.sortingD.Z to A
V.table styleE.A to Z
Answer: https://biology-forums.com/index.php?topic=271571

Question 765
Match the function categories to their descriptions:
I.LogicalA.Tests such as AND, OR, and NOT
II.Lookup & ReferenceB.Standard Math and trigonometry calculations
III.Math & TrigC.Calculations such as averages and standard
deviations
IV.StatisticalD.Manipulates text strings
V.TextE.Looks up values in cells, creates links to cells, or
provides references to cells
Answer: https://biology-forums.com/index.php?topic=270732

Question 766
The ________ is located at the bottom of the window in Office 2010 and contains file information.
Answer: https://biology-forums.com/index.php?topic=270940

Question 767
Press the _______ key during a presentation to see a list of slide show controls.
Answer: https://biology-forums.com/index.php?topic=271026
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Question 769
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Match the range names to their descriptions:
I.Tax_RateA.Acceptable name with underscore and numbers
II.Commission RateB.Unacceptable name; can't start with a number
III.Discount Rate %C.Acceptable name with underscore
IV.2009_RateD.Unacceptable name; can't use special symbols and spaces
V.Rate_2012E.Unacceptable name; can't use spaces in names
Answer: https://biology-forums.com/index.php?topic=270739

M

Question 768

R
U

Craig is working in a database that stores homes for sale for a Realtor. The database contains a table called HomeListings which contains a field
called ListingDate that holds the date that a home was listed. Craig is designing a query that will identify houses on the market for less than 30 days as
new listings, and houses on the market 30 days or more as old listings. This information will be included in a query column called ListingAge. Which
of the following expressions will achieve these results:
A) ListingAge: IIf(Date-[HomeListings]![ListingDate]<30,"New Listing","Old Listing")
B) ListingAge: IIf(Date-[HomeListings]![ListingDate]>30,"New Listing","Old Listing")
C) ListingAge: IIf(Date-[HomeListings]![ListingDate] < 30, “Old Listing","New Listing")
D) ListingAge: IIf(Date-[ListingDate]![HomeListings]<30,"New Listing","Old Listing")
Answer: https://biology-forums.com/index.php?topic=270491

YFO

Question 770

A screen capture, also known as a(n) ________, can be created using Window 7's Snipping Tool.
Answer: https://biology-forums.com/index.php?topic=271648

Question 771

IO

Question 772

LO

G

A(n) ________ is a replica of a table or query’s Datasheet view that maintains some form properties although the form is limited in design and control
options?
A) Multiple Items form
B) Subform
C) Split form
D) Datasheet form
Answer: https://biology-forums.com/index.php?topic=270539

B

Compression where some data may be lost when decompressed is referred to as ________.
Answer: https://biology-forums.com/index.php?topic=271234

Question 773

Referencing the image above, what number represents the section that a page number would appear in the report?
A) 1
B) 2
C) 3
D) 4
Answer: https://biology-forums.com/index.php?topic=270570

Question 774
A(n) ________ is the blank space on the left, right, top, and bottom sides of a document or worksheet.
Answer: https://biology-forums.com/index.php?topic=270953

Question 775
A total row, which can be displayed as the last row in the Datasheet view of a table, provides a number of ________ functions that can be applied to
columns of data.
A) Aggregate
B) DateTime
C) Statistical
D) PMT
Answer: https://biology-forums.com/index.php?topic=270486
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Question 776

M

When you turn on a computer and enter any username and password prompts that may be required, the ________ displays on the screen.
Answer: https://biology-forums.com/index.php?topic=271634

A ________ is the intersection of a column and a row.
Answer: https://biology-forums.com/index.php?topic=270645

Question 778
Click the File tab and click Print to view the ________ settings and options for printing.
Answer: https://biology-forums.com/index.php?topic=271332

Question 779

M
S.
C
O

Question 777

R
U

The ________ of a picture is the area to be removed with the Remove Background tool.
Answer: https://biology-forums.com/index.php?topic=271237

Question 780

YFO

Which of the following is true about the NOT operator?
A) The NOT operator returns records meeting any of the specified criteria
B) The NOT operator returns records meeting all of the specified criteria
C) The NOT operator does return any records
D) The NOT operator returns all records except those that meet the specified criteria
Answer: https://biology-forums.com/index.php?topic=270415

Question 781

IO

Question 782

LO

G

A caption is descriptive text for all of the following EXCEPT:
A) an outline.
B) a figure.
C) an image.
D) a table.
Answer: https://biology-forums.com/index.php?topic=271454

B

Which Windows 7 feature aligns a window on the right or left side of the desktop when dragging the title bar of the window to the side?
A) Aero Flip 3D
B) Snip
C) Snap
D) Aero Peek
Answer: https://biology-forums.com/index.php?topic=271610

Question 783
Sorting arranges records in a table
A) by the number of pages in the worksheet.
B) by the number of pages in the workbook.
C) by the value in field(s) within a table.
D) by permanently removing extraneous data.
Answer: https://biology-forums.com/index.php?topic=270837

Question 784
The RATE
A) is the periodic interest rate, such as a monthly interest rate.
B) is the total number of payment periods.
C) is a word or a string of characters that represent one or more cells.
D) the present value of the loan.
Answer: https://biology-forums.com/index.php?topic=270700

Question 785
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M

Which of the following Word 2010 features reveals hidden data in a file?
A) Document Properties
B) Compatibility Checker
C) Document Panel
D) Document Inspector
Answer: https://biology-forums.com/index.php?topic=271304

M
S.
C
O

Question 786

Filtering the Last_Name field to show only records that begin with the letter S is an application of a ________ Filter.
Answer: https://biology-forums.com/index.php?topic=270874

Question 787

R
U

The SUM function
A) identifies the midpoint value in a set of values.
B) calculates the total of values contained in two or more cells.
C) calculates the arithmetic mean or average of values in a range.
D) displays the lowest value in a range.
Answer: https://biology-forums.com/index.php?topic=270679

Question 788

YFO

A(n) ________ is a collection of fields that describe a person, place, object, event, or idea.
Answer: https://biology-forums.com/index.php?topic=270356

Question 789

________ an image is the process of trimming edges off of the image.
Answer: https://biology-forums.com/index.php?topic=271410

G

Question 790

IO

LO

Which of the following does NOT create harmony and unity on slides?
A) Repeat colors
B) Use clip art in only one style
C) Use photographs as well as clip art
D) Repeat shapes
Answer: https://biology-forums.com/index.php?topic=271074

Question 791

B

Which of the following is NOT an artistic effect available in PowerPoint 2010?
A) Marker
B) Pencil sketch
C) Watercolor painting
D) 3-D
Answer: https://biology-forums.com/index.php?topic=271204

Question 792
To ________ a table into a range, click within the table, click the Table Tools Design tab and from the Tools group, select Convert to Range.
Answer: https://biology-forums.com/index.php?topic=270868

Question 793
The form header section displays
A) in the form’s record source.
B) at the bottom of the form.
C) at the top of each form.
D) at the top of each page.
Answer: https://biology-forums.com/index.php?topic=270543

Question 794
A table of ________ is a list of captions within a document.
Answer: https://biology-forums.com/index.php?topic=271486
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Question 795

M

All folders in ________ are automatically included within an index in Windows 7.
Answer: https://biology-forums.com/index.php?topic=271654

Question 796

M
S.
C
O

A trendline
A) is a line used to depict trends and forecast future data.
B) is text that describes a collection of data points in a chart.
C) is a group of related data points.
D) displays data comparisons vertically in columns.
Answer: https://biology-forums.com/index.php?topic=270779

Question 797

R
U

________ is duplication of data stored in two or more tables.
Answer: https://biology-forums.com/index.php?topic=270450

Question 798

YFO

If a formula contains a reference to the cell containing the formula a ________ reference exists.
Answer: https://biology-forums.com/index.php?topic=270710

Question 799

LO

Question 800

G

Aggregate functions are most commonly used in all of the following Access objects EXCEPT:
A) Tables
B) Queries
C) Forms
D) Macros
Answer: https://biology-forums.com/index.php?topic=270469

B

IO

The converter needed by Word 97-2003 programs to open Word 2010 files is known as the:
A) AutoRecover.
B) Converter.
C) Compatibility Checker.
D) Compatibility Pack.
Answer: https://biology-forums.com/index.php?topic=271301

Question 801

________ is a single spreadsheet that can contain formulas, functions, values, text and visual aids.
Answer: https://biology-forums.com/index.php?topic=270636

Question 802
When entering text in the Text pane of a SmartArt design and you want to increase the indent level, press:
A) Tab
B) Enter
C) Shift+Tab
D) Alt+Tab
Answer: https://biology-forums.com/index.php?topic=271134

Question 803
Which of the following is NOT part of the Edit Photo Album dialog box?
A) Contrast
B) Sharpness
C) Rotate
D) Preview
Answer: https://biology-forums.com/index.php?topic=271231

Question 804
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Question 805

M

Unless you specify a style for a document, Word uses the ________ style.
A) Custom
B) Default
C) New
D) Normal
Answer: https://biology-forums.com/index.php?topic=271374

If you ________ a chart on the same sheet as the data source, you need to decide if you want to print the data only, the data and the chart, or the
chart only.
Answer: https://biology-forums.com/index.php?topic=270794

A chart sheet
A) is a label that describes the chart.
B) enables you to adjust the size of the chart.
C) contains a single chart and no spreadsheet data.
D) is a miniature chart contained in a single cell.
Answer: https://biology-forums.com/index.php?topic=270768

YFO

Question 807

R
U

Question 806

How do you retain the original height and width proportion of a clip art object?
A) Click the Lock aspect ratio check box
B) Click the Retain Shape check box
C) Click the Lock Ratio button
D) You can only retain the original height and width manually
Answer: https://biology-forums.com/index.php?topic=271147

G

Question 808

IO

LO

Which of the following would be the best choice for a primary key?
A) First Name
B) Last Name
C) Social Security Number
D) Street Address
Answer: https://biology-forums.com/index.php?topic=270397

Question 809

B

Match the following terms to their descriptions:
I.A print areaA.is a complete set of data for an entity
II.Print orderB.rows and columns of data formatted to enable data
management and analysis
III.A tableC.defines the range of data to print
IV.A fieldD.is the sequence in which pages print
V.A recordE.an individual piece of data, such as a last name
Answer: https://biology-forums.com/index.php?topic=270884

Question 810
What year was Windows 7 available on most new microcomputer systems?
A) 2007
B) 2008
C) 2009
D) 2010
Answer: https://biology-forums.com/index.php?topic=271574

Question 811
Match the following terms with their descriptions:
I.tableA.vertical space in a table
II.cellB.intersection of a column and a row
III.row heightC.horizontal space in a table
IV.column widthD.selects the entire table
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V.Table Move handleE.series of columns and rows
Answer: https://biology-forums.com/index.php?topic=271565

Question 812

Question 813
To sort the order of records in a form, you need to open the form in
A) Tabular View
B) Form View
C) Design View
D) Print Preview
Answer: https://biology-forums.com/index.php?topic=270553

Question 814

YFO

R
U

What happens to the background when you print a slide show in Grayscale?
A) The background prints in shades of gray.
B) The background will only print in black and white, no shades will be included.
C) The background will not print.
D) An error message occurs.
Answer: https://biology-forums.com/index.php?topic=271001

M
S.
C
O

M

The ________ Checker feature in Word 2010 enables you to check if there are features that are not supported by Word 97-2003 versions.
Answer: https://biology-forums.com/index.php?topic=271331

Question 815

Question 816

LO

G

The COUNTBLANK function
A) tallies the number of blank cells in a range.
B) displays the current date and time.
C) displays the current date.
D) tallies the number of cells in a range that are not empty.
Answer: https://biology-forums.com/index.php?topic=270685

IO

Dot ________ are dot characters that display on the left side of a tab and serve to draw the reader's eye across the page to the information at the tab
stop.
Answer: https://biology-forums.com/index.php?topic=271398

B

Question 817

The ________ determines what field values are allowed and what other properties the field will have.
A) identity
B) attribute
C) record type
D) data type
Answer: https://biology-forums.com/index.php?topic=270424

Question 818
Previewing the worksheet in ________ view enables you to adjust print settings.
Answer: https://biology-forums.com/index.php?topic=270861

Question 819
Match the following features of a dialog box to each of their purposes:
I.option buttonA.mutually exclusive choices
II.check boxB.enables the user to enter specific information
III.list boxC.quick method of increasing/decreasing a setting
IV.spin arrowD.used if choices are not mutually exclusive
V.text boxE.displays all or some of the available choices
Answer: https://biology-forums.com/index.php?topic=271661

Question 820
Unless you have intentionally changed the option, most documents you work with will consist of ________ section(s).
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M

A) one
B) two
C) three
D) ten
Answer: https://biology-forums.com/index.php?topic=271289

M
S.
C
O

Question 821
What happens the first time you convert a Word 2003 or earlier file?
A) It will convert the file and change the file extension to .docx.
B) It will convert the file, remove the Compatibility Mode designator, and change the file extension .docx.
C) It will convert the file, remove the Compatibility Mode designator, and retain the file extension to .doc.
D) The Compatibility Mode designator will be retained as will the .doc file extension.
Answer: https://biology-forums.com/index.php?topic=271302

Question 822

YFO

R
U

Which of the following is NOT required of your computer for creating narration for a slide show?
A) Speakers
B) A sound card
C) A microphone
D) A DVD player
Answer: https://biology-forums.com/index.php?topic=271219

Question 823

The Step by Step Mail Merge ________ makes the process of creating a mail merge document easier.
Answer: https://biology-forums.com/index.php?topic=271559

Question 824

IO

Question 825

LO

G

What do kelvin units refer to?
A) The sharpness of an image
B) The degree of contrast of a picture
C) The brightness of a picture
D) The tone or temperature of a color
Answer: https://biology-forums.com/index.php?topic=271199

B

A ________ row appears as the last row of a table to display summary statistics, such as a sum.
Answer: https://biology-forums.com/index.php?topic=270876

Question 826

Foreign language characters can be entered in a document with the ________ command.
A) Symbol
B) Typeface
C) Type style
D) Character style
Answer: https://biology-forums.com/index.php?topic=271387

Question 827
A(n) ________ is a visual plan of a presentation that helps in planning the direction of your presentation.
Answer: https://biology-forums.com/index.php?topic=271011

Question 828
When you need to alter a report’s appearance but do not need to see or edit underlying data, you can use ________ view.
Answer: https://biology-forums.com/index.php?topic=270596

Question 829
Adjusting the ________ lightens and darkens an overall graphic object.
Answer: https://biology-forums.com/index.php?topic=271411
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Question 830

M

A ________ relationship requires a table called a junction table.
Answer: https://biology-forums.com/index.php?topic=270459

Question 831

R
U

Question 832

M
S.
C
O

Match the following terms to their meanings:
I.A chart title A.the value or name of a data point
II.An axis title B.a label that describes either the category axis or the
value axis
III.A data labelC.a label that describes the chart
IV.A gridline D.a line used to depict trends and forecast future data
V.A trendlineE.a line that extends from the horizontal or vertical
axis through the plot area
Answer: https://biology-forums.com/index.php?topic=270814

A(n) ________ is an object, such as an oval or an arrow, inserted onto a slide.
Answer: https://biology-forums.com/index.php?topic=271157

YFO

Question 833

G

All of the following are true in reference to built-in functions EXCEPT:
A) A function produces a result based on variable inputs known as arguments.
B) You can use Expression Builder to find out if a built-in function exists in Access.
C) Built-in functions can only perform calculations on numeric data.
D) Built-in functions work the same in Access as they do in Excel.
Answer: https://biology-forums.com/index.php?topic=270483

Question 834

IO

LO

Which of the following is NOT an example of an Access object?
A) Query
B) Sort
C) Report
D) Table
Answer: https://biology-forums.com/index.php?topic=270323

B

Question 835

A ________ name is a word or string of characters that represent one or more cells.
Answer: https://biology-forums.com/index.php?topic=270729

Question 836
Templates that you have recently used are located in the ________.
A) Sample templates folder
B) Office.com Templates category
C) My Templates folder
D) Home category
Answer: https://biology-forums.com/index.php?topic=271044

Question 837
Match the following terms to their meanings:
I.Active cellA.Numbers that represent a quantity used for calculations
in excel
II.Sheet tabB.A combination of cell references, operators, values,
and/or functions to perform a calculation
III.TextC.Any combination of letters, numbers, symbols
IV.A valueD.Used to switch to another sheet in the workbook
V.FormulaE.The current cell, containing the insertions point
Answer: https://biology-forums.com/index.php?topic=270662
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Question 838

M

The ________ view displays a structural view of a document that can be collapsed or expanded.
Answer: https://biology-forums.com/index.php?topic=271405

The Angle ________ includes background shapes to create the design.
Answer: https://biology-forums.com/index.php?topic=271104

Question 840

Question 841

YFO

Arranging table data from Z to A is _________ order.
Answer: https://biology-forums.com/index.php?topic=271553

R
U

What happens if you are in the last cell of a table and press the Tab key?
A) A new row is created.
B) Nothing. You will remain in that cell.
C) You return to the first cell in the first row.
D) A new column is created and the cursor moves to that new column.
Answer: https://biology-forums.com/index.php?topic=271501

M
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Question 839

Question 842

The ________ is a field or collection of fields whose values uniquely identify each record in a table.
Answer: https://biology-forums.com/index.php?topic=270358

Question 843

B

IO

LO

G

Match the following data management projects to the software best suited to carry out the project. Each answer may be chosen more than once.
I.A restaurant needs to manage a list of vendors,
sales invoices, and inventoryA.Access
II.A college student needs to manage a list of their
monthly expendituresB.Excel
III.An accountant needs to display regional sales figures
in a pie chart
IV.A teacher needs to manage a list of students, their grades,
their major, and their contact information
V. A consultant needs to keep track of his hours worked on a project.
Answer: https://biology-forums.com/index.php?topic=270385

Question 844

A total row appears as the last row of a table to
A) highlight or emphasize cells that meet certain conditions.
B) format cells based upon their value in reference to the value of other cells.
C) tag a table element as a reference in a formula.
D) display summary statistics, such as a sum.
Answer: https://biology-forums.com/index.php?topic=270846

Question 845
When in ________ view, double-click a footnote or endnote reference mark to open the Footnotes or Endnotes pane in order to edit the note.
A) Draft
B) Print Layout
C) Full Screen Reading
D) Outline
Answer: https://biology-forums.com/index.php?topic=271444

Question 846
Jose is working on a database that stores stock information. He needs to design a field that will allow a user to connect to a graph created in Excel.
The data type he should apply to this field is:
A) OLE
B) Number

Page 100 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
C) Text
D) Memo
Answer: https://biology-forums.com/index.php?topic=270399

Question 848

R
U

Which of the following statements is NOT true regarding a Form's design view?
A) Design view is used to make advanced changes to a form
B) You can perform many of the same tasks in Design view as you can in Layout view
C) Changes to the form sections can only be made in Design view
D) Record source data is shown in Design view
Answer: https://biology-forums.com/index.php?topic=270544

M
S.
C
O

The Help and Support home button in the Windows Help and Search function in Windows 7 resembles a(n):
A) book.
B) house.
C) question mark.
D) adult helping a child with a book.
Answer: https://biology-forums.com/index.php?topic=271629

YFO

Question 849

Which of the following are vertical bars that display to specify the line that contains revision marks?
A) Revision marks
B) Changed lines
C) Show Markup
D) Comments
Answer: https://biology-forums.com/index.php?topic=271430

G

Question 850

IO

LO

Each column in a table
A) needs to be converted to a Range
B) represents a record.
C) is a complete set of data for an entity.
D) represents a Field which can contain an individual piece of data for a record.
Answer: https://biology-forums.com/index.php?topic=270826

Question 851

B

Copyrighted work that the owner gives free use to reproduce and duplicate is referred to as ________.
Answer: https://biology-forums.com/index.php?topic=271245

Question 852
Which of the following statements about objects is TRUE in regard to Office 2010?
A) You must download any clip art image you want to use since Office installation does not include clip art.
B) The Clip Art task pane allows you to search for only certain types of images.
C) Clicking the Home tab and the Insert button will allow you to insert objects into a document.
D) Search results cannot be limited to only search for particular types of media.
Answer: https://biology-forums.com/index.php?topic=270924

Question 853
Match the function categories to their descriptions:
I.DatabaseA.Provides information about the contents of a cell.
II.Date & TimeB.Analyzes data stored in a database format Excel and
returns key values.
III.EngineeringC.Provides methods for manipulating date and time
values.
IV.FinancialD.Calculates values used by engineers such as value
conversions.
V.InformationE.Performs financial calculations such as payments,
rates, and present value.
Answer: https://biology-forums.com/index.php?topic=270731
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Question 854
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A data point
A) is a numeric value that describes a single value on a chart.
B) is a group of related data points.
C) displays data comparisons vertically in columns.
D) is text that describes a collection of data points in a chart.
Answer: https://biology-forums.com/index.php?topic=270741

Match the following descriptions to their correct term:
I.a note about the content of a documentA.markup balloon
II.displays comments and changes made
to a documentB.Reviewing Pane
III.inserts revision marks and shows additions,
deletions, and formatting changesC.Revision marks
IV.colored circles that display in the marginsD.Track Changes
V.indicates where text is added, deleted, or formatting
changed in Track ChangesE.comment
Answer: https://biology-forums.com/index.php?topic=271488

YFO

Question 856

R
U

Question 855

G

Access contains ________ that perform routine calculations.
A) Identifiers
B) Built-in Functions
C) Operators
D) Constants
Answer: https://biology-forums.com/index.php?topic=270471

LO

Question 857

B

IO

Match the following terms with their descriptions:
I.BordersA.single, double, triple, wavy
II.ShadingB.position of the table between the left and
right margins
III.Table styleC.similar to the Highlight feature
IV.Table alignmentD.degree of rotation in which text displays
V.Text directionE.contains borders, shading, and other attributes
Answer: https://biology-forums.com/index.php?topic=271566

Question 858

Tables, queries, reports, and forms are all examples of ________.
Answer: https://biology-forums.com/index.php?topic=270365

Question 859
Which of the following is NOT an option from the Add Shape arrow in the Create Graphic group?
A) Add Shape Below
B) Add Shape to the Right
C) Add Shape After
D) Add Shape Above
Answer: https://biology-forums.com/index.php?topic=271136

Question 860
Match the following features with the dialog box where they are accessible:
I.mix hues based on the RGB modelA.Choose a SmartArt Graphic dialog box
II.view the array of gradient optionsB.Grids and Guides dialog box
III.create a Cycle diagramC.Format Picture dialog box
IV.set the Snap to featureD.Format Shape dialog box
V.view more fill texturesE.Colors dialog box
Answer: https://biology-forums.com/index.php?topic=271191
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Question 861
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If you're unable to apply a theme for the background of a photo album, click the _________ tab and select a theme from the gallery.
A) Insert
B) Home
C) Slide Show
D) Design
Answer: https://biology-forums.com/index.php?topic=271226

Question 862

R
U

The form Layout view can be used for all of the following EXCEPT
A) adding or removing a field.
B) changing the order of fields.
C) adding a calculated field.
D) changing the width of a field.
Answer: https://biology-forums.com/index.php?topic=270552

Question 863

YFO

Click the ________ tab to add a video to a slide.
Answer: https://biology-forums.com/index.php?topic=271250

Question 864

G

Referencing the image above, what number represents the section where a comprehensive total value would appear in the report?
A) 1
B) 2
C) 3
D) 4
Answer: https://biology-forums.com/index.php?topic=270574

LO

Question 865

IO

Which of the following feature of a dialog box offers a mutually exclusive choice?
A) Check box
B) Option button
C) List box
D) Text box
Answer: https://biology-forums.com/index.php?topic=271609

B

Question 866

The Table Style ________ group contains check boxes to select format actions.
Answer: https://biology-forums.com/index.php?topic=270870

Question 867
What is a quick, easy way to flip an object?
A) Double-click a side sizing handle
B) Right-click a side sizing handle and select Flip
C) Triple-click the image
D) Drag one of the side sizing handles over the opposite side
Answer: https://biology-forums.com/index.php?topic=271150

Question 868
An ________ area is a range of cells containing values for variables used in formulas.
Answer: https://biology-forums.com/index.php?topic=270638

Question 869
When you paste copied data, Excel displays the Paste Options button
A) in the status bar at the left of the screen.
B) in the next set of nonadjacent ranges.
C) on the toolbar.
D) in the bottom right corner of the pasted data.
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Answer: https://biology-forums.com/index.php?topic=270627

Question 871

M
S.
C
O

Click the ________ tab to continue audio over multiple slides in a presentation.
A) Animations
B) Format
C) Playback
D) Insert
Answer: https://biology-forums.com/index.php?topic=271222

M

Question 870

R
U

If you want to insert a different header or footer midway in a document, you need to insert a ________.
A) hard page break
B) section break
C) hard return
D) second header or footer
Answer: https://biology-forums.com/index.php?topic=271288

Question 872

YFO

Which of the following statements is true about data types and delimiters?
A) Numeric fields require quotation marks as delimiters
B) Text fields require pound signs as delimiters
C) Different data types require different delimiters
D) Different data types use the same delimiters
Answer: https://biology-forums.com/index.php?topic=270428

Question 873

IO

Question 874

LO

G

The ________ feature in PowerPoint 2010 helps you line up shapes and objects.
A) Rotate
B) Align
C) Distribute
D) Guide
Answer: https://biology-forums.com/index.php?topic=271154

B

Appear, Fade, Fly In, and Swivel are all types of:
A) transitions.
B) themes.
C) animations.
D) templates.
Answer: https://biology-forums.com/index.php?topic=270991

Question 875
Which of the following is NOT available as part of the Album Layout section of the Photo Album dialog box?
A) Rotate photos
B) Layout for the album pages
C) Frame shapes
D) Apply a theme
Answer: https://biology-forums.com/index.php?topic=271232

Question 876
Which field property type should be used to enter a predefined value into a field when most of the records will have the same value?
A) Input Mask
B) Default Value
C) Validation Rule
D) Validation Text
Answer: https://biology-forums.com/index.php?topic=270402

Question 877
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Question 878
How do icons appear on the desktop if Auto Arrange icons is selected?
A) Icons are arranged alphabetically across the top of the desktop.
B) Icons are arranged by frequency of use in two columns.
C) Icons are maintained in three rows in alphabetical order.
D) Icons are maintained in straight columns and cannot be moved out of line.
Answer: https://biology-forums.com/index.php?topic=271577

Question 879

M
S.
C
O

When you insert a picture into a placeholder on a slide, all of the following are true EXCEPT:
A) a portion of the photo may be cropped.
B) the picture is centered within the placeholder.
C) the placeholder size automatically adjusts to fit the height and width of the photo.
D) the picture may be automatically adjusted to fit the placeholder.
Answer: https://biology-forums.com/index.php?topic=271196

M
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Question 880

YFO

The two types of special indentation styles are first line and ________.
Answer: https://biology-forums.com/index.php?topic=271402

R
U

The ________ wrapping style permits text to wrap around a graphic frame that surrounds the image.
Answer: https://biology-forums.com/index.php?topic=271408

Question 881

IO

Question 882

LO

G

Jenna is working on a database that stores a company’s invoices. The database includes a Table called Invoices, which has a column called
outBalances that shows all outstanding balances. Jenna’s boss has asked her to design a query that calculates the numerical mean of all outstanding
balances. Which function should Jenna use on the outBalances column to help her complete this task?
A) Avg
B) Sum
C) Count
D) Max
Answer: https://biology-forums.com/index.php?topic=270479

B

If you make a grammatical error in a Word 2010 document, for example, you:
A) should add it to the dictionary so it will not appear again.
B) will be offered an option for correcting the error.
C) will see a red wavy underline indicating the error.
D) will see a blue underline indicating the error.
Answer: https://biology-forums.com/index.php?topic=270927

Question 883
A saved search is displayed in the ________ section of the Computer window.
Answer: https://biology-forums.com/index.php?topic=271655

Question 884
The ________ allows you to quickly and easily copy formatting from one area of a document to another.
Answer: https://biology-forums.com/index.php?topic=270948

Question 885
Which of the following is NOT a handout printing option?
A) One
B) Two
C) Six
D) All
Answer: https://biology-forums.com/index.php?topic=271003

Question 886
________ formatting highlights or emphasizes cells that meet certain conditions.
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Answer: https://biology-forums.com/index.php?topic=270877

Question 887

M
S.
C
O

M

Match the following features or parts of Office 2010 to their description:
I.contextual tabA.easy access to formatting commands
II.Mini toolbarB.contains groups of commands related to a specific,
selected object
III.title barC.set of selections when you click a More button
IV.galleryD.contains information relative to the open file
V.status barE.includes file name and application
Answer: https://biology-forums.com/index.php?topic=270963

Question 888

Question 889

YFO

A chart
A) is a group of related data points.
B) is a visual representation of numerical data.
C) is a numeric value that describes a single value on a chart.
D) is text that describes a collection of data points in a chart.
Answer: https://biology-forums.com/index.php?topic=270740

R
U

After clicking the File tab to open a template, click the ________ button.
Answer: https://biology-forums.com/index.php?topic=271083

Question 890

Question 891

LO

G

The PMT function
A) is the periodic interest rate, such as a monthly interest rate.
B) is the total number of payment periods.
C) is the present value of a loan.
D) calculates the periodic payment for a loan with a fixed interest rate and fixed term.
Answer: https://biology-forums.com/index.php?topic=270699

B

IO

Which of the following is FALSE about the video editing tools in PowerPoint?
A) If you use the Start and End markers for timing, you view the video as you make changes.
B) Videos can be faded in and faded out.
C) Videos can be muted.
D) Videos can only be started with a click of the mouse.
Answer: https://biology-forums.com/index.php?topic=271214

Question 892
Before creating a sparkline, identify what ________ you want to depict and where you want to place it.
Answer: https://biology-forums.com/index.php?topic=270795

Question 893
In addition to selecting an entire entry field to delete from a table of authorities, what also must be selected?
A) The braces { }
B) The brackets [ ]
C) The parenthesis ( )
D) The quotations marks " "
Answer: https://biology-forums.com/index.php?topic=271458

Question 894
Match the following shortcut actions to the selection in Word or PowerPoint:
I.Double-clickA.a sentence
II.Triple-clickB.a paragraph
III.Press and hold Ctrl while you click to selectC.one character
to the right
IV.Press and hold Shift while you press the right
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arrow keyD.entire document
V.Press and hold Ctrl while you press the letter AE.a word
Answer: https://biology-forums.com/index.php?topic=270960

M

Question 895

M
S.
C
O

Excel displays a green arrow in the top left corner of a cell if it detects a
A) cell reference or a value.
B) rule that governs components of functions.
C) potential error.
D) predefined formula that performs a calculation.
Answer: https://biology-forums.com/index.php?topic=270676

Question 896

________ changes the appearance of a field containing a date without affecting the data the field contains.
Answer: https://biology-forums.com/index.php?topic=270513

R
U

Question 897

As in other Microsoft Office programs, the Cut, Copy, and Paste commands are on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271087

YFO

Question 898

G

To remove duplicate records (rows),
A) select any cell in the table, then click Remove Duplicates from the Tools group on the Table Tools Design tab.
B) click the Remove tab and then Duplicate in the Records group.
C) click in a cell and on the Home tab, click the Remove arrow in the Cells group.
D) convert it to a Range.
Answer: https://biology-forums.com/index.php?topic=270832

Question 899

Question 900

LO

The ________ bar displays the contents of the active cell.
Answer: https://biology-forums.com/index.php?topic=270642

B

IO

Horizontal Alignment (as it applies to Excel)
A) refers to the up-down position of contents in a cell.
B) removes the vertical lines running through the data.
C) puts a line horizontally through the data.
D) refers to the left-right position of contents in a cell.
Answer: https://biology-forums.com/index.php?topic=270629

Question 901
Match the following terms with their descriptions:
I.filterA.also known as the source or starting document
II.database tableB.contains individual pieces of data
III.main documentC.steps which ask questions to make the process easier
IV.wizardD.specifies criteria for including records in a merge
V.data sourceE.collection of related records that contain fields
Answer: https://biology-forums.com/index.php?topic=271570

Question 902
Which of the following is implemented at the section level in a document?
A) Tabs
B) Page numbering
C) Line spacing
D) Indents
Answer: https://biology-forums.com/index.php?topic=271369

Question 903
Access differs from other Microsoft software because it:
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M

A) works primarily from memory.
B) works primarily from storage.
C) does not save your work as soon as changes are made.
D) does not allow more than one user to work on a file at a time.
Answer: https://biology-forums.com/index.php?topic=270322

M
S.
C
O

Question 904

A(n) ________ copy of a file or folder should be copied to another drive in case the original drive is damaged or the data is lost for some reason.
Answer: https://biology-forums.com/index.php?topic=270936

To insert the current date into an active cell use
A) F4.
B) Ctrl + Alt + Delete.
C) The Ctrl + D key combination.
D) The Ctrl and semicolon key combination.
Answer: https://biology-forums.com/index.php?topic=270614

Question 906

R
U

Question 905

YFO

In regard to spelling and grammar in Office 2010, it is important to know that, in general,:
A) you turn on the Spelling and Grammar features in all applications.
B) only a small selection of words will be checked as you type; the rest must be accessed through the Spelling and Grammar features.
C) all Office applications check your spelling and grammar as you type.
D) Word and PowerPoint check spelling and grammar as you type; Access and Excel do not.
Answer: https://biology-forums.com/index.php?topic=270926

Question 907

LO

Question 908

G

Variables that are needed to produce the output for a function in a calculated field are called ________.
Answer: https://biology-forums.com/index.php?topic=270504

B

IO

Which of the following is TRUE about a pinned program?
A) It becomes a permanent selection on the right side of the taskbar.
B) A pinned program always shows in the Notification area.
C) A program can be pinned to either the Start menu, the taskbar, or both.
D) You can pin a program directly from the taskbar to the Start menu.
Answer: https://biology-forums.com/index.php?topic=271578

Question 909

A column chart
A) displays data comparisons vertically in columns.
B) is a horizontal line that borders the plot area to provide a frame of reference for measurement.
C) contains graphical representation of values in data series.
D) contains the entire chart and all of its elements.
Answer: https://biology-forums.com/index.php?topic=270744

Question 910
Microsoft ________ is most appropriate to use to create memo for use in a business.
A) Word
B) Excel
C) PowerPoint
D) Access
Answer: https://biology-forums.com/index.php?topic=270902

Question 911
Showing white space between pages while in Print Layout view is a function of the ________ menu category in Word Options.
A) General
B) Proofing
C) Advanced
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D) Display
Answer: https://biology-forums.com/index.php?topic=271285

All revisions in a Word document fall into one of two categories: ________ and deletions.
Answer: https://biology-forums.com/index.php?topic=271472

M
S.
C
O

Question 913

M

Question 912

A(n) ________ is a note or annotation that someone writes and includes about the content of an existing document.
Answer: https://biology-forums.com/index.php?topic=271464

Question 914

R
U

The ________ key can be used to move the insertion point from one cell of a table to the next.
A) Insert
B) Tab
C) F2
D) Enter
Answer: https://biology-forums.com/index.php?topic=270987

Question 915

YFO

Of the following, only a ________ cannot be added as a favorite in Windows Explorer.
A) library
B) folder
C) search
D) file
Answer: https://biology-forums.com/index.php?topic=270894

G

Question 916

IO

LO

________ can most accurately be described as the command center of Office 2010.
A) The status bar
B) The Quick Access Toolbar
C) Backstage
D) The Ribbon
Answer: https://biology-forums.com/index.php?topic=270905

Question 917

B

Which of the following statements is FALSE about the status bar in Office 2010?
A) The status bar is located at the bottom of the Office 2010 window.
B) Contents viewable on the status bar are standard in all Office applications.
C) Slide number and total slide information is displayed in PowerPoint.
D) Summary information is displayed in Excel.
Answer: https://biology-forums.com/index.php?topic=270907

Question 918
All of the following are arguments of the built-in PMT function EXCEPT:
A) Rate
B) Present value
C) Future value
D) Loan payment
Answer: https://biology-forums.com/index.php?topic=270464

Question 919
The two ways of displaying revisions by reviewers are ________ showing Markup or as ________ Showing Markup.
A) First; Revised
B) New; Last
C) Original; Revised
D) Original; Final
Answer: https://biology-forums.com/index.php?topic=271434
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Question 920

M
S.
C
O

M

Rich is working on a database that stores a list of vendors and price quotes for a remodeling project. If Rich wanted to create a query to find the least
expensive price quote, he should use the ________ function on the column containing the price quotes.
A) Avg
B) Min
C) Max
D) Count
Answer: https://biology-forums.com/index.php?topic=270480

Question 921

R
U

The Text pane of a SmartArt diagram is most similar to a(n):
A) outline.
B) text box.
C) Word document.
D) shape.
Answer: https://biology-forums.com/index.php?topic=271135

Question 922

YFO

The ________ toolbar provides a quick way to format text in Office 2010.
Answer: https://biology-forums.com/index.php?topic=270944

Question 923

Question 924

LO

G

Match the PowerPoint 2010 feature to its description:
I.Snap toA.create a diagram which includes text
II.AlignB.create numerous styles of arrows using points,
circles, and diamonds
III.SmartArtC.forces an object to align with the grid
IV.Shape OutlineD.change any shape to a different shape
V.Edit ShapeE.line up shapes and objects
Answer: https://biology-forums.com/index.php?topic=271189

B

IO

Filtering the Date column (field)to show only records older than January 2001 is an application of
A) a Number Filter.
B) a Date Filter.
C) use of a table element as a formula.
D) a Text Filter.
Answer: https://biology-forums.com/index.php?topic=270843

Question 925
Match each function with the value it returns:
I.IIfA.Returns the current system date
II.DatePartB.Returns a specified portion of a date
III.DateDiffC.Returns a monthly loan payment
IV.DateD.Returns one value when a condition is true and another value
when a condition false
V.PMTE.Returns the amount of time elapsed between two dates
Answer: https://biology-forums.com/index.php?topic=270534

Question 926
A(n) ________ holds content, such as a title, subtitle, or an image.
Answer: https://biology-forums.com/index.php?topic=271014

Question 927
Which of the following is TRUE about a data source file in the final steps of the merge process?
A) A data source can be used only one time.
B) A data source can be filtered prior to merging.
C) A one page list can be generated from a data source with the Envelopes command.
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D) A data source file cannot be used to create multiple sets of form documents.
Answer: https://biology-forums.com/index.php?topic=271535

M
S.
C
O

After inserting a table in a document, what two contextual tabs appear when the table is selected?
A) Page Layout and Table Layout
B) Table Tools and Table Layout
C) Table Tools Design and Table Tools Layout
D) Table Design and Table Layout
Answer: https://biology-forums.com/index.php?topic=271498

Question 930

YFO

What key can be pressed to constrain a shape?
A) Ctrl
B) Shift
C) Tab
D) Alt
Answer: https://biology-forums.com/index.php?topic=271123

R
U

Question 929
How does watermark text usually display in a document?
A) As very light, washed-out text
B) In the footer or header
C) As bright, bolded text
D) As text around the perimeter of the document
Answer: https://biology-forums.com/index.php?topic=271296

M

Question 928

G

Question 931

IO

LO

An area chart
A) shows the high, low, and close prices for individual stocks over time.
B) trends using two dimensions on a continuous curve.
C) emphasizes magnitude of changes over time by filling in the space between lines with a color.
D) shows a relationship between two variables.
Answer: https://biology-forums.com/index.php?topic=270762

Question 932

B

Jim is working in a database that contains inventory for an electronics wholesaler. He wants to create a form that will enable him to view many records
at one time in the form. He can use a Datasheet or a(n) ________ form for this purpose.
Answer: https://biology-forums.com/index.php?topic=270598

Question 933
________ orientation is a page displayed or printed that is wider than it is tall.
Answer: https://biology-forums.com/index.php?topic=270955

Question 934
The category axis
A) compares two or more sets of data in one chart.
B) compares values for one set of data.
C) displays descriptive group names or labels, such as college names or cities, to identify data.
D) displays incremental values to identify the values of the data series.
Answer: https://biology-forums.com/index.php?topic=270749

Question 935
________ enables a user to continuously type without pressing Enter at the end of lines in a document.
Answer: https://biology-forums.com/index.php?topic=271314

Question 936
In Excel 2010, Dataset
A) indicates where data starts on a new printed page.
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Question 937

M
S.
C
O

An axis title
A) is a line used to depict trends and forecast future data.
B) is the value or name of a data point.
C) is a label that describes either the category axis or the value axis.
D) is a horizontal or vertical line that extends from the horizontal or vertical axis through the plot area.
Answer: https://biology-forums.com/index.php?topic=270776

Question 938

R
U

A2+A3 is not a formula because the ________ sign is missing.
Answer: https://biology-forums.com/index.php?topic=270655

Question 939

YFO

According to the order of operations, expressions in ________ are calculated first.
Answer: https://biology-forums.com/index.php?topic=270520

Question 940

G

What do you use to preview more than one page at a time prior to printing?
A) Click the number of pages you want to preview under the Settings area
B) Click the number of pages you want to preview
C) Click Home tab, click Print Preview, and choose the number of pages to preview
D) Use the zoom slider or Zoom to Page setting
Answer: https://biology-forums.com/index.php?topic=271306

LO

Question 941

In design, empty space on a slide is known as ________ space.
Answer: https://biology-forums.com/index.php?topic=271097

IO

Question 942

M

B) is a collection of structured, related data in columns and rows.
C) is freezing rows to keep them visible.
D) is freezing panes to keep them visible.
Answer: https://biology-forums.com/index.php?topic=270816

B

The ________ is the number of payments over the life of a loan.
Answer: https://biology-forums.com/index.php?topic=270727

Question 943

Column width
A) is adjustable so you can display more or less characters in a column.
B) is not adjustable so keep the formulas as short as possible.
C) always switches back to default.
D) is best left unchanged unless you absolutely have to.
Answer: https://biology-forums.com/index.php?topic=270619

Question 944
When you select a Sample template option, what templates are you looking at?
A) Templates created by Microsoft and located at the Microsoft Online.com Web site
B) Templates created by a member of the Microsoft community
C) Templates installed with PowerPoint 2010
D) Templates created by a Microsoft partner on the Microsoft Online.com Web site
Answer: https://biology-forums.com/index.php?topic=271043

Question 945
Which of the following is NOT a type of section break in Word 2010?
A) Last Page
B) Even Page
C) Continuous
D) Next Page
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Answer: https://biology-forums.com/index.php?topic=271291

Question 946

M
S.
C
O

M

If you need to sort the records contained in a report, you can do so from either the design view or the ________ of the report.
A) Design View
B) Layout View
C) Print preview
D) Report view
Answer: https://biology-forums.com/index.php?topic=270556

Question 947

R
U

A range name
A) Indicates a cell's specific location and the reference does not change when you copy the formula.
B) is a word or a string of characters that represent one or more cells.
C) indicates a cells relative location from the cell containing the formula.
D) creates an Equals (=) sign.
Answer: https://biology-forums.com/index.php?topic=270703

Question 948

YFO

The ________ function evaluates a condition and displays different values for true and false conditions.
Answer: https://biology-forums.com/index.php?topic=270505

Question 949

LO

Question 950

G

The ________ field property changes how a field will appear when displayed or printed, but does not change the values stored in the field.
A) Input Mask
B) Caption
C) Default Value
D) Format
Answer: https://biology-forums.com/index.php?topic=270400

To accept all changes in a document at once, click the ________ arrow on the Review tab.
Answer: https://biology-forums.com/index.php?topic=271469

IO

Question 951

B

The Increase List Level and decrease List Level is located on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271086

Question 952

A field, or a combination of fields, that has a unique value is a:
A) primary key/
B) foreign key/
C) table/
D) field value/
Answer: https://biology-forums.com/index.php?topic=270317

Question 953
A ________ control, like a text box, is linked to data sources while a ________ control, like a label, is used to describe data and create aesthetically
pleasing forms.
A) bound, unbound
B) unbound, bound
C) calculated, bound
D) bound, calculated
Answer: https://biology-forums.com/index.php?topic=270549

Question 954
The order of precedence (as it applies to math operations in Excel)
A) includes letters, numbers, and spaces.
B) controls the sequence in which Excel performs arithmetic operations.
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C) is a software application used to create and modify business communications.
D) includes formulas, functions, and formatting.
Answer: https://biology-forums.com/index.php?topic=270616

Question 956

Question 957

YFO

A(n) ________ only displays records that match selected criteria.
Answer: https://biology-forums.com/index.php?topic=270378

R
U

Match the following terms to their descriptions:
I.compressionA.reduces data files in the amount of space required for storage
II.cropB.store an object from an external source within a presentation
III.codecC.eliminating unwanted portions of an image
IV.embedD.a connection from a presentation to another location
V.linkE.digital video compression scheme used to compress and
decompress video
Answer: https://biology-forums.com/index.php?topic=271271

M
S.
C
O

The ________ feature in Word 2010 monitors all additions, deletions, and formatting changes a user makes.
Answer: https://biology-forums.com/index.php?topic=271467

M

Question 955

Question 958

LO

Question 959

G

The Table Array
A) is the argument in a VLOOKUP function that identifies from which column to return a value.
B) looks up a value in a horizontal table where the first row contains the values to compare with the lookup value.
C) calculates the periodic payment for a loan with a fixed interest rate and fixed term.
D) is a range containing a lookup table.
Answer: https://biology-forums.com/index.php?topic=270696

A ________ is a horizontal or vertical line that extends from the horizontal or vertical axis through the plot area.
Answer: https://biology-forums.com/index.php?topic=270802

IO

Question 960

B

A form can be customized to add additional functionality using, ________, Microsoft's programming language that is built into all of the Office products.
Answer: https://biology-forums.com/index.php?topic=270600

Question 961

Match the following graphic file format descriptions with their file format type:
I.Windows 16-bit file formatA.Tagged Image File Format
II.best file format for storing bitmapped images
on PCs but not widely supported by browsersB.Microsoft Windows
Metafile
III.Windows 32-bit file formatC.Joint Photographic Experts
Group
IV.limited to 256 colors; good for
black-and-white imagesD.Graphics Interchange Format
V.supports 16 million colors; optimized
for photographsE.Windows Enhanced Metafile
Answer: https://biology-forums.com/index.php?topic=271263

Question 962
What is the order for including a bibliography within your document?
A) Click Insert Bibliography, then add the sources using Insert Citation
B) Add the sources using Insert Footnote or Insert Endnote, then click Insert Bibliography
C) Add the sources using the Insert Citation feature, click Bibliography, then click Insert Bibliography
D) Click Bibliography, click Insert Bibliography, then add the sources with Insert Citation
Answer: https://biology-forums.com/index.php?topic=271439
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Question 964

R
U

The collapsed outline view displays all of the following except ______.
A) Slide number
B) Slide icon
C) Title of slide
D) Content of slide
Answer: https://biology-forums.com/index.php?topic=271052

M
S.
C
O

Which of the following is FALSE about the Highlighter feature in Word 2010?
A) To remove highlights, select the highlighted text and click Remove Color.
B) It can be accessed on the Mini toolbar.
C) It can be accessed in the Font group on the Home tab.
D) The button can be selected prior to selecting the text.
Answer: https://biology-forums.com/index.php?topic=271356

M

Question 963

Question 965

YFO

To change the ________ representation on the axes and gridlines, click Axes in the Axes group, and then point to Primary Vertical Axis.
Answer: https://biology-forums.com/index.php?topic=270801

Question 966

SUM and COUNT are examples of ________ functions that perform calculations on entire columns of data.
Answer: https://biology-forums.com/index.php?topic=270516

Question 967

LO

Question 968

G

A(n) ________ is text or a graphic displayed behind text in a document.
Answer: https://biology-forums.com/index.php?topic=271327

B

IO

Which of the following Mail Merge Commands from the Mailings tab opens the Mail Merge Recipients dialog box in order to sort records?
A) Edit Recipient List
B) Select Recipients
C) Start Mail Merge
D) Rules
Answer: https://biology-forums.com/index.php?topic=271537

Question 969

Which of the following is FALSE about headers and footers in Word 2010?
A) They can contain fields.
B) A document cannot display both a header and footer.
C) A document may display a header but not a footer as well as vice versa.
D) When you edit header or footer text, it is automatically changed on all pages.
Answer: https://biology-forums.com/index.php?topic=271286

Question 970
Which of the following features is NOT part of the features available from the Corrections button in the Adjust group?
A) Adjust brightness
B) Adjust contrast
C) Remove the background
D) Soften
Answer: https://biology-forums.com/index.php?topic=271201

Question 971
Using Conditional Formatting to draw attention to cells that are blank
A) displays a particular color based on the relative value of the cell contents to other selected cells.
B) displays an icon representing a value in the top third, quarter, or fifth based on values in the selected range.
C) helps locate where data may be missing.
D) helps locate errors in cells quickly.
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Answer: https://biology-forums.com/index.php?topic=270855

Question 972

Question 973

R
U

If your report has a ________ section, it precedes the first Page Header section.
A) Access Header
B) Group Header
C) Detail Header
D) Report Header
Answer: https://biology-forums.com/index.php?topic=270566

M
S.
C
O

M

Fill Color (as it applies to Excel)
A) is handled automatically depending upon the contents of the cell.
B) is not adjustable.
C) is black by default.
D) is the background color of a cell.
Answer: https://biology-forums.com/index.php?topic=270633

Question 974

YFO

If a user selects the ________ option while creating a relationship, Access will automatically modify all foreign key values in a related table to match
any modifications made to the primary key.
Answer: https://biology-forums.com/index.php?topic=270457

Question 975

Question 976

LO

G

Each row in an Excel table
A) is an individual piece of data, such as a last name.
B) is the sequence in which pages print.
C) represents a Field which can contain an individual piece of data for a record.
D) represents a record.
Answer: https://biology-forums.com/index.php?topic=270828

IO

The Project Status Report Sample and contemporary photo Album Sample are examples of ________ in PowerPoint 2010.
Answer: https://biology-forums.com/index.php?topic=271081

Question 977

B

The slide ________ determines the location and presence or absence of objects contained on a slide.
Answer: https://biology-forums.com/index.php?topic=271013

Question 978

A key or feature that can be turned on or off is known as a(n) ________ command.
Answer: https://biology-forums.com/index.php?topic=270946

Question 979
Denim, marble, and cork are examples of _________ fills.
A) freeform
B) picture
C) gradient
D) texture
Answer: https://biology-forums.com/index.php?topic=271127

Question 980
Which of the following is NOT a feature on the Picture Tools Format tab?
A) Remove the background of a picture
B) Create picture background
C) Picture correction
D) Picture contrast
Answer: https://biology-forums.com/index.php?topic=271198
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Question 982
You can ________ a database in order to protect your data against loss or damage.
Answer: https://biology-forums.com/index.php?topic=270361

Question 983

R
U

The ________ key on the keyboard accesses Help in Office 2010.
Answer: https://biology-forums.com/index.php?topic=270941

Question 984

YFO

A ________ is a marker that divides a document into different segments or parts.
Answer: https://biology-forums.com/index.php?topic=271326

Question 985

LO

G

A document that contains a list of captions is referred to as a:
A) caption table.
B) table of authorities.
C) table of figures.
D) cross-reference list.
Answer: https://biology-forums.com/index.php?topic=271456

Question 986

A group of related tables is called a(n) ________ database.
Answer: https://biology-forums.com/index.php?topic=270364

IO

Question 987

M
S.
C
O

Which of the following Windows 7 features asks for permission before allowing changes to your system settings?
A) Action Center
B) UAC
C) Windows Updates
D) Windows firewall
Answer: https://biology-forums.com/index.php?topic=271621

B

To return to a document from the Backstage view, click the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271337

Question 988

If you click the button for Header row in the Sort dialog box, what happens?
A) The Header row will be included in the sort
B) The header row names appear in the Sort by list
C) The header row numbers appear in the Sort by list
D) The Header row will automatically be changed to numbers
Answer: https://biology-forums.com/index.php?topic=271518

Question 989
Match the following Windows 7 programs or features to their descriptions:
I.SnapA.automatically places a window on the
side of the desktop
II.Aero Flip 3DB.invite someone to help with a computer issue
III.Remote AssistanceC.arranges all open windows in a stack
IV.Search boxD.use to record to-do lists, phone numbers, or
other info
V.Sticky NotesE.locate files, folder, programs or e-mail messages
Answer: https://biology-forums.com/index.php?topic=271666

Question 990
Match the scenario with the Word 2010 feature:
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M
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I.discover hidden content in a fileA.Document Inspector
II.discover file features that are supported by
Word 97-2003B.Compatibility Checker
III.check out the print previewC.Document Panel
IV. add a keywordD.AutoRecover
V.recover an unsaved fileE.Backstage view
Answer: https://biology-forums.com/index.php?topic=271345

Question 991

A(n) ________ is a single characteristic or attribute of a person, place, object, event, or idea contained in a database.
Answer: https://biology-forums.com/index.php?topic=270360

Question 992

In addition to sorting and filtering cells by content you can sort and/or filter by ________ formatting.
Answer: https://biology-forums.com/index.php?topic=270882

R
U

Question 993

In field names, object names, and filenames, uppercase letters are used to distinguish the first letter of a new word in ________ notation.
Answer: https://biology-forums.com/index.php?topic=270449

YFO

Question 994

G

When you hover the mouse over any cell of a table, what displays?
A) A dark, bolded outline of the table
B) A ScreenTip
C) The Table Move handle
D) Table Sizing handles
Answer: https://biology-forums.com/index.php?topic=271500

Question 995

Question 996

LO

A ________ relationship consists of a primary key value in a primary table many foreign key values in a related table.
Answer: https://biology-forums.com/index.php?topic=270438

B

IO

Match the following nonprinting symbol description with how it is created:
I.nonbreaking spaceA.press Enter
II.line breakB.press Shift+Enter
III.end of paragraphC.press Ctrl+Shift+Spacebar
IV.regular hyphenD.press Ctrl+Shift+Hyphen
V.nonbreaking hyphenE.press Hyphen
Answer: https://biology-forums.com/index.php?topic=271418

Question 997
The ________ is the Present Value of a loan or in other words; how much was borrowed.
Answer: https://biology-forums.com/index.php?topic=270728

Question 998
Match the following Windows 7 features to their descriptions:
I.tagA.custom file property
II.propertyB.screen display that contains icons and a taskbar
III.iconC.identifier of a file
IV.shortcutD.small picture on the desktop
V.desktopE.point to a program or computer resource
Answer: https://biology-forums.com/index.php?topic=271668

Question 999
________ is spoken commentary that can accompany a PowerPoint presentation.
Answer: https://biology-forums.com/index.php?topic=271253
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Question 1001

R
U

A(n) ________ is a descriptive title for a figure, a table, or an equation.
Answer: https://biology-forums.com/index.php?topic=271484

M
S.
C
O

Match the date/time function syntax to their descriptions:
I.=TODAY()A.Returns the serial number for a date
II.=NOW()B.Displays today's date: moth, day, year
III.=DATE(year,month)C.Displays the day within a month for a serial
number of months from a serial number
representing a date
IV.=EDATE(start,_date,months)D.Displays the serial number of a date a specified
number of months in the future or past
V.=DAY(serial_number)E.Displays today's date and current military time
Answer: https://biology-forums.com/index.php?topic=270736

M

Question 1000

Question 1002

YFO

Syntax can most accurately be defined as the ________.
A) names of fields, controls, or properties.
B) formulas used to calculate new fields from the values in existing fields.
C) arithmetic instructions such as * , / , + , or — .
D) set of language rules that Access follows when evaluating expressions.
Answer: https://biology-forums.com/index.php?topic=270472

Question 1003

G

Access stores dates as the number of ________ that have elapsed since the date of December 1st, 1899.
Answer: https://biology-forums.com/index.php?topic=270522

LO

Question 1004

IO

Which of the following is FALSE about styles?
A) Styles use the Format Painter to copy formats from one location in a document to another.
B) When you change the style, you automatically change all text defined by that style.
C) You can apply a style to any element within a document.
D) Styles automate the formatting process.
Answer: https://biology-forums.com/index.php?topic=271371

B

Question 1005

Each individual piece of data in a recipient list is known as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271561

Question 1006
Irene is working on a database that stores customer data and order information. The Customer Information Table holds customer information. A
unique customer number serves as the primary key for this table. The Order Information Table holds order information. A unique order number serves
as the primary key for this table. A customer only has one customer number but may have several order numbers. If Irene wants to establish a
one-to-many relationship between the customer information table and the order information table, which of the following steps should she follow?
A) Irene should include the primary key in the customer information table as a foreign key in the order information table.
B) Irene should include the foreign key in the customer information table as a primary key in the order information table.
C) Irene should include the primary key in the customer information table as a primary key in the order information table.
D) Irene cannot establish a relationship between the two tables.
Answer: https://biology-forums.com/index.php?topic=270394

Question 1007
Match the following examples with the best type of SmartArt design category:
I.proportional relationship--an ecology chartA.Pyramid
II.steps to buy a computerB.Process
III.connections among winter snow activities C.Hierarchy
IV.items to take care of for a new semesterD.List
V.business organization chartE.Relationship
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Answer: https://biology-forums.com/index.php?topic=271185

Question 1008

M
S.
C
O

M

Referencing the image above, what number represents the section where data from a record source would appear in the report?
A) 2
B) 3
C) 4
D) 5
Answer: https://biology-forums.com/index.php?topic=270571

YFO

Match the following descriptions to their correct term:
I.monitors additions, deletions, and formatting
changes in a documentA.Revision marks
II.shows a line through deleted text and inserted
text in a balloonB.Changed lines
III.display where text in a document has been added,
deleted or formattedC.Track Changes
IV.vertical bars in the margins that show where items
have been changedD.Original: Show Markup
V.shows inserted text in the body and deleted text
in a balloonE.Final: Show Markup
Answer: https://biology-forums.com/index.php?topic=271489

R
U

Question 1009

Question 1010

A ________ relationship exists when records in two different tables are related by the same primary key.
Answer: https://biology-forums.com/index.php?topic=270458

G

Question 1011

IO

LO

A Word feature which is a step beyond using the Format Painter to achieve uniformity is:
A) character styles.
B) kerning.
C) type styles.
D) styles.
Answer: https://biology-forums.com/index.php?topic=271370

Question 1012

B

To Freeze Columns and/or rows
A) first indicate where data starts on a new printed page.
B) use the View Tab, Window Group, and click Freeze Panes.
C) scroll through a worksheet and click on the Freeze button.
D) adjust settings to control how the worksheet will print.
Answer: https://biology-forums.com/index.php?topic=270818

Question 1013
A workbook is defined as
A) similar to a spreadsheet but bound rather than electronic.
B) an un-editable "picture" of data.
C) the address of the current cell.
D) a file containing related worksheets.
Answer: https://biology-forums.com/index.php?topic=270608

Question 1014
The small dots that surround an object appearing at each corner and in the middle of each side are known as ________.
A) sliders
B) buttons
C) handles
D) toggles
Answer: https://biology-forums.com/index.php?topic=270923
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Question 1015

M

________ is any combination of letters, numbers, etc NOT used for calculations.
Answer: https://biology-forums.com/index.php?topic=270649

The smallest data element in an Access database is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270371

Question 1017

Question 1018

YFO

Each object you place on a form is called a(n) ________.
A) index
B) label
C) icon
D) control
Answer: https://biology-forums.com/index.php?topic=270561

R
U

When you first open Word 2010, what are you presented with?
A) The Open dialog box ready to access a previously-created file
B) The Save dialog box to save a new file
C) A new blank work area
D) A pane to open a file
Answer: https://biology-forums.com/index.php?topic=270911

M
S.
C
O

Question 1016

Question 1019

IO

Question 1020

LO

G

The value in a field with the ________ data type will be automatically increased each time a new record is entered.
A) Currency
B) Date/Time
C) Number
D) AutoNumber
Answer: https://biology-forums.com/index.php?topic=270411

B

How do you edit footnotes or endnotes while in Draft view?
A) Edit footnotes and endnotes in the Footnotes or Endnotes pane
B) Click the footnote or endnote and edit it
C) Click in the balloon and edit them
D) Double-click to open the Track Changes view and edit
Answer: https://biology-forums.com/index.php?topic=271442

Question 1021
Two or more tables which contain duplicate data is an example of ________.
A) one-to-many relationships
B) data redundancy
C) many-to-many relationships
D) data backup
Answer: https://biology-forums.com/index.php?topic=270427

Question 1022
=A2+A3 is a (better or worse) ________ formula than =10+2 because of flexibility.
Answer: https://biology-forums.com/index.php?topic=270657

Question 1023
An area of member reserved to temporarily hold selections that have been cut or copied from a document is known as the ________.
Answer: https://biology-forums.com/index.php?topic=270947

Question 1024
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How do you insert a regular tab character within a cell?
A) Shift+Tab
B) F12
C) Ctrl+Tab
D) Ctrl+left arrow
Answer: https://biology-forums.com/index.php?topic=271503

Question 1026

R
U

Two common command buttons in many dialog boxes include OK and ________.
Answer: https://biology-forums.com/index.php?topic=271639

M
S.
C
O

Question 1025

M

A mixed cell reference
A) occurs when a formula directly or indirectly refers to the cell containing the formula.
B) causes a potential error.
C) contains absolute or relative cell references, but not both.
D) contains both an absolute and a relative cell reference.
Answer: https://biology-forums.com/index.php?topic=270674

Question 1027

YFO

Filtering the Cost column (field) to show only records Greater than $10,000 is an application of
A) a Date Filter.
B) a Text Filter.
C) use of a table element as a formula.
D) a Number Filter.
Answer: https://biology-forums.com/index.php?topic=270844

G

Question 1028

IO

LO

How does an adjustment handle display when a shape is selected?
A) Just like a sizing handles but larger and bolder
B) As a green circle located at the top of the selected shape
C) As a yellow diamond
D) As a large blue diamond
Answer: https://biology-forums.com/index.php?topic=271122

Question 1029

B

The ________ Pane displays comments and changes made to a document.
Answer: https://biology-forums.com/index.php?topic=271465

Question 1030
________ is a basic word processing program that includes formatting and graphic capability and is a part of Windows 7.
Answer: https://biology-forums.com/index.php?topic=271645

Question 1031
The ________ stores descriptive information about a file and author that you may want to keep but do not want to show up in the text of the document.
Answer: https://biology-forums.com/index.php?topic=271334

Question 1032
The data type "Text" (as it applies to Excel)
A) should be entered into every cell of the spreadsheet.
B) includes letters, numbers, and spaces not used in calculations.
C) includes formulas, functions, and formatting.
D) is of little concern to Excel because Excel does calculations on numbers.
Answer: https://biology-forums.com/index.php?topic=270610

Question 1033
An unchanging value is called a(n) ________.
Answer: https://biology-forums.com/index.php?topic=270451
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Question 1034

M
S.
C
O

M

Which of the following is NOT an activity within Windows Explorer?
A) Manage folders
B) Work with libraries
C) Create a document
D) View favorites
Answer: https://biology-forums.com/index.php?topic=270893

Question 1035

A(n) ________ typeface allocates space for each character based on the width of the character.
Answer: https://biology-forums.com/index.php?topic=271389

Question 1036

R
U

The default text direction is ________ position.
Answer: https://biology-forums.com/index.php?topic=271547

Question 1037

YFO

________ controls in a form are created from a text box control and contain an expression that generates a computed result when displayed.
Answer: https://biology-forums.com/index.php?topic=270590

Question 1038

For Excel to recognize a formula, it must begin with an ________ sign.
Answer: https://biology-forums.com/index.php?topic=270654

Question 1039

IO

Question 1040

LO

G

Which of the following typically appears at the end of a document?
A) A table of authorities
B) A table of contents
C) An index
D) A cross-reference
Answer: https://biology-forums.com/index.php?topic=271449

B

All the following statements are true regarding functions arguments EXCEPT:
A) An argument can be a variable
B) An argument can be a constant
C) An argument can be the value of a field
D) An argument can be the value of a label
Answer: https://biology-forums.com/index.php?topic=270490

Question 1041
The Chart Layouts group enables you to apply ________ layouts to a chart.
Answer: https://biology-forums.com/index.php?topic=270789

Question 1042
Which of the following views does NOT display comments in markup balloons?
A) Print Layout
B) Full Screen Reading
C) Draft
D) Web Layout
Answer: https://biology-forums.com/index.php?topic=271425

Question 1043
In the table pictured above, the last row of data shown ( 2734, Riker, William, 212-566-1701.) is a:
A) form.
B) field.
C) key.
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D) record.
Answer: https://biology-forums.com/index.php?topic=270331

Question 1044

M
S.
C
O

Question 1045

M

Preview the chart in ________ view before you print to ensure a balanced printout.
Answer: https://biology-forums.com/index.php?topic=270793

"Works Cited" or "References" are terms used by some reference manuals for a (n) ________, a list of works cited or consulted by an author.
Answer: https://biology-forums.com/index.php?topic=271476

What is a gradient fill a blend of?
A) Two or more colors
B) Two or more images
C) Only two shapes merged together
D) Two or more Quick Styles
Answer: https://biology-forums.com/index.php?topic=271125

Question 1047

R
U

Question 1046

YFO

Text that you enter into a SmartArt diagram can be entered in a(n) ________ pane.
Answer: https://biology-forums.com/index.php?topic=271169

Question 1048

Question 1049

LO

G

A structured reference
A) is a tag or use of a table element as a reference in a formula.
B) highlights or emphasizes cells that meet certain conditions.
C) is a horizontal gradient or solid fill indicating the cell's structure compared to other selected cells.
D) formats cells based upon their value in reference to the value of other cells.
Answer: https://biology-forums.com/index.php?topic=270845

IO

A citation that appears at the bottom of the page of a Word document is a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271480

Question 1050

B

A hard return is created when you press ________ at the end of a line or paragraph.
Answer: https://biology-forums.com/index.php?topic=271315

Question 1051
A relative cell ________ indicates a cell's relative location.
Answer: https://biology-forums.com/index.php?topic=270708

Question 1052
Help topics in Windows 7 are available when you look through help by clicking the ________ button.
A) Search
B) Search Help
C) Look Through Help
D) Browse Help
Answer: https://biology-forums.com/index.php?topic=271628

Question 1053
Match the following terms to their meanings:
I.A chartA.displays data comparisons vertically in columns
II.A data pointB.group of related data points
III.A data seriesC.numeric value that describes a single value on a chart
IV.A category labelD.visual representation of numerical data
V.A column chartE.text that describes a collection of data points in a chart
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Answer: https://biology-forums.com/index.php?topic=270806

Question 1054

M

A table is added to a document from the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271541

M
S.
C
O

Question 1055
The .rtf extension stands for ________ Format.
Answer: https://biology-forums.com/index.php?topic=271091

Question 1056

Question 1057

YFO

A ________ is a question you ask about data stored in a database.
A) query
B) form
C) report
D) macro
Answer: https://biology-forums.com/index.php?topic=270314

R
U

The X-axis
A) displays incremental values to identify the values of the data series.
B) provides descriptive group names for subdividing the data series.
C) is a horizontal line that borders the plot area to provide a frame of reference for measurement.
D) is a vertical line that borders the plot area to provide a frame of reference for measurement.
Answer: https://biology-forums.com/index.php?topic=270747

G

Question 1058

IO

Question 1059

LO

In order to receive online help files in your searches, open Help and Support, click Options, and then click:
A) Open.
B) Online Help.
C) More.
D) Settings.
Answer: https://biology-forums.com/index.php?topic=271633

B

Match the chart type to their meanings:
I.A pie chartA.separates one or more pie slices from the
rest of the pie chart
II.An exploded pie chartB.shows each data point in proportion to the
whole data series as a slice in a circular pie
III.An area chartC.shows a relationship between two variables
IV.An X Y (scatter) chartD.can show the open, high, low, close, and
volume prices for individual stocks over time
V.A stock chartE.emphasizes magnitude of changes over time
by filling in the space between lines with a color
Answer: https://biology-forums.com/index.php?topic=270810

Question 1060
Click the ________ key on the keyboard to display Key Tips in Office 2010.
A) Alt
B) Shift
C) F1
D) Ctrl
Answer: https://biology-forums.com/index.php?topic=270908

Question 1061
An important design principle states that you should use no more than ________ fonts on a slide.
A) one
B) two

Page 125 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
C) three
D) four
Answer: https://biology-forums.com/index.php?topic=271072

Question 1063
An object can be ________ vertically or horizontally for a mirror image of the object.
Answer: https://biology-forums.com/index.php?topic=271172

Question 1064
A(n) ________ is a small, miniature graphic of a slide that appears in the Slides tab.
Answer: https://biology-forums.com/index.php?topic=271007

R
U

Question 1065

M
S.
C
O

________ view is used to modify the design of a form, but does not contain the more advanced features of design view.
Answer: https://biology-forums.com/index.php?topic=270579

M

Question 1062

YFO

To add a record (row) to a table,
A) select any cell in the table, then click Remove Duplicates in the Tools group.
B) click in a cell and on the Home tab, click the Insert arrow in the Cells group.
C) click within a range, click the Table Tools Design tab, and then select Add Row to Table.
D) click the Insert tab and then click Range in the Range group.
Answer: https://biology-forums.com/index.php?topic=270831

Question 1066

Question 1067

LO

G

Which of the following is NOT included as part of the status bar?
A) Total number of pages in the document
B) Total number of words in the document
C) The total number of characters in the document
D) The page number where the insertion point is located
Answer: https://biology-forums.com/index.php?topic=271275

IO

When adding ________ elements to a chart, make sure they enhance the effectiveness of the chart instead of overpowering it.
Answer: https://biology-forums.com/index.php?topic=270797

B

Question 1068

The ________ data type contains values that can be used in a calculation.
Answer: https://biology-forums.com/index.php?topic=270446

Question 1069
To begin to record audio for a presentation, click the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271257

Question 1070
Comments can be added to a document from the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271466

Question 1071
Which of the following is TRUE about ungrouping an object?
A) Vector graphic files are easily edited and layered.
B) Most of the clip art images available from the Clip Art pane are not vector graphics.
C) Files in .bmp and .jpg can be ungrouped.
D) All non-vector graphics can be converted into drawing objects.
Answer: https://biology-forums.com/index.php?topic=271151

Question 1072
Match the following Table Tools Layout features with their descriptions:
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I.MergeA.set margins within a cell
II.AlignmentB.sort within a table
III.DataC.delete cells, columns, rows
IV.Cell SizeD.join or split two or more cells
V.Rows & ColumnsE.adjust row height and column width
Answer: https://biology-forums.com/index.php?topic=271564

M
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Question 1073
A function is a
A) predefined formula that performs a calculation.
B) cell reference or a value.
C) list of values and defined names as you enter a spreadsheet.
D) set of rules that govern the structure and components for a formula.
Answer: https://biology-forums.com/index.php?topic=270677

Question 1074

YFO

R
U

You can use ________ to create a relationship between two tables using a common field.
A) join lines
B) objects
C) forms
D) reports
Answer: https://biology-forums.com/index.php?topic=270336

Question 1075

Question 1076

LO

G

When you close a document in Office 2010, what happens to the application?
A) It automatically remains open for a minimum of 10 additional minutes.
B) It also closes with the document.
C) If you close two of more documents simultaneously, the application closes; if only one document is closed, the application remains open.
D) The application remains open.
Answer: https://biology-forums.com/index.php?topic=270916

IO

Completing a merge in Word starts with clicking on the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271563

Question 1077

B

Of the following, which is NOT a method to return to a previously-viewed slide?
A) Press N
B) Press the left arrow
C) Press Backspace
D) Press Page Up
Answer: https://biology-forums.com/index.php?topic=270996

Question 1078
Which of the following is NOT a function of an operating system?
A) It keeps track of files and folders
B) It allows you to create written documents
C) It recognizes keyboard input
D) It sends output to a display or output device
Answer: https://biology-forums.com/index.php?topic=271575

Question 1079
How do you change the indexing options and locations in Windows 7?
A) Start button, Indexing, and click Indexing Options
B) Start button, All Programs, and Indexing Options
C) Start button, All Programs, Indexing, and Options
D) Start button, type Indexing Options in the Search box, and click Indexing Options
Answer: https://biology-forums.com/index.php?topic=271624
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R
U

Which cell becomes active when you press the "Enter" key?
A) Cell A1 .
B) The cell at the bottom of the next column.
C) The next cell down.
D) The cell at the end of the current row.
Answer: https://biology-forums.com/index.php?topic=270609

M
S.
C
O

A typical ________ entry may say "See page 2 for more information about CPUs."
A) cross-reference
B) index
C) table of authority
D) table of figures
Answer: https://biology-forums.com/index.php?topic=271462

M

Question 1080

Question 1082

YFO

Which of the following could be a Web document that could possibly be imported into PowerPoint?
A) spring_contract.htm
B) cleaning service.doc
C) cleaning.http
D) spring contract.rtf
Answer: https://biology-forums.com/index.php?topic=271061

Question 1083

LO

Question 1084

G

Windows Help and ________ is a tool used to locate a specific help topic or simply brows the general topics to learn more about computing and
applications.
Answer: https://biology-forums.com/index.php?topic=271657

B

IO

The Report ________ section of a report is used for report totals and other summary information.
A) Detail
B) Footer
C) Header
D) Page Header
Answer: https://biology-forums.com/index.php?topic=270567

Question 1085
When viewing a slide in collapsed outline view, how do you know if a slide contains additional levels?
A) The title is bolded
B) The title is bolded and a larger font than others without additional levels
C) A slide icon shows next to titles with additional levels
D) The slide title appears with a wavy line below it
Answer: https://biology-forums.com/index.php?topic=271053

Question 1086
The Table Style Options Group
A) enables you to adjust settings to control how many pages will print.
B) contains check boxes to select format actions such as Total Row which displays a Total Row when Checked.
C) is a collection of structured, related data in columns and rows.
D) keeps Table Options visible as you scroll through a worksheet.
Answer: https://biology-forums.com/index.php?topic=270835

Question 1087
The Windows Help button, a question mark, is located in the ________ of most windows.
A) top right corner
B) bottom left corner
C) bottom right corner
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D) top left corner
Answer: https://biology-forums.com/index.php?topic=271630

Question 1088

M
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Question 1089

M

The ________ of an image refers to the lightness and darkness of the picture.
Answer: https://biology-forums.com/index.php?topic=271239

You can use the ________ to create specialized reports that come preformatted to for name-brand labels such as Avery.
A) Report Wizard
B) Form Wizard
C) Mailing Wizard
D) Label Wizard
Answer: https://biology-forums.com/index.php?topic=270555

Question 1090

YFO

R
U

In which of the following scenarios will the Mini toolbar NOT show?
A) You've clicked in one location of a document
B) You've selected a paragraph and have right-clicked the mouse
C) You've selected a word and slightly moved the mouse pointer
D) You've selected a sentence in a document and right-clicked the mouse while located within the highlighted text.
Answer: https://biology-forums.com/index.php?topic=270919

Question 1091

To display another worksheet click the sheet ________ at the bottom of the workbook window.
Answer: https://biology-forums.com/index.php?topic=270648

G

Question 1092

IO

LO

The SUBTOTAL function
A) highlights or emphasizes cells that meet certain conditions.
B) formats cells based upon their value in reference to the value of other cells.
C) calculates an aggregate for values in a range or database.
D) tags a table element as a reference in a formula.
Answer: https://biology-forums.com/index.php?topic=270847

Question 1093

B

Match the following terms with their descriptions:
I.typographyA.appearance of printed material
II.typefaceB.contains thin lines at the top and bottom of characters
III.serif typefaceC.characteristic applied to a font
IV.sans serif typefaceD.complete set of characters
V.type styleE.does not contain thin lines on characters
Answer: https://biology-forums.com/index.php?topic=271413

Question 1094
Match the following keyboard shortcuts with their function:
I.Shift+TabA.toggle field codes on and off
II.Shift+F9B.moves the insertion point to the previous cell in a table
III.TabC.inserts a regular tab character within a cell
IV.DeleteD.removes selected data within a table
V.Ctrl+TabE.moves the insertion point to the next cell in a table
Answer: https://biology-forums.com/index.php?topic=271572

Question 1095
Which of the following list of items (text within a sentence) uses parallel construction?
A) turning on the faucet, drinking the water, and turn the faucet off
B) went running, walking, and then rode her bike
C) mowed the lawn, weeded the flower beds, and put the tools away
D) she plays volleyball, likes to hike, and runs cross country

Page 129 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Answer: https://biology-forums.com/index.php?topic=270977

Question 1096

M
S.
C
O

M

Where would you find an arrowhead in regard to PowerPoint 2010?
A) As a shape on a slide
B) At the vertex of two or more lines
C) At the corner of any selected shape
D) At the end of a line
Answer: https://biology-forums.com/index.php?topic=271129

How are Master Lists stored in Word 2010?
A) In XML format
B) In HTML format
C) As a template
D) As a URL
Answer: https://biology-forums.com/index.php?topic=271437

Question 1098

R
U

Question 1097

YFO

A table
A) is an area in the worksheet that contains rows and columns of related data formatted to enable data management and analysis.
B) is a complete set of data for an entity.
C) represents a Field which is an individual piece of data.
D) is an individual piece of data, such as a last name.
Answer: https://biology-forums.com/index.php?topic=270824

Question 1099

IO

Question 1100

LO

G

A bar chart
A) uses a line to connect data points in order to show trends over a period of time.
B) compares values across categories using horizontal bars.
C) shows each data point in proportion to the whole data series as a slice in a circular pie.
D) separates one or more pie slices from the rest of the pie chart.
Answer: https://biology-forums.com/index.php?topic=270758

B

Match the following parts of the Windows Explorer interface with its function:
I.Address barA.shows currently selected folder or library
II.Content paneB.shows properties associated with a selected file
III.Details paneC.includes buttons relevant to currently selected item
IV.Navigation paneD.contains Favorites, Libraries, Homegroup, Computer,
and Network
V.ToolbarE.navigate to other folders or libraries
Answer: https://biology-forums.com/index.php?topic=270956

Question 1101
________ alignment refers to the placement of text between the left and right margins..
Answer: https://biology-forums.com/index.php?topic=271401

Question 1102
Which of the following Word Options menu categories allows you to enable click and type, choose a default paragraph style, and show paste option
buttons?
A) General
B) Proofing
C) Advanced
D) Add-ins
Answer: https://biology-forums.com/index.php?topic=271282

Question 1103
Match the following terms to their meanings:
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Question 1104

M

I.Filter by SelectionA.Expressions used to filter the records in a table
II.Filter by FormB.Evaluates the relationship between two quantities
III. Comparison operatorsC.Displays table data based on multiple criteria
IV. CriteriaD.Lists records numerically or alphabetically,
in ascending or descending order.
V. SortE.Displays table data based on a single criterion.
Answer: https://biology-forums.com/index.php?topic=270386

The ________ button, the middle button on the title bar of a window, allows you to fill the screen with the window or restore down to the previous size.
Answer: https://biology-forums.com/index.php?topic=271638

Question 1105

R
U

You've found a sound file from the Clip Art pane and you want to listen to it, now what?
A) Click the bar on the right side of the clip and select Preview/Properties
B) Simply click the sound clip result
C) Double-click the sound clip you want to hear
D) Click the bar on the right side of the clip and select Play
Answer: https://biology-forums.com/index.php?topic=271215

YFO

Question 1106

G

Match the navigation method with the navigation option in PowerPoint 2010:
I.Press NA.returns to a previous slide
II.Press PB.ends a slide show
III.Press EscC.see a list of slide show controls
IV.type a slide number and press Enter D.advance through the slide show
V.Press F1E.goes to a specific slide
Answer: https://biology-forums.com/index.php?topic=271038

LO

Question 1107

IO

Which of the following is NOT considered a step in checking spelling and incorrect word usage for a PowerPoint slide show?
A) Use the Editing feature
B) Read the slide content after you enter it.
C) Use the Spelling feature
D) Ask a friend or colleague to review it
Answer: https://biology-forums.com/index.php?topic=270983

B

Question 1108

Which statement accurately describes the function of a query?
A) Queries manipulate data stored in tables, displaying only those records which match the query’s criteria
B) Queries delete data stored in tables, displaying only those records which match the query’s criteria
C) Queries edit data stored in tables, displaying only those records which match the query’s criteria
D) Queries manipulate data stored in tables, hiding only those records which match the query’s criteria
Answer: https://biology-forums.com/index.php?topic=270388

Question 1109
Match the following Word features to the dialog box where it can be accessed:
I.change to superscriptA.Symbols dialog box
II.insert a nonbreaking hyphenB.Tabs dialog box
III.specify a leader characterC.Borders and Shading dialog box
IV.add a Box style to a paragraphD.Paragraph dialog box
V.change line spacingE.Font dialog box
Answer: https://biology-forums.com/index.php?topic=271421

Question 1110
Steve is working in a database that stores student exam grades. He needs to create a query that will show the numerical mean of exam grades. He
should use the ________ function on the column containing the grades.
A) Sum
B) Avg
C) Count
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D) Max
Answer: https://biology-forums.com/index.php?topic=270485

Question 1111

M
S.
C
O

M

David is working in a database that organizes student exam grade information. He needs to find all students who have scored 100 on an exam. David
can apply a(n) ________ to the data in order to show only records that meet the criteria.
A) Filter
B) Report
C) Form
D) Sort
Answer: https://biology-forums.com/index.php?topic=270343

Question 1112

R
U

In addition to verifying the accuracy of a calculated field using a calculator, you can also use a(n) ________ to verify results
A) expression
B) Excel spreadsheet
C) second query
D) formula
Answer: https://biology-forums.com/index.php?topic=270473

YFO

Question 1113

If a user selects the ________ option while creating a relationship, Access will automatically remove all records in related tables when the matching
primary key is removed from the first table.
Answer: https://biology-forums.com/index.php?topic=270460

Question 1114

IO

Question 1115

LO

G

Click the ________ command on the ________ tab to begin the process of converting text into a Word table.
A) Table; Page Layout
B) Convert Text; Insert
C) Text to Table; Insert
D) Table; Insert
Answer: https://biology-forums.com/index.php?topic=271519

Data in one or more tables can be related to each other by means of a(n) ________ field.
Answer: https://biology-forums.com/index.php?topic=270372

B

Question 1116

An icon set
A) is a conditional format that displays an icon representing a value in the top third, quarter, or fifth based on values in the selected range.
B) highlights cells meeting specified criteria with a specified color, font, or border.
C) calculates an aggregate for values in a range or database.
D) is a conditional format that displays a particular color based on the relative value of the cell contents to other selected cells.
Answer: https://biology-forums.com/index.php?topic=270853

Question 1117
Match each term with the appropriate definition.
I.Page FooterA.Appears at the top of each page of a report
II.Report FooterB.Appears once for each record in the underlying table or query
III.Report HeaderC.Appears once at the beginning of a report
IV.Detail D.Appears once at the end of a report
V.Page HeaderE.Appears at the bottom of each page in a report
Answer: https://biology-forums.com/index.php?topic=270603

Question 1118
The ________ refers to the last line of a paragraph that displays by itself at the top of a page of text.
Answer: https://biology-forums.com/index.php?topic=271403

Question 1119
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The ________ data type will automatically increment each time a new record is entered.
Answer: https://biology-forums.com/index.php?topic=270445
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You can click the ________ button on the table toolbar to sort records in alphabetical order, from A to Z.
A) form
B) descending
C) order
D) ascending
Answer: https://biology-forums.com/index.php?topic=270315

M

Question 1120

Question 1121

R
U

The ________ group on the External Data Tab has options that you can use to send a portion of a database to other application
A) Import & Link
B) Export
C) Collect Data
D) Web Linked Lists
Answer: https://biology-forums.com/index.php?topic=270414

Question 1122

YFO

Which of the following is FALSE about the Clipboard task pane?
A) The most recently added Clipboard item is pasted when you begin a paste operation.
B) All items can be removed from the Clipboard.
C) The Clipboard can be displayed in different locations.
D) Only the most recently added Clipboard item can be pasted into a document.
Answer: https://biology-forums.com/index.php?topic=270921

G

Question 1123

Question 1124

LO

Lining up shapes and objects by the sides, middle or top or bottom edges can easily be done with the ________ feature.
Answer: https://biology-forums.com/index.php?topic=271181

B

IO

Match the following components of Office 2010 and its function:
I.BackstageA.easy access to commonly executed task
II.Quick Access ToolbarB.displays the current file name and application
III.title barC.used to print, save, open, close, and share a file
IV.RibbonD.contains tabs, groups, and commands
V.Dialog Box LauncherE.opens a corresponding box that provides access to
precise tools
Answer: https://biology-forums.com/index.php?topic=270958

Question 1125
A page ________ indicates where data starts on a new printed page.
Answer: https://biology-forums.com/index.php?topic=270862

Question 1126
A form can best be described as a(n):
A) record.
B) object.
C) attribute.
D) table.
Answer: https://biology-forums.com/index.php?topic=270316

Question 1127
What happens to images that are entered into a photo album presentation in PowerPoint?
A) Images are reduced or enlarged in size to fix the size of each placeholder.
B) Each image is entered as the exact same size.
C) All images are cascaded on the first slide of the photo album.
D) Four images are displayed on each page of the photo album.
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Answer: https://biology-forums.com/index.php?topic=271227

Question 1128

M
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Ryan needs to organize the data in a table so that it displays in a summarized format. He should use the ________ view for this purpose.
A) Datasheet
B) PivotTable
C) PivotChart
D) Design
Answer: https://biology-forums.com/index.php?topic=270393

Question 1129

R
U

Joe is working in a database that stores client data. He needs to design a field that will assign a client ID number each time a user enters a new
client. The data type he should apply to this field is:
A) Text
B) Memo
C) Number
D) AutoNumber
Answer: https://biology-forums.com/index.php?topic=270396

Question 1130

YFO

The ________ is a temporary holding area in the computer's memory; it is only temporary storage.
Answer: https://biology-forums.com/index.php?topic=271647

Question 1131

Question 1132

LO

G

Match each aggregate function with the value it returns:
I.AvgA.Returns the data item with the highest value
II.Count B.Returns the data item with the lowest value
III.MaximumC.Returns the mean value of a group of numbers.
IV.MinimumD.Returns the total value of a column of numbers
VI.SumE.Returns the number of fields containing data
Answer: https://biology-forums.com/index.php?topic=270532

IO

To open an existing outline file created in a program other than PowerPoint 2010, click the ________ tab.
Answer: https://biology-forums.com/index.php?topic=271093

B

Question 1133

To simplify entering ranges in formulas you can use
A) range names.
B) a cells relative location.
C) both an absolute and a relative cell reference.
D) a cell's specific location.
Answer: https://biology-forums.com/index.php?topic=270704

Question 1134
Typography can be defined as the process of selecting all EXCEPT:
A) typefaces.
B) type styles.
C) type formats.
D) type sizes.
Answer: https://biology-forums.com/index.php?topic=271348

Question 1135
Which of the following is TRUE about PowerPoint 2010?
A) A PowerPoint presentation is saved with a .ptt extension after the filename.
B) A page is the most basic element of the PowerPoint presentation.
C) A PowerPoint electronic slide show can run automatically at a kiosk.
D) A PowerPoint slide show cannot be displayed on the World Wide Web.
Answer: https://biology-forums.com/index.php?topic=270966
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Question 1136

M

In order to change the default location and format to save files, access the ________ menu category of the Word Options.
Answer: https://biology-forums.com/index.php?topic=271319

Question 1137

M
S.
C
O

Consider the table pictured above. The value 4 in the totals row represents the number of employees listed in this table. How was this value
calculated in the totals row?
A) This value is a result of the Count function being applied to the LastName Field
B) This value is a result of the Average function being applied to the LastName Field
C) This value is a result of the Sum function being applied to the LastName Field
D) This value is a result of the Maximum function being applied to the LastName Field
Answer: https://biology-forums.com/index.php?topic=270498

Question 1138

R
U

A(n) ________ is created at the end of lines when you continue to type without entering a hard return.
Answer: https://biology-forums.com/index.php?topic=271316

Question 1139

YFO

Which of the following is TRUE about printing the outline of a slide show?
A) Speaker notes are not included when printed.
B) All charts and graphics would also be included in the printout.
C) Slide title are never included when printing an outline.
D) Printing the outline will include all details, all bullets, all graphics, and all tables.
Answer: https://biology-forums.com/index.php?topic=271004

G

Question 1140

IO

Question 1141

LO

Which of the following examples would be most appropriate for a nonbreaking space?
A) Three trees
B) John and Jean Huberman
C) 541-555-5555
D) Ms. Boyles
Answer: https://biology-forums.com/index.php?topic=271358

B

Items in an index are listed in:
A) the order of importance.
B) the order of entry into the document.
C) numerical order.
D) alphabetic order.
Answer: https://biology-forums.com/index.php?topic=271448

Question 1142
An existing query for a database can be opened by double-clicking in the ________ of the Database window.
Answer: https://biology-forums.com/index.php?topic=270375

Question 1143
A stock chart
A) shows relationships among three values by using bubbles.
B) shows values as percentages of the whole but may contain more than one data series.
C) displays trends using two dimensions on a continuous curve.
D) can show the open, high, low, and close prices for individual stocks over time.
Answer: https://biology-forums.com/index.php?topic=270764

Question 1144
A(n) ________ SmartArt diagram shows a proportional relationship with the largest component on the top or the bottom.
Answer: https://biology-forums.com/index.php?topic=271167
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Question 1146
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A handle, indicated by faint dots on the outside border of a selected chart
A) enables you to adjust the size of the chart.
B) is a label that describes either the category axis or the value axis.
C) is a miniature chart contained in a single cell.
D) is a label that describes the chart.
Answer: https://biology-forums.com/index.php?topic=270769

M

Question 1145

R
U

A ________ displays when you point your mouse over a static cross-reference entry in a document
A) ScreenTip
B) paragraph number
C) page number
D) cross-reference name
Answer: https://biology-forums.com/index.php?topic=271459

Question 1147

YFO

Creating a chart involves selecting the data ________ and choosing the chart type.
Answer: https://biology-forums.com/index.php?topic=270783

Question 1148

Question 1149

LO

G

Match the following terms with their definitions:
I.templateA.file that includes a theme, layout, and possible
content
II.outlineB.indicates levels of importance
III.hierarchyC.shows presentation in levels according to points
and subpoints
IV.Outline view D.main points
V.Level 1E.method of organizing text hierarchically
Answer: https://biology-forums.com/index.php?topic=271109

IO

After you add sources to a document, they are saved in a(n) ________, a database of all citation sources.
Answer: https://biology-forums.com/index.php?topic=271475

B

Question 1150

A(n) ________ is a Lines shape that is attached to and moves with other shapes.
Answer: https://biology-forums.com/index.php?topic=271162

Question 1151
The COUNTA function
A) evaluates a condition and returns one value if the condition is true and a different value if the condition is false.
B) evaluates true or false.
C) tallies the number of cells in a range that are not empty.
D) displays the current date.
Answer: https://biology-forums.com/index.php?topic=270686

Question 1152
Match the following terms to their meanings:
I.DatabaseA.Contains a complete set of fields describing a person, place,
or idea.
II.TableB.Contains a singular data element such as a first name, last
name, or identification number
III.RecordC.Contains one or more tables that store data
IV. FieldD.The main components of an Access database which give it
functionality.
V. ObjectE. Contains a set of related records.
Answer: https://biology-forums.com/index.php?topic=270383

Page 136 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Question 1153

M

A(n) ________ font is a font has small lines at the end of letters.
Answer: https://biology-forums.com/index.php?topic=271099

Match the Word group with the function it can serve:
I.Comments groupA.opens a markup balloon
II.Changes groupB.view changes in Final or Original view
III.Index groupC.show or hide index fields, for examples
IV.Tracking groupD.accept or reject revisions
V.Paragraph groupE.mark entries within a document
Answer: https://biology-forums.com/index.php?topic=271490

Question 1155

R
U

Adjustments in the UAC control settings range from Never notify to ________ notify.
Answer: https://biology-forums.com/index.php?topic=271652

M
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Question 1154

Question 1156

YFO

Gina is working in a database that stores employee data. Gina’s boss wants her to design a form that will make a data entry easier. Her boss wants
her to include the company name and logo on the form. Gina can add this information to the Form ________ section.
Answer: https://biology-forums.com/index.php?topic=270584

Question 1157

Mail ________ is the process of combining text from a main document with a data source.
Answer: https://biology-forums.com/index.php?topic=271554

G

Question 1158

IO

LO

Using Conditional Formatting to draw attention to cells containing errors
A) helps locate errors in cells quickly.
B) displays a particular color based on the relative value of the cell contents to other selected cells.
C) calculates an aggregate for values in a range or database.
D) displays an icon representing a value in the top third based on values in the selected range.
Answer: https://biology-forums.com/index.php?topic=270856

Question 1159

B

Which of the following is TRUE about the Recent Documents list in Office 2010?
A) It constantly changes.
B) It is accessed from the Home tab.
C) All files located on your hard drive can be accessed from it.
D) It can be quickly accessed with the F10 key.
Answer: https://biology-forums.com/index.php?topic=270912

Question 1160
The intersection of a column and row is a table is referred to as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271540

Question 1161
The ________ function returns the number of fields that have data entered in a particular column but ignores null values.
Answer: https://biology-forums.com/index.php?topic=270527

Question 1162
Shadows, gradients, and 3-D effects are part of the ________ gallery.
A) WordArt Text Effects
B) SmartArt Quick Styles
C) WordArt Quick Styles
D) Shapes Quick Styles
Answer: https://biology-forums.com/index.php?topic=271138
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The column index number
A) is the periodic interest rate, such as a monthly interest rate.
B) looks up a value in a horizontal lookup table where the first row contains the values to compare with the lookup value.
C) calculates the periodic payment for a loan with a fixed interest rate and fixed term.
D) is the argument in a VLOOKUP function that identifies from which column to return a value.
Answer: https://biology-forums.com/index.php?topic=270697

Question 1164

Question 1165

YFO

What does MIDI stand for in regard to an audio file?
A) Musical Instrument Data Interface
B) Music on the Internet for Data Interchange
C) Music Internet Data Interchange
D) Musical Instrument Digital Interface
Answer: https://biology-forums.com/index.php?topic=271218

R
U

What type of control is used to help keep controls aligned horizontally and vertically, giving forms a uniform appearance?
A) Bounded
B) Layout
C) Unbounded
D) Calculated
Answer: https://biology-forums.com/index.php?topic=270541

Question 1166

IO

Question 1167

LO

G

As you are removing areas of a background that you want to discard, you can press ________ to see what the picture currently looks like.
A) Ctrl
B) Shift
C) F3
D) Esc
Answer: https://biology-forums.com/index.php?topic=271202

B

Setting a ________-pt After spacing in a document that is single spaced creates the appearance of a double-space after the paragraph even though
Enter is pressed only once.
A) 6
B) 12
C) 18
D) 24
Answer: https://biology-forums.com/index.php?topic=271368

Question 1168
By default, Word sequentially numbers footnotes as:
A) 1, 2, 3 ...
B) I, II, III ...
C) i, ii, and iii ...
D) A, B, C, ...
Answer: https://biology-forums.com/index.php?topic=271440

Question 1169
You can search for and locate video clips from the ________ pane within PowerPoint.
Answer: https://biology-forums.com/index.php?topic=271252

Question 1170
________ orientation is a page displayed or printed that is taller than it is wide.
Answer: https://biology-forums.com/index.php?topic=270954

Question 1171
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Match the following dialog box names with the features they offer:
I.Word OptionsA.display a document at 75%, for example
II.ZoomB.change the margins
III.Page SetupC.a file will have a .doc or .docx extension
IV.Save AsD.select type of content that you want checked within a file
V.Document InspectorE.make sure backups occur in a timely manner
Answer: https://biology-forums.com/index.php?topic=271344

Question 1172
What does pressing the hyphen (-) do when showing a slide show?
A) Advances through the slides
B) Returns to a previous slide
C) Goes to a specific slide that you specify after pressing the hyphen
D) Ends a slid show
Answer: https://biology-forums.com/index.php?topic=270997

You can use ________ names in formulas instead of cell references.
Answer: https://biology-forums.com/index.php?topic=270730

YFO

Question 1174

R
U

Question 1173

The first row of a data source for a mail merge is known as the:
A) primary row.
B) merge field.
C) filter.
D) header row.
Answer: https://biology-forums.com/index.php?topic=271527

G

Question 1175

IO

LO

How do you drag a window out of the way that may be obstructing another window?
A) Hover the mouse arrow over the title bar until it changes to a double-arrow, then drag it
B) Click the title bar to move it
C) Click the control buttons and drag it
D) Double-click anywhere in the window to automatically move it alongside the other windows
Answer: https://biology-forums.com/index.php?topic=271608

Question 1176

B

Database design begins with:
A) creating the correct forms.
B) creating the correct queries.
C) grouping data into the correct tables.
D) grouping the data in alphabetical order.
Answer: https://biology-forums.com/index.php?topic=270337

Question 1177
The Chart Tools Design ________ tab contains options to modify the overall chart design.
Answer: https://biology-forums.com/index.php?topic=270785

Question 1178
The breakpoint
A) looks up a value and returns a related result from the lookup table.
B) is a range containing a lookup table.
C) is the lowest value for a specific category or series in a lookup table.
D) is a reference to a cell containing a value to look up.
Answer: https://biology-forums.com/index.php?topic=270693

Question 1179
Which of the following is TRUE about .txt files when importing an outline?
A) All formatting is retained.
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B) Each line of the outline becomes a slide when imported.
C) They cannot be transferred among platforms.
D) Files with a .txt extension have a saved hierarchical structure.
Answer: https://biology-forums.com/index.php?topic=271060

YFO

Which of the following fonts does NOT contain special symbols?
A) Wingdings
B) Calibri
C) Webdings
D) Symbol
Answer: https://biology-forums.com/index.php?topic=271385

M
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Question 1181

R
U

Match the following groups with the item or function most associated with that group:
I.Comments groupA.markup tools to accept or reject changes
that a review added
II.Changes groupB.add a title to an image, figure, or table
III.Citations & Bibliography
groupC.choose MLA or APA, for example
IV.Captions groupD.update changes to a table
V.Table of Authorities groupE.text added to a document to remind or inform
of something
Answer: https://biology-forums.com/index.php?topic=271492

M

Question 1180

Question 1182

Question 1183

LO

G

The ________ tab holds all of the operations necessary to carry out data import and export.
A) External Data
B) Database Tools
C) Create
D) Home
Answer: https://biology-forums.com/index.php?topic=270355

IO

Clicking _______, and then the Options button will allow you to set the Proofing options in PowerPoint 2010.
Answer: https://biology-forums.com/index.php?topic=271017

B

Question 1184

The three areas of the Background Styles gallery include ________, moderate, and intense.
Answer: https://biology-forums.com/index.php?topic=271102

Question 1185
Match the following keyboard strokes while in Outline view with its function:
I.TabA.create a new slide or bullet at the same level
II.Shift+TabB.promotes an item
III.EnterC.remove highlighted content
IV.Delete D.demotes an item
V.Shift+Tab twiceE.decreases the indent two levels
Answer: https://biology-forums.com/index.php?topic=271107

Question 1186
A ________ produces professional appearing formatted information derived from the information contained in tables or queries.
A) primary key
B) criterion
C) report
D) form
Answer: https://biology-forums.com/index.php?topic=270350

Question 1187
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Question 1188
What is the default line border for tables in Word 2010?
A) A single line
B) A thin double line
C) A thick border line
D) A dashed line
Answer: https://biology-forums.com/index.php?topic=271506

Question 1189

YFO

R
U

The PV is
A) a set of range names.
B) is a word or a string of characters that represent one or more cells.
C) the present value of the loan.
D) why you do not have to make the cell reference absolute in the formula.
Answer: https://biology-forums.com/index.php?topic=270702
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Which of the following statements is true in reference to comparing the sections in Access forms and the sections in Access reports?
A) Forms have more sections than reports, and working with report sections is much different from working with form sections.
B) Reports have more sections than forms, but working with report sections is similar to working with form sections.
C) Forms have the same number of sections as reports, and working with report sections is similar to working with form sections.
D) Forms have the same number of sections as reports, but working with report sections is much different from working with form sections.
Answer: https://biology-forums.com/index.php?topic=270568

Question 1190

Question 1191

LO

G

Contextual mistakes in PowerPoint 2010 are noted by:
A) a red wavy underline.
B) dark red bolded text.
C) a thick green underline.
D) blue flashing text.
Answer: https://biology-forums.com/index.php?topic=270984

IO

QAT in Word 2010 refers to the ________ Toolbar.
Answer: https://biology-forums.com/index.php?topic=271320

Question 1192

B

Match the following features of the Picture Tools Format tab with their description:
I.CropA.increases or decreases brightness of an object
II.PositionB.specifies the location on a page where the object
will reside
III.Compress PicturesC.reduces the file size
IV.CorrectionsD.removed unwanted portions of an object
V.GroupE.selecting multiple objects so they can be moved or
formatted together
Answer: https://biology-forums.com/index.php?topic=271420

Question 1193
Having the Mini toolbar and Enhanced Screen Tips show in Word is a function of the ________ menu category of the Word options.
A) Advanced
B) Proofing
C) General
D) Add-Ins
Answer: https://biology-forums.com/index.php?topic=271284

Question 1194
Match the following audio file format descriptions with their file format type:
I.used to create sound files for UNIX computersA.AU Audio file
II.compressed sound file that uses MPEG Audio
Layer 3 codecB.MP3 Audio file
III.not compressed--can result in large files; originally
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for Apple computersC.MIDI file
IV.sound format used to distribute recorded music,
usually over the InternetD.AIFF Audio file
V.standard format for musical data between instruments
and synthesizersE.Windows Media
Audio file
Answer: https://biology-forums.com/index.php?topic=271269

Question 1195

________ are the placeholders for the variable data that is inserted into individual letters in a mail merge.
Answer: https://biology-forums.com/index.php?topic=271556

Question 1196

R
U

What happens to RAM when electricity is lost or the computer shuts down suddenly and a document that you are working on has not yet been saved?
A) Nothing; RAM is permanent.
B) The contents in RAM are erased.
C) The document is automatically saved and nothing is lost in RAM.
D) RAM saved everything in it for previous ten minutes.
Answer: https://biology-forums.com/index.php?topic=270899

YFO

Question 1197
The default orientation for printing slides is ________.
Answer: https://biology-forums.com/index.php?topic=271028

Question 1198

Question 1199

LO

G

What is the keyboard shortcut to center text?
A) Ctrl+E
B) Ctrl+C
C) Shift+C
D) Ctrl+Shift+C
Answer: https://biology-forums.com/index.php?topic=271366

B

IO

What is the most common modification procedure of objects?
A) Resizing
B) Rotating
C) Recoloring
D) Flipping
Answer: https://biology-forums.com/index.php?topic=271145

Question 1200
The left pane of a standard PowerPoint window contains the ________ and ________ tabs.
A) Slides; Outline
B) Add-Ins; Outline
C) Slides; View
D) Slides; Slide Show
Answer: https://biology-forums.com/index.php?topic=270967

Question 1201
Match the parts of the Excel Window to its meaning:
I.Name BoxA.Displays the content of the active cell
II.Formula barB.Displays the name of a worksheet within a workbook
III.Sheet tabC.Identifies a cell by a column letter and row number
IV.CellD.Identifies the address of the current (active) cell
V.Cell addressE.Intersection of a column or row
Answer: https://biology-forums.com/index.php?topic=270661

Question 1202
A form that displays fields in a vertical column, and displays one record at a time is in a ________ layout.
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Answer: https://biology-forums.com/index.php?topic=270577

Question 1204

R
U

Match each Form tool with its function
I.FormA. Creates a two-part form with a stacked layout in one section
and a tabular layout in the other.
II.Form DesignB.Creates a custom form based on questions you answer.
III.Blank FormC.Creates a form in a stacked layout displaying all of the fields
in the record source.
IV.Form WizardD.Creates an empty form in Layout view
V.Split FormE.Creates an Empty form in Design view
Answer: https://biology-forums.com/index.php?topic=270604

YFO

Question 1205

A(n) ________ provides legal protection for written and artistic work.
Answer: https://biology-forums.com/index.php?topic=271244

Question 1206

IO

LO

G

Which of the following views hides the Ribbon?
A) Draft
B) Full Screen Reading
C) Print Layout
D) Web Layout
Answer: https://biology-forums.com/index.php?topic=271299

Question 1207

M
S.
C
O

Sorting Dates oldest to newest
A) is the process of displaying only records that meet specific conditions.
B) arranges dates in alphabetical order.
C) is a Text Filter.
D) displays data in chronological order.
Answer: https://biology-forums.com/index.php?topic=270839

M

Question 1203

________ refers to using and documenting the work of another as your own.
Answer: https://biology-forums.com/index.php?topic=271473

B

Question 1208

Match the chart elements to their meanings:
I.The chart areaA.contains graphical representation of values in data
series
II.The Plot AreaB.provides descriptive group names for subdividing the
data series
III.The X-axisC.horizontal line that borders the plot area to provide a
frame of reference for measurement
IV.The Y-axisD.vertical line that borders the plot area to provide a frame
of reference for measurement
V.The category axisE.contains the entire chart and all of its elements
Answer: https://biology-forums.com/index.php?topic=270807

Question 1209
The ________ tool is a new feature for images in PowerPoint 2010.
A) Remove Background
B) Colors
C) Crop
D) Picture
Answer: https://biology-forums.com/index.php?topic=271200

Question 1210
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Consider the table pictured above. GrossPay is a calculated field. Which of the following expressions was used to calculate the data for the field?
A) [HoursWorked]*[HourlyWage]
B) [HoursWorked] x [HourlyWage]
C) [HoursWorked]([HourlyWage])
D) [HoursWorked]+ [HourlyWage]
Answer: https://biology-forums.com/index.php?topic=270497
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Question 1211
The ________ Pane contains a list of all objects on a slide.
Answer: https://biology-forums.com/index.php?topic=271177

If field codes have been toggled on in a table, which cells are shaded?
A) Only the cells that contain formulas
B) All cells that contain data or formulas
C) All cells in a table
D) Only the cells that contain data
Answer: https://biology-forums.com/index.php?topic=271515

Question 1213

YFO

Indentation in a document is established at the ________ level.
A) word
B) sentence
C) paragraph
D) page
Answer: https://biology-forums.com/index.php?topic=271367

R
U

Question 1212

G

Question 1214

IO

LO

All Office 2010 applications allow you to insert clip art from the Illustrations group; ________, however, also allows you to insert an object directly from
a slide.
A) Word
B) Excel
C) Access
D) PowerPoint
Answer: https://biology-forums.com/index.php?topic=270925

Question 1215

B

The ________ is the screen display through which a user communicates with the software installed on a drive.
Answer: https://biology-forums.com/index.php?topic=270937

Question 1216
If you do not see comments in a document, click ________ on the Review tab and confirm that Comments is toggled on.
A) Final: Show Markup
B) Revision marks
C) Track Changes
D) Show Markup
Answer: https://biology-forums.com/index.php?topic=271426

Question 1217
How do you move a slide in collapsed outline view?
A) Click the slide title and drag it to the new location
B) Position the pointer over a slide icon until it turns to a four-headed arrow and drag it
C) Position the pointer over the slide number until it turns to a four-headed arrow and drag it
D) Click the slide number and drag it to the new location
Answer: https://biology-forums.com/index.php?topic=271054

Question 1218
SmartArt layouts include combinations of all EXCEPT:
A) fills.
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B) orientation.
C) shadowing.
D) fonts.
Answer: https://biology-forums.com/index.php?topic=271139

M

Question 1219

M
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Match the following terms with their descriptions:
I.right tabA.used to align numbers
II.decimal tabB.characters which display up to the point of a
tab setting
III.dot leaderC.used for aligning text in a document
IV.tabD.text moves to the left of this tab setting
V.bar tabE.does not position or align text or decimals but instead,
inserts a character at the tab setting
Answer: https://biology-forums.com/index.php?topic=271416

R
U

Question 1220

YFO

Which of the following is TRUE about using database files as data sources in a mail merge?
A) Field names must be the same in the database file as in the Word document.
B) The newest Access version saves database files with a .mdb extension.
C) Information in a database is stored in tables.
D) Filtering data in a database should always be done in Word, not in Access.
Answer: https://biology-forums.com/index.php?topic=271530

Question 1221

Question 1222

LO

G

AutoComplete (as it applies to Excel)
A) adds all the numbers in the row automatically.
B) searches for and displays any other similar label in the current column as you begin to type.
C) adds all the numbers in the columns automatically.
D) is a number that represents a quantity and can be the basis of calculations.
Answer: https://biology-forums.com/index.php?topic=270612

IO

________ is the arrangement and appearance of printed material.
Answer: https://biology-forums.com/index.php?topic=271388

Question 1223

B

Match the following terms to their descriptions:
I.Structured referenceA.highlights or emphasizes cells that meet certain
conditions
II.Total rowB.statistical functions
III.SUBTOTAL functionC.a tag or use of a table element as a reference in
a formula
IV.Conditional formattingD.calculates an aggregate for values in a range or
database
V.Sum, average, min, maxE.appears as the last row of a table to display
summary statistics
Answer: https://biology-forums.com/index.php?topic=270888

Question 1224
Using the fill handle on a cell containing a formula
A) cannot complete a sequence of dates in a column.
B) changes the background color of the selected cells to yellow.
C) copies the formula in the active cell to other cells and adapts it based upon the type of cell references in the original formula.
D) has two or more sub-commands related to the command.
Answer: https://biology-forums.com/index.php?topic=270617

Question 1225
A clustered column chart
A) is a key that identifies the color, gradient, picture, texture, or pattern fill assigned to each data series in a chart.
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Question 1226
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To Freeze Columns and/or rows use the View Tab, Window Group, and then click ________ Panes.
Answer: https://biology-forums.com/index.php?topic=270859

M

B) places stacks of data in segments on top of each other in one column, with each category in the data series represented by a different color.
C) places (stacks) data in one column per category, with each column having the same height of 100%.
D) groups or clusters similar data in columns to compare values across categories.
Answer: https://biology-forums.com/index.php?topic=270753

Question 1227

R
U

A data bar
A) highlights cells meeting specified criteria with a specified color, font, or border.
B) calculates an aggregate for values in a range or database.
C) formats the bar data in preparation for printing.
D) is a horizontal gradient or solid fill indicating the cell's relative value compared to other selected cells.
Answer: https://biology-forums.com/index.php?topic=270851

Question 1228

YFO

In which of the following examples would you LEAST LIKELY insert a section break?
A) Changing font, font size, and alignment in the middle of a document
B) Needing to insert a wide graph that needs landscape orientation into a document that uses portrait orientation
C) Changing from a two-column format to a one-column format
D) Changing page numbering from Roman numerals to Arabic numerals
Answer: https://biology-forums.com/index.php?topic=271293

Question 1229

G

The ________ is the periodic interest or a loan.
Answer: https://biology-forums.com/index.php?topic=270726

LO

Question 1230

IO

Printing a document is available from the ________ tab.
A) File
B) Home
C) View
D) Page Layout
Answer: https://biology-forums.com/index.php?topic=270914

B

Question 1231

To view data fields that are not visible on your display you can use the vertical or horizontal ________.
Answer: https://biology-forums.com/index.php?topic=270373

Question 1232
Microsoft Word 2010 outlines that can be imported into a presentation have a ________ file extension.
A) .doc
B) .wrd
C) .docx
D) .wpd
Answer: https://biology-forums.com/index.php?topic=271057

Question 1233
Which of the following is TRUE about how typical text looks on a slide?
A) Each subsidiary item is indented and the font size is larger
B) Each subsidiary item is bolded and the font size is smaller
C) Each subsidiary item is italicized, bolded, and the font size is smaller
D) Each subsidiary item is indented and the font size is smaller
Answer: https://biology-forums.com/index.php?topic=271051

Question 1234
Match the following features with the appropriate tab:
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I.add a SmartArt diagram to a slideA.Drawing Tools Format tab
II.insert a picture as fill to a shapeB.SmartArt Tools Design tab
III.apply a Quick Style to a selected shapeC.View tab
IV.access the Text paneD.Home tab
V.see the grids on a slideE.Insert tab
Answer: https://biology-forums.com/index.php?topic=271186

M
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Question 1235
How do you move to the previous cell in a row?
A) Alt+Tab
B) Alt+F1
C) Shift+Tab
D) Ctrl+Tab
Answer: https://biology-forums.com/index.php?topic=271502

Question 1236

YFO

R
U

A field that is defined as a primary key in one table is defined as a(n) ________ in a related table.
A) filter
B) relational database
C) foreign key
D) primary key
Answer: https://biology-forums.com/index.php?topic=270321

Question 1237

Question 1238

LO

G

The NPER
A) is the total number of payment periods.
B) is a word or a string of characters that represent one or more cells.
C) the present value of the loan.
D) a set of range names.
Answer: https://biology-forums.com/index.php?topic=270701

IO

To change the page size in a Word document, use the Size command in the ________ group.
Answer: https://biology-forums.com/index.php?topic=271321

Question 1239

B

Which of the following is FALSE about line shapes in PowerPoint 2010?
A) Width of a line is measured in points.
B) A vertical inch contains 100 centimeters.
C) A shape can have an outline entirely removed.
D) Weight line choices range from 1/4 pt to 6 pt.
Answer: https://biology-forums.com/index.php?topic=271130

Question 1240
The ________ organizes and lists the database objects in an Access database.
A) report wizard
B) navigation pane
C) query tool
D) form wizard
Answer: https://biology-forums.com/index.php?topic=270329

Question 1241
A enhanced ________ displays in Office 2010 when the mouse pointer is placed over a button.
Answer: https://biology-forums.com/index.php?topic=270942

Question 1242
Access is known as a(n) ________ because it allows users to administer groups of data in tables and create relationships between tables.
Answer: https://biology-forums.com/index.php?topic=270376

Page 147 of 157

Exploring Microsoft Office 2010, Volume 1 - 1319 Total Questions - Biology-Forums.com
Question 1243

Question 1244
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You can use Form view to ________ the data in a report, for example, to organize fields in order from A to Z.
A) Sort
B) Format
C) Edit
D) Query
Answer: https://biology-forums.com/index.php?topic=270565

M

Text automatically wraps in a cell in a table when it is too wide for the width.
Answer: https://biology-forums.com/index.php?topic=271538

Question 1245

YFO
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When text automatically continues onto a following page, a hidden ________ marker is automatically inserted.
A) hard return
B) soft return
C) soft page break
D) hard page break
Answer: https://biology-forums.com/index.php?topic=271278

Question 1246

G

Which of the following is FALSE about the 7 x 7 guideline for presentations?
A) It suggests that you use no more than seven words per line
B) You may occasionally be forced to exceed this guideline
C) It suggests that you try to use no more than seven lines per slide
D) It suggests that a maximum of seven transitions and seven animations should be used in a presentation.
Answer: https://biology-forums.com/index.php?topic=270978

LO

Question 1247

IO

How is a more extensive array of options, known as a gallery, displayed in Office 2010?
A) By clicking the More button
B) By clicking the contextual tab
C) By choosing the Page Layout tab and clicking the Gallery button
D) By clicking the Quick Access Toolbar
Answer: https://biology-forums.com/index.php?topic=270909

B

Question 1248

Match the following terms with their description:
I.transparencyA.solid fill with no transparency
II.opaqueB.marble or denim within a shape
III.picture fillC.blend of purple and red, for example
IV.texture fillD.an inserted image into a shape
V.gradient fillE.how much you can see through a fill
Answer: https://biology-forums.com/index.php?topic=271190

Question 1249
The most basic element of a PowerPoint slide show is a(n) _______, similar to a page being the most basic element of Microsoft Word.
Answer: https://biology-forums.com/index.php?topic=271006

Question 1250
Arranging data in a table from A to Z is referred to as ________.
Answer: https://biology-forums.com/index.php?topic=271549

Question 1251
A(n) ________ is a key that is switched from one setting to another; Caps Lock is an example.
Answer: https://biology-forums.com/index.php?topic=271317
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The ________ is a special character that is used to represent one or more characters in the criterion of a query.
A) wildcard
B) operator
C) operand
D) delimiter
Answer: https://biology-forums.com/index.php?topic=270404

Question 1253

R
U

What is the first step to reuse slides from an existing presentation to an open PowerPoint file?
A) Click File, Open
B) Click the Open button on the Quick Access Toolbar
C) Click the Insert tab and the Picture button
D) Click the New Slide arrow in the Slides group.
Answer: https://biology-forums.com/index.php?topic=271065

Question 1254

YFO

Which of the following is NOT a modification element of WordArt?
A) Text Fill
B) Text Outline
C) Text Animation
D) Text Effects
Answer: https://biology-forums.com/index.php?topic=271142

Question 1255

IO

LO

G

If you save a presentation with a .pptx file extension, it will open in ________ view in PowerPoint 2010.
A) Presenter
B) Slide Sorter
C) Slide Show
D) Normal
Answer: https://biology-forums.com/index.php?topic=270971

Question 1256

M

Question 1252

B

You can make a(n) ________ copy of a database file to protect your database against loss or damage.
A) master
B) secure
C) backup
D) restore
Answer: https://biology-forums.com/index.php?topic=270344

Question 1257
All EXCEPT ________ is a type of reference for a cross-reference listing.
A) Heading
B) Object
C) Bookmark
D) Figure
Answer: https://biology-forums.com/index.php?topic=271461

Question 1258
The quickest way to access a summary of Action Center items is to:
A) double-click the icon in the Notification area.
B) click the Start button.
C) click the icon in the Notification area.
D) click the Windows Defender icon.
Answer: https://biology-forums.com/index.php?topic=271617

Question 1259
The default blank PowerPoint template uses the ________ Theme.
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Answer: https://biology-forums.com/index.php?topic=271094

Question 1261

Question 1262

YFO

The first step in sorting a table containing data in rows 1 through 10 is:
A) select the rows to be sorted.
B) click the Sort button on the Layout tab.
C) select the table.
D) click the Layout tab.
Answer: https://biology-forums.com/index.php?topic=271517

R
U

The ________ displays open window buttons as well as the Notification area.
Answer: https://biology-forums.com/index.php?topic=271636

M
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C
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Match the following Mail Merge commands with their description:
I.Select RecipientsA.enables you to select records to include in a merge
II.Highlight Merge FieldsB.choose how to display or process mail merge results
III.Edit Recipient ListC.enables you to select the data source file
IV.Insert Merge FieldD.add fields to a main document
V.Finish & MergeE.shades fields in the main document to see where
merged information is
Answer: https://biology-forums.com/index.php?topic=271569

M

Question 1260

Question 1263

G

The ________ view removes white space and does not display the header or footer.
Answer: https://biology-forums.com/index.php?topic=271329

Question 1264

Question 1265

LO

Rows in a table are identified by ________.
Answer: https://biology-forums.com/index.php?topic=271551

B

IO

A line chart
A) separates one or more pie slices from the rest of the pie chart.
B) shows each data point in proportion to the whole data series as a slice in a circular pie.
C) emphasizes magnitude of changes over time by filling in the space between lines with a color.
D) uses a line to connect data points in order to show trends over a period of time.
Answer: https://biology-forums.com/index.php?topic=270759

Question 1266
Match the shape or design with their description:
I.connectorA.shape that includes a text box
II.calloutB.geometric or non-geometic object
III.freeform shapeC.the interior contents of a shape
IV.shapeD.Lines shape attached to another shape
V.fillE.shape with curved and straight lines
Answer: https://biology-forums.com/index.php?topic=271182

Question 1267
A(n) ________ is a combination of formatting options that can easily be applied to a shape or graphic.
Answer: https://biology-forums.com/index.php?topic=271163

Question 1268
Changing the order of slides or deleting one or more slides is most easily done in ________ view.
A) Presenter
B) Reading
C) Slide Sorter
D) Slide Show
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Answer: https://biology-forums.com/index.php?topic=270968

Question 1269

M

The ________ slides option includes a black border around slides when printed.
Answer: https://biology-forums.com/index.php?topic=271029
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Question 1270
A(n) ________ is a variable or constant that is needed to produce output for a function in a calculated field.
A) Argument
B) Formula
C) Expression
D) Syntax
Answer: https://biology-forums.com/index.php?topic=270474

Question 1271

YFO

R
U

Referencing the image above, what number represents the section where the page number, date and time would appear on each page in the report?
A) 1
B) 2
C) 3
D) 4
Answer: https://biology-forums.com/index.php?topic=270573

Question 1272

LO

Question 1273

G

Which of the following is NOT an option in the Arrange group on the Format tab?
A) Send on Top
B) Bring Forward
C) Bring to Front
D) Send to Back
Answer: https://biology-forums.com/index.php?topic=271156

B

IO

In which views does a transition appear?
A) Presentation and Notes views
B) Normal and Presentation views
C) Normal and Slide Show views
D) Slide Show and Reading views
Answer: https://biology-forums.com/index.php?topic=270990

Question 1274
The NOW function
A) contains another function embedded inside one or more of its arguments.
B) evaluates a condition and returns one value if the condition is true and a different value if the condition is false.
C) evaluates true or false.
D) displays the current date and time.
Answer: https://biology-forums.com/index.php?topic=270688

Question 1275
A ________ label is text that describes a collection of data points in a chart.
Answer: https://biology-forums.com/index.php?topic=270781

Question 1276
________ attributes include boldfacing, italicizing, and color.
Answer: https://biology-forums.com/index.php?topic=270945

Question 1277
Which of the following is FALSE in regard to Windows Defender?
A) It requires an annual maintenance fee.
B) It is antispyware software.
C) It is included with Windows 7.
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D) It identifies and removes spyware.
Answer: https://biology-forums.com/index.php?topic=271615

Question 1278

M
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The AVERAGE function
A) calculates the arithmetic mean of values in a range.
B) identifies the midpoint value in a set of values.
C) identifies the highest value in a range.
D) displays the lowest value in a range.
Answer: https://biology-forums.com/index.php?topic=270680

Question 1279

R
U

The Table Style Options Group
A) contains check boxes to select format actions such as Header Row which displays the header row when checked.
B) keeps Table Options visible as you scroll through a worksheet.
C) is a collection of structured, related data in columns and rows.
D) enables you to adjust settings to control how many pages will print.
Answer: https://biology-forums.com/index.php?topic=270834

Question 1280

YFO

Where does a comment frequently appear in Word 2010?
A) In a ScreenTip
B) In a task pane on the right of the window
C) In a balloon
D) Directly within the text of the document
Answer: https://biology-forums.com/index.php?topic=271423

G

Question 1281

IO

LO

Which of the following is FALSE about Word options?
A) You can change the font default.
B) Tabs can be added to the Ribbon.
C) You can customize the Quick Access Toolbar.
D) You can disallow text to be dragged and dropped.
Answer: https://biology-forums.com/index.php?topic=271281

Question 1282

B

A company name that you may want included at the top of every page would be inserted as a(n) ________.
Answer: https://biology-forums.com/index.php?topic=271322

Question 1283
Match the following terms to their descriptions:
I.Conditional Formatting that highlights blanksA.is useful to see where
you are missing data
II.Conditional Formatting that highlights errorsB.format cells based upon
their value in relation to
the value of other cells such
as the top 10%
III.Highlight Cell RulesC.horizontal gradient or
solid fill indicating
the cell's relative value
compared to other
selected cells
IV.Top Bottom RulesD.highlight cells meeting
specified criteria with a
specified color, font, or border
V.Data barE.helps locate errors in cells quickly
Answer: https://biology-forums.com/index.php?topic=270890

Question 1284
Match the following terms to their descriptions:
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Question 1285
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Match the sort options to their explanations:
I.Table Style controlsA.check boxes to select format actions
II.Table Style Options GroupB.fill color of the header row, columns,
and records in a table
III.Sorting Text A to ZC.arranges data in alphabetical order
IV.Sorting Dates oldest to newestD.arranges numbers in sequential order
V.Sorting Values smallest to largestE.displays data in chronological order
Answer: https://biology-forums.com/index.php?topic=270886

M
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I.DatasetA.collection of structured, related
data in columns and rows
II.Freezing keeps rows and/or columnsB.enables you to adjust settings
to control how the worksheet
will print
III.Freeze Top RowC.visible as you scroll through a
worksheet
IV.Previewing the worksheet in Backstage viewD.indicates where data starts on
a new printed page
V.A page breakE.keeps the top row visible as
you scroll through a worksheet
Answer: https://biology-forums.com/index.php?topic=270883

M
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Question 1286

LO

Question 1287

G

Which field property type should be applied to fields that should not remain empty?
A) Required
B) Format
C) Indexed
D) Caption
Answer: https://biology-forums.com/index.php?topic=270422

B

IO

How does a document appear when you choose the Final option from the Review tab?
A) Shows the document if all tracked changes are rejected
B) Shows additions and deletions in balloons in the margin
C) Shows the additions as inserted text in the document and deletions in balloons in the margin
D) Shows the document if you accept all tracked changes
Answer: https://biology-forums.com/index.php?topic=271436

Question 1288
If two conditions are not sufficient to evaluate an expression in an expression, Access users can use the ________ IIf function.
Answer: https://biology-forums.com/index.php?topic=270512

Question 1289
Line ________ or thickness can be adjusted around a shape.
Answer: https://biology-forums.com/index.php?topic=271165

Question 1290
The ________ data type can store text, numerals, and symbols.
A) Text
B) Number
C) Date/Time
D) Currency
Answer: https://biology-forums.com/index.php?topic=270412

Question 1291
Which of the following galleries enables you to apply a soft glow, soft edges, shadows, or a 3-D look to an object?
A) Font
B) Effects
C) Background Styles
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D) Colors
Answer: https://biology-forums.com/index.php?topic=271078

Question 1292
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Match the following terms to their meanings:
I.QueryA.A professional, formatted printout of a table or query
II.ReportB.An object that allows you to enter data, modify data, or
delete data in a table.
III.FormC.A question you ask about data stored in a database
IV.RDBMSD.A collection of related records.
V.TableE.A program that allows you to manage groups of data in
tables and specify relationships among data tables.
Answer: https://biology-forums.com/index.php?topic=270382

Question 1293

YFO
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To generate a list of information on the same page instead of merging each record onto a separate page, use the ________ mail merge.
A) Letters
B) Labels
C) Directory
D) Envelopes
Answer: https://biology-forums.com/index.php?topic=271534

Question 1294

The ________ data type should be applied to fields that contain a combination of characters.
Answer: https://biology-forums.com/index.php?topic=270441

Question 1295

LO

Question 1296

G

A ________ program is a computer application used to create and modify spreadsheets.
Answer: https://biology-forums.com/index.php?topic=270635

B
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________ are two lines on a slide that intersect at the center.
A) Stacks
B) Grids
C) Guides
D) Line weights
Answer: https://biology-forums.com/index.php?topic=271153

Question 1297
________ a picture removes unwanted external areas of the image.
Answer: https://biology-forums.com/index.php?topic=271243

Question 1298
Which of the following statements is true about how Access and Excel share data:
A) Access can import data from Excel, but cannot export data to Excel
B) Access can export data to Excel, but cannot import data from Excel
C) Access can import data from Excel, and export data to Excel
D) Access cannot import data from Excel and cannot export data to Excel
Answer: https://biology-forums.com/index.php?topic=270420

Question 1299
Some computer users thought that the previous version of Windows, Windows ________, contained excessive UAC prompts; Windows 7 has
changed that.
Answer: https://biology-forums.com/index.php?topic=271650

Question 1300
When expanding a search, scroll to the last item in the search results list and select ________ to search the entire computer system.
A) Computer
B) All Computer
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C) All
D) My Computer
Answer: https://biology-forums.com/index.php?topic=271625

How many levels of indentation does PowerPoint 2010 allow?
A) Six
B) Eight
C) Nine
D) Twelve
Answer: https://biology-forums.com/index.php?topic=271050

Question 1302
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Match the description of a Word option to the menu category where it is located:
I.customize the window areaA.General
II.modify how Word corrects and
formats textB.Trust Center
III.create a new tabC.Advanced
IV.change security settings D.Proofing
V.specify editing optionsE.Customize Ribbon
Answer: https://biology-forums.com/index.php?topic=271339
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Question 1301

Question 1303

The ________ function calculates the periodic payment for a loan with interest.
Answer: https://biology-forums.com/index.php?topic=270725

Question 1304

IO

Question 1305
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The ________ function measures the amount of time that has elapsed between two dates.
A) DatePart
B) Date
C) DateDiff
D) DateArithmetic
Answer: https://biology-forums.com/index.php?topic=270467

B

Which of the following is NOT a type of tab in Word 2010?
A) Bar tab
B) Center tab
C) Decimal tab
D) Point tab
Answer: https://biology-forums.com/index.php?topic=271360

Question 1306
Revision marks of deleted text show as:
A) red bold text within the document.
B) black bolded text.
C) red text in a balloon.
D) strikeout lines.
Answer: https://biology-forums.com/index.php?topic=271431

Question 1307
Which of the following is FALSE about endnotes?
A) An endnote will show at the end of your document.
B) By default, endnotes are sequentially numbers with lowercase Roman numerals.
C) Footnotes, endnotes, and bibliographies often contain the same information.
D) An Endnote can be inserted into a document with the Insert tab.
Answer: https://biology-forums.com/index.php?topic=271443

Question 1308
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Question 1309
Match the following features with their description:
I.section breakA.switch from one setting to another
II.toggleB.text or graphic that displays behind text
III.watermarkC.forces the next part of a document onto a new page
IV.hard page break D.when text automatically continues to the next page
V.soft page breakE.marker that divides a document
Answer: https://biology-forums.com/index.php?topic=271342

YFO

In addition to setting tabs in the Tabs dialog box, tabs can be set:
A) on the Quick Access Toolbar.
B) directly on the ruler.
C) directly on the Mini toolbar.
D) directly from the Page Layout tab.
Answer: https://biology-forums.com/index.php?topic=271361
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Question 1310
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What do you see what you first click the File tab from a document?
A) A thumbnail of all of the pages of the file and information about the document
B) Detailed information about each page of the document
C) A thumbnail version of the current page and information about the document
D) Information about the current page and a separate box with information about the full document
Answer: https://biology-forums.com/index.php?topic=271309

Question 1311

LO

G

After creating a chart you can change the chart type by using
A) Page Layout tab / Chart Options button.
B) Design tab / Change Chart Type button.
C) Data tab / Chart Changer tool.
D) You cannot change the chart.
Answer: https://biology-forums.com/index.php?topic=270771

Question 1312

B

IO

An X Y (scatter) chart
A) shows values as percentages of the whole but may contain more than one data series.
B) shows the high, low, and close prices for individual stocks over time.
C) shows trends using two dimensions on a continuous curve.
D) shows a relationship between two variables.
Answer: https://biology-forums.com/index.php?topic=270763

Question 1313
A(n) ________ is a special character that keeps two or more words together.
Answer: https://biology-forums.com/index.php?topic=271395

Question 1314
Which of the following is TRUE about changing diagram types in SmartArt?
A) Customized shapes transfer from the old diagram to the new one.
B) Rotation effects transfer to the new layout.
C) Changing a diagram type never alters the implication of a diagram.
D) All effects transfer from the old diagram to the new one.
Answer: https://biology-forums.com/index.php?topic=271140

Question 1315
Which of the following options is NOT a type of list available in Word 2010?
A) Pyramid list
B) Numbered list
C) Multilevel list
D) Bulleted list
Answer: https://biology-forums.com/index.php?topic=271362
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Question 1316
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Match the PowerPoint option with its description:
I.Print Full slides optionA.black border prints around each slide
II.Grayscale optionB.prints without gray fills
III.Pure Black and White optionC.print slides for use as a backup
IV.Frame slides optionD.even if slide is set to a large custom size, slide
prints on one page
V.Scale to Fit paper optionE.do not want the background printed
Answer: https://biology-forums.com/index.php?topic=271035

Question 1317
The order of various layers of objects is known as the _________ order.
Answer: https://biology-forums.com/index.php?topic=271178

YFO

Which of the following is NOT possible to do while in Outline view?
A) Add transitions to the slides
B) Move easily from one slide to another
C) Rearrange the order of slides
D) Copy text from one slide to another
Answer: https://biology-forums.com/index.php?topic=271049

R
U

Question 1318

Question 1319
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In relational databases, there is a concept known as ________ which means that related tables must be consistent with one another.
Answer: https://biology-forums.com/index.php?topic=270370
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